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Thank You for Choosing Ross
You've made a great choice. We expect you will be very happy with your purchase of Ross 
Technology. 
Our mission is to:
1. Provide a Superior Customer Experience

• offer the best product quality and support

2. Make Cool Practical Technology

• develop great products that customers love
Ross has become well known for the Ross Video Code of Ethics. It guides our interactions and 
empowers our employees. I hope you enjoy reading it below.
If anything at all with your Ross experience does not live up to your expectations be sure to reach 
out to us at solutions@rossvideo.com.

David Ross
CEO, Ross Video
dross@rossvideo.com

Ross Video Code of Ethics
Any company is the sum total of the people that make things happen. At Ross, our employees are a 
special group. Our employees truly care about doing a great job and delivering a high quality 
customer experience every day. This code of ethics hangs on the wall of all Ross Video locations to 
guide our behavior:
1. We will always act in our customers’ best interest.

2. We will do our best to understand our customers’ requirements.

3. We will not ship crap.

4. We will be great to work with.

5. We will do something extra for our customers, as an apology, when something big goes wrong 
and it's our fault.

6. We will keep our promises.

7. We will treat the competition with respect.

8. We will cooperate with and help other friendly companies.

9. We will go above and beyond in times of crisis. If there's no one to authorize the required action in 
times of company or customer crisis - do what you know in your heart is right. (You may rent 
helicopters if necessary.)
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International

This equipment has been tested under the requirements of CISPR 22:2008 or CISPR 32:2015 and 
found to comply with the limits for a Class A Digital device.

Warranty and Repair Policy
The Ultricore CC system is backed by a comprehensive one-year warranty on all components.

If an item becomes defective within the warranty period Ross will repair or replace the defective 
item, as determined solely by Ross.

Warranty repairs will be conducted at Ross, with all shipping FOB Ross dock. If repairs are 
conducted at the customer site, reasonable out-of-pocket charges will apply. At the discretion of 
Ross, and on a temporary loan basis, plug in circuit boards or other replacement parts may be 
supplied free of charge while defective items undergo repair. Return packing, shipping, and special 
handling costs are the responsibility of the customer.

This warranty is void if products are subjected to misuse, neglect, accident, improper installation or 
application, or unauthorized modification.

In no event shall Ross Video Limited be liable for direct, indirect, special, incidental, or 
consequential damages (including loss of profit). Implied warranties, including that of 
merchantability and fitness for a particular purpose, are expressly limited to the duration of this 
warranty.

This warranty is TRANSFERABLE to subsequent owners, subject to Ross’ notification of change of 
ownership.

Environmental Information
The equipment may contain hazardous substances that could impact health and the environment.

To avoid the potential release of those substances into the environment and to diminish the need 
for the extraction of natural resources, Ross Video encourages you to use the appropriate take-back 
systems. These systems will reuse or recycle most of the materials from your end-of-life equipment 
in an environmentally friendly and health conscious manner.

The crossed-out wheeled bin symbol invites you to use these systems.

If you need more information on the collection, reuse, and recycling systems, please contact your 
local or regional waste administration. You can also contact Ross Video for more information on the 
environmental performances of our products.

This appliance may contain a Coin type battery which should not be treated as household waste.

To ensure that the battery will be treated properly use the appropriate take-back systems in your 
area. These systems will reuse or recycle most of the materials from your end-of-life equipment in 
an environmentally friendly and health conscious manner.

Notice — This is a Class A product. In domestic environments, this product may cause radio 
interference, in which case the user may have to take adequate measures.

Notice — Changes or modifications to this equipment not expressly approved by Ross Video Limited 
could void the user’s authority to operate this equipment.



Security and Privacy 
If you would like more information on how Ross Video security and privacy practices have been 
applied to the Ultricore CC, what you should know about maintaining security of this product, and 
how we can partner with you to ensure security throughout this product's life-cycle, contact 
techsupport@rossvideo.com.

Ross Video has implemented reasonable administrative, technical, and physical safeguards to help 
protect against security incidents and privacy breaches involving a Ross Video product provided 
those products are used in accordance with Ross Video instructions for use. However, as systems 
and threats evolve, no system can be protected against all vulnerabilities and we consider our 
customers the most important partner in maintaining security and privacy safeguards. If you have 
any concerns, we ask that you bring them to our attention, and we will investigate. Where 
appropriate, we will address the issue with product changes, technical bulletins and/or responsible 
disclosures to customers and regulators. Ross Video continuously strives to improve security and 
privacy throughout the product life-cycle using practices such as: 

• Privacy and Security by Design
• Product and Supplier Risk Assessment
• Vulnerability and Patch Management
• Secure Coding Practices and Analysis
• Vulnerability Scanning
• Access Controls appropriate to Customer Data
• Incident Response
• Clear paths for two-way communication between customers and Ross Video

If you would like to report a potential product related privacy or security issue (incident, breach, or 
vulnerability), contact techsupport@rossvideo.com.

Company Address

Ross Video Limited 
8 John Street
Iroquois, Ontario
Canada, K0E 1K0

Ross Video Incorporated 
P.O. Box 880
Ogdensburg, New York
USA 13669-0880

General Business Office: (+1) 613  652  4886

Fax: (+1) 613  652  4425

Technical Support: (+1) 613  652  4886

After Hours Emergency: (+1) 613  349  0006

E-mail (Technical Support): techsupport@rossvideo.com
E-mail (General Information): solutions@rossvideo.com

Website: http://www.rossvideo.com

mailto:techsupport@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
mailto:solutions@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
http://www.rossvideo.com
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Introduction
This guide covers the installation, configuration, and use of the Ultricore CC in a routing system. The 
following chapters are included:

• “Introduction” summarizes the guide and provides important terms, and conventions.
• “Getting Started” provides an overview for creating a routing system with Ultricore CC, and 

general information to keep in mind before installing and configuring your Ultricore CC panel.
• “Hardware Overview” provides a basic introduction to the Ultricore CC front and rear panels.
• “Physical Installation” provides instructions for the basic physical installation of the Ultricore CC 

panel.
• “Basic Configuration” provides instructions for configuring the Ultricore CC network settings, 

displaying the Ultricore CC nodes in DashBoard, and setting up your first database for the routing 
system.

• “Software License Keys” provides instructions for enabling licensed features of your Ultricore 
CC.

• “Ultricore Profiles” provides an introduction to the Ultricore Profiles for your routing matrix and 
includes general information on managing those profiles.

• “Device Communication Setup” provides instructions for using Ultricore CC to establish 
connections with NK Series devices, Ross Ethernet devices, and third-party devices in your 
routing system.

• “Database Configuration” provides instructions for defining the elements of your routing 
system database such as matrices, levels, destinations, and sources.

• “Tallies” provides instructions on how to enable TSL UMD messages in the active database, and 
assign Tally IDs to your sources and destinations.

• “Using Categories” describes how to assign each destination, source, and level, to a specific 
category in the routing system database.

• “Soft Panels in DashBoard” provides instructions for creating virtual panels in Ultricore CC.
• “Using Salvos” describes how to create and recall a salvo using the options in DashBoard.
• “Operation with Ross Devices” provides general information for operating the Ultricore CC in a 

routing system that also includes Ross NK Series devices.
• “System Integration Examples” provides generalized examples of integrating Ultricore CC into 

existing routing systems. 
• “External Control” lists the third-party protocol commands the Ultricore CC supports.
• “Monitoring” describes the alarms and status indicators in the DashBoard interface for the 

Ultricore CC. General information is also provided on the Ethernet port LEDs.
• “DashBoard Interface Overview” summarizes the functions, menus, and parameters of the 

Ultricore CC tabs and windows in DashBoard.
• “Technical Specifications” provides the specifications for the Ultricore CC.
• “Software Licenses” provides third-party software license information for your Ultricore CC.
• “Glossary” provides a list of terms used throughout this guide.

Related Publications
It is recommended to consult the following Ross documentation before installing and configuring 
your Ultricore CC:
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• DashBoard User Guide, Ross Part Number: 8351DR-004
• NK-NET User Guide, Ross Part Number: 2201DR-002
• NK-IPS User Guide, Ross Part Number: 9807DR-1020
• NK Series User Guide, Ross Part Number: 9807DR-0100
• RCP-ME User Guide, Ross Part Number: 2201DR-200
• RCP-QE User Guide, Ross Part Number: 2201DR-201
• Ultricore CC Quick Start Guide, Ross Part Number: 2201DR-102
• Ultrix and Ultricore Database Guide, Ross Part Number: 2201DR-108
• ULTRIX-FR1, ULTRIX-FR2, and ULTRIX-FR5 Installation Guide, Ross Part Number: 2101DR-003
• ULTRIX-FR1, ULTRIX-FR2, and ULTRIX-FR5 User Guide, Ross Part Number: 2101DR-004
• Walkabout Application Note, Ross Part Number: 2201DR-003

Documentation Conventions
Special text formats are used in this guide to identify parts of the user interface, text that a user 
must enter, or a sequence of menus and sub-menus that must be followed to reach a particular 
command.

Interface Elements
Bold text is used to identify a user interface element such as a dialog box, menu item, or button. For 
example:

In the Edit dialog, click Insert Above.

User Entered Text
Courier text is used to identify text that a user must enter. For example:

In the Language box, enter English.

Referenced Guides
Italic text is used to identify the titles of referenced guides, manuals, or documents. For example:

For more information, refer to the Ultrix User Guide.

Menu Sequences
Menu arrows are used in procedures to identify a sequence of menu items that you must follow. 
For example, if a step reads “File > Save As,” you would click the File menu and then click Save As.

Important Instructions
Star icons are used to identify important instructions or features. For example:

 Contact your IT department before connecting to your facility network to ensure that there are 
no conflicts. They will provide you with an appropriate value for the IP Address, Subnet Mask, and 
Gateway for your device.

Contacting Technical Support
At Ross Video, we take pride in the quality of our products, but if problems occur, help is as close as 
the nearest telephone.
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Our 24-hour Hot Line service ensures you have access to technical expertise around the clock. 
After-sales service and technical support is provided directly by Ross Video personnel. During 
business hours (Eastern Time), technical support personnel are available by telephone. After hours 
and on weekends, a direct emergency technical support phone line is available. If the technical 
support person who is on call does not answer this line immediately, a voice message can be left 
and the call will be returned shortly. This team of highly trained staff is available to react to any 
problem and to do whatever is necessary to ensure customer satisfaction.

• Technical Support: (+1) 613-652-4886
• After Hours Emergency: (+1) 613-349-0006
• E-mail: techsupport@rossvideo.com 
• Website: http://www.rossvideo.com 

mailto:techsupport@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
http://www.rossvideo.com
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Getting Started
Ultricore CC alleviates the burden typically placed up on the user to partition, offset, and assign to 
levels the inputs and outputs of the routers that will be part of the system. Ultricore CC’s 
user-friendly, graphical interface provides the tools for easily handling those configuration issues 
and more at a system, rather than router, level.

If you have questions pertaining to the operation of Ultricore CC, please contact us at the numbers 
listed in “Contacting Technical Support”. Our technical staff is always available for consultation, 
training, or service.

General Overview
Ultricore CC is the central system controller for Ross Video’s routing systems. It allows the 
connection of Ethernet based routers and remote control panels, T-Bus based Ross NK Series 
routers and remote control panels, and third-party automation systems.

By collating the potentially complex aspects of a system’s switching scheme, Ultricore CC allows for 
minimal out-of-the-box configuration of routers. This not only makes it easier to initially setup a 
system, but it also makes it easier to change configuration as needed.

The DashBoard client software enables you to monitor and control your Ross routing system 
components, including Ultricore CC from a computer. DashBoard communicates with the Ross 
routing system through ethernet, TCP, connections. 

Features
Some features of the Ultricore CC include:

• SLP discovery or manual configuration of connection to DashBoard client software
• Client and server operation with client connection failover support
• Basic system crosspoint control and status monitoring via DashBoard
• Connections for redundant power supplies
• Alarm output with locking GP connector
• Dual Gigabit Ethernet interfaces
• T-Bus with looping connectors and power for native NK series connectivity
• Non-volatile memory for system recovery and logging
• Real-time clock
• Supports a maximum of 64 levels, with a maximum matrix of 4096 sources and 4096 destinations
• Dual configurable serial ports (RS-232 or RS-422)
• Front status display for system events
• Bi-directional Ethernet and Serial protocol support for the GVG Native protocol
• Supports the Probel SW-P-08 serial protocol
• Acts as a central system controller for up to 25 DashBoard clients and up to 50 hardware clients 

(routers, remote control panels, third-party control systems, etc.)
• Supports links from the NK-IPS for legacy installed systems
• Supports NK-IPS pass-through type connection for direct NK device support
• Supports Virtual Routing, Matrix Partitioning, and Mapping

• Label support1
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Typical System Equipment
Use Ultricore CC in typologies where routers and remote control panels are distributed throughout 
a facility. In this scenario some of the routers and panel are physically located a great distance from 
the Ultricore CC. You would use Ethernet connections to the Ultricore CC.

 The Ultricore CC does not support the ULTRIX-FR12.

Figure 1  Example of a Possible Routing System with Ultricore CC

1. Ultricore CC does not support Unicode characters.
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Before You Begin
Before configuring and operating the Ultricore CC, you must first:

1. Download and install the latest version of the DashBoard client software. The DashBoard 
software and user manual are available from our website. 

 Contact your IT department before connecting to your facility network to ensure that there are 
no conflicts. 

2. Connect your routers and panels to your facility network.

3. Launch DashBoard.

4. Ensure that your routers and remote control panels are available/visible in DashBoard.

 Ross Video recommends a Memory Allocation of at least 4GB in DashBoard to ensure reliable 
operation. Refer to the DashBoard User Guide for details on setting the Memory Allocation value.

For More Information on...
• downloading and installing DashBoard, refer to the DashBoard User Guide.
• planning and installing your routing system, refer to the user documentation that accompanied 

your devices.
• configuring the NK-NET, refer to the NK-NET User Guide.
• configuring the NK-IPS, refer to the NK-IPS User Guide.

Installation and Setup Overview
The generalized workflow of installing and configuring your Ultricore CC is:

1. Implement your routing system plan by installing the devices and configuring their network 
settings.

2. Use Walkabout to establish communications between Ultricore CC and DashBoard.

3. Ensure that DashBoard discovers the routing system and all its devices.

4. Configure individual device settings in DashBoard.

5. Define the routing system database using the options in the Ultricore CC interfaces in 
DashBoard.

6. Set up control panels.

Implementing a System Plan
Once the topology of the system has been decided with respect to routers, panels, connecting 
devices (NK-NET, NK-IPS) etc. the components are connected and configured. Once all the Ross 
routing system components are configured for network communication, the required information 
is entered into the Ultricore CC’s databases through its DashBoard interfaces.

An example use topology would be a broadcast facility or studio where there are routers and 
panels distributed throughout a building or a campus with the Ultricore CC collating the system’s 
components.

 Ultricore CC acts as a central system controller for up to 10 DashBoard clients and up to 50 
hardware clients (routers and/or remote control panels).

Establish Communications
Ultricore CC supports the Walkabout system for initial configuration of IP settings. Once you 
establish communications over Ethernet between the Ultricore CC panel and DashBoard, you can 
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proceed to use the interfaces in DashBoard that enable Ultricore CC to communicate with the other 
devices in your routing system.

For More Information on...
• establishing a network connection to Ultricore CC, refer to “Using Walkabout to Assign an IP 

Address to the Ultricore CC Panel”.

Define the Routing System Database in Ultricore CC
The Database interface in DashBoard for Ultricore CC enables you to create system input and 
output lists, assign those signals to system sources and destinations, define multiple levels and 
matrices. You can create multiple databases, each one with unique parameters, that are saved to 
the Ultricore CC panel memory. This provides the flexibility of recalling a database and edit 
parameters as needed. You may wish to use the following process when defining the database for 
your routing system.

 Ultricore CC supports a maximum of 64 levels, with a maximum matrix of 4096 sources and 4096 
destinations.

Figure 2  Process for Configuring an Ultricore CC

 Ultricore CC does not support Unicode characters.

For More Information on...
• defining a database, refer to “Creating a New Database” or the Ultrix and Ultricore Database 

Guide.

Set up Virtual Control and Resource Management in Ultricore CC
Once your router connections are defined, and a database is established, you can start building a 
map of several different physical devices that become one virtual device. When a switch request is 
made for a virtual device, all the physical devices that are mapped to the virtual device are switched. 

Ultricore CC enables you to map inputs and outputs from routers for control via any remote control 
panel. These parameters can be saved to a database, enabling you to change configurations easily 
and quickly, allowing devices to used in a number of different operating scenarios.

Configure the Soft Panels in Ultricore CC
There are seven types of soft panels available in the Ultricore CC interface:

• A Matrix panel displays the sources and destinations in a grid pattern, allowing you to quickly 
select a router, then select which crosspoints to switch from, and perform a Take transition 
between the crosspoints.

• A MultiBus panel arranges the sources and destinations in separate crosspoint buses, but 
provides similar controls as the Matrix panel.

• A Category panel displays the sources, destinations, and levels as defined by the CAT Index tags 
defined via the Categories interface. 

• A Category Index panel provides an interface for classic category/index selection. The various 
categories and indexes are set via the Cat/Index category table within each database.

• A Group category panel provides a method of grouping dissimilarly named resources into 
functional selection groups. The group assignments are set via the Group categories table within 
each database.
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• A Push Button panel provides a button-per-source style panel in a grid layout. 
• An UltritouchPB panel provides a button-per-source grid of buttons scaled to support Ultritouch 

panels.
• An UltritouchMV panel provides specific Ultriscape Multiviewer controls scaled for display on 

Ultritouch panel.

Operation

Once configured, the Ultricore CC provides central controller functionality for the routing system, 
including:

• the storage and implementation of routing system configurations, which collect a series of 
routing matrices into a system and provide a logical database view of the whole system

• switching the physical crosspoints of the routers according to the system configuration
• the control and system database interface for devices that control and/or display routing status 

(e.g. remote control panels, switchers, master control, automation systems, multi-viewers, and 
tally systems)

• virtual routing, matrix partitioning, and mapping
• label support for protocols supporting labels
• system control through DashBoard
• connection and status logging 
• client and server operation with client connection fail-over support
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Hardware Overview
This chapter presents information on the Ultricore CC front and rear panels. 

Front Panel Overview
The Ultricore CC front panel provides LEDs for monitoring the communication activity and power 
supply status of the panel. An LCD display is also included for monitoring purposes.

Figure 3  Ultricore CC — Front Panel 

1. Front Panel Wave Light

The front panel provides various system status indication via the 'wave light'. The concave section 
of the black front panel bezel emits light of various colors to indicate system function. 

2. LCD Display

The LCD display reports on the overall system status, IP address of the panel, and current fault 
conditions. During normal operations, the display reports the Device Name (user assigned) and 
the active IP address of the panel. Under some conditions, fault conditions are reported such as: 
device boot status, Walkabout locate mode indication, SRAM battery warnings, and firmware 
upgrade states. The information on the display alternates between normal operation and the 
error messages.

3. Navigation Positioner

The front panel includes a five-direction joystick that is used to navigate the Ultricore CC on the 
LCD Display. Refer to “Monitoring via the Front Panel” for details.

4. ETHERNET Port LEDs

Table 2 describes the Ultricore CC front panel LEDs that are used to monitor ethernet 
communication activity of the Ultricore CC panel. When facing the front panel, the left LED 
reports the status of ETHERNET PORT 1 while the right LED reports the status of ETHERNET 
PORT 2. 

Table 1  Front Panel Wave Light

Status Description
Blue pulsing to White When lit blue, this indicates normal operation.

Red When lit red, this indicates a serious issue that requires 
immediate attention.

1 2 3 4IP: ###.###.##.###1 2 3 4IP: ###.###.##.###
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Rear Panel Overview
The Ultricore CC rear panel provides communication ports, two power supply ports, and an alarm 
condition general purpose output. 

For More Information on...
• the pinouts for the Ultricore CC rear panel connections, refer to “Technical Specifications”.
• the power specifications, refer to “Power”.

Figure 4  Ultricore CC — Rear Panel 

1. PSU Ports

Two +15V DC power supply connections (PSU1, PSU2) are provided to connect to external brick 
power supplies to the Ultricore CC panel.

2. ALARM GPO

This contact closure connector is used to report an alarm where closed is a system fault, and 
open when the system is running without errors.

3. ETHERNET Ports

Ultricore CC communicates over an Ethernet connection to routers, and other devices. PORT 1 is 
the primary Ethernet connection for Ultricore CC. PORT 2 is the redundant (backup) Ethernet 
connection. The exact steps for connecting to your facility via an ethernet network depends on 
the requirements defined by your IT Department.

4. T-BUS Ports

Each port provides a loop-through connection for Ross NK series communication. This enables 
communication to legacy routers and remote control panels as part of the routing system.

5. COM Ports

There are two female DB-9 serial ports used to connect to third-party automation devices. Each 
port can be configured for RS-232 or RS-422 serial communication. Uses these ports to connect 
to third-party automation devices that will control the routing system.

Table 2  Front Panel LEDs

LED Status Description
ETH# - ACT Bright 

Blue
A valid physical ethernet connection is established, and the port 
is active. There is data transfer activity on the indicated 
ETHERNET port.

Dim Blue A valid physical ethernet connection is established, but the port is 
not the active one. There is no data transfer activity on the 
indicated Ethernet port.

Off No valid ethernet link to the indicated Ethernet port.

Notice — The Ultricore CC automatically powers on when power is applied.

T-BUS
PORT 2PORT 1

ETHERNET

COM1

COM2

PSU 1

PSU 2 ALARM
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Physical Installation
If you have questions pertaining to the installation of Ultricore CC, please contact us at the numbers 
listed in “Contacting Technical Support”. Our technical staff is always available for consultation, 
training, or service.

Before You Begin
These installation guidelines assume the following:

• The relevant Ross equipment is installed into a ventilated rack frame. The relative humidity in the 
environment of the equipment should be <70% (non-condensing). The ambient temperature of 
the air entering the front panel should not exceed 40°C (104°F), and should not fall below 0°C 
(32°F).

• The install location of the router should be accessible, dry, and dust-free.
• The socket/outlet should be installed near the equipment and be easily accessible.
• Valid IP addresses are assigned to the equipment.

Static Discharge

Throughout this chapter, please heed the following cautionary note: 

Mounting Requirements
The Ultricore CC panel is designed for installation into a standard 19” equipment rack. It has 
integrated rack ears, allowing it to be screwed in using standard screws and cage nuts.

The Ultricore CC panel mounts in the rack frame by means of four rack screws fastened through the 
front mounting ears. This should normally be sufficient to carry the load, including the weight of 
accompanying cables. 

Under some conditions, the ambient air temperature inside rack-mount cabinets can be greater 
than the ambient temperatures within a room. For safe long term reliability, ensure the ambient air 
temperatures at the router front intake are within the router’s specified operating temperature 
range. Adequate ventilation within a rack frame must also be maintained.

For More Information on...
• the technical specifications for the Ultricore CC, refer to “Technical Specifications”.

Connecting the Ultricore CC to a Network
Each Ethernet port is a standard 10/100/1000 RJ45 Ethernet connector and is used to exchange data 
and communicate with other devices in your router system. 

 Contact your IT department before connecting to your facility network to ensure that there are 
no conflicts. They will provide you with an appropriate value for the IP Address, Subnet Mask, and 
Gateway for your device.

ESD Susceptibility — Static discharge can cause serious damage to sensitive semiconductor 
devices. Avoid handling circuit boards in high static environments such as carpeted areas and when 
synthetic fiber clothing is worn. Always exercise proper grounding precautions when working on circuit 
boards and related equipment.
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The Ultricore CC is connected directly to your network so that it can interface with the devices and 
the computer running the DashBoard client. After a physical connection is established, DashBoard 
is used to configure the network settings for the Ultricore CC.

For More Information on...
• downloading and installing DashBoard, refer to the DashBoard User Guide.

 If difficulties or problems are experienced when connecting the Ultricore CC to a network hub, or 
with assigning IP addresses, please contact your network administrator.

To establish a physical connection to the network

1. To connect the primary network connection for the Ultricore CC panel:

a. Connect one free end of the straight through CAT5/5e/6 cable to a free port of the network 
hub.

b. Connect the other end of the same cable to Ethernet PORT 1 on the Ultricore CC rear panel.

Figure 5  Ultricore CC — Network Connections

2. If required, connect the redundant network connection for the Ultricore CC panel:

a. Connect one free end of a second straight through CAT5/5e/6 cable to a free port of the 
network hub.

b. Connect the other end of the same cable to Ethernet PORT 2 on the Ultricore CC rear panel.

Connecting the Ultricore CC to Ross NK Series Devices
Ross NK Series devices, such as routers and remote control panels, communicate within the routing 
system via the Ross T-BUS protocol. The Ultricore CC panel includes two T-BUS ports that can be 
used to cable an NK Series router or other legacy device that uses the T-BUS protocol.

For More Information on...
• the T-BUS port pinouts, refer to “T-Bus Ports”.
• establishing T-BUS protocol communications between Ultricore CC and an NK Series router, refer 

to “Connecting to Ross NK Series Devices”.
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To connect the Ultricore CC to a NK Series device via T-BUS

1. Connect a T-BUS Interface cable to one of the T-BUS RJ-45 ports on the Ultricore CC rear panel.

Figure 6  Ultricore CC — Cabling to Legacy NK Series Devices

2. Connect the other end of the same T-BUS Interface cable to either of the RJ-45 ports of the 
device. Most Ross NK Series devices are equipped with two RJ-45 ports for looping or daisy 
chaining configurations.

Connecting the Ultricore CC to a Serial Device
Each COM port is a DB9 female port on the Ultricore CC rear panel that accepts RS-232 or RS-422 
connection. These ports can be used to connect a third-party device or automation system that 
uses a supported serial protocol for communications.

For More Information on...
• the COM port pinouts, refer to “Serial Ports”.
• the pinouts required by your device, refer to the user documentation that accompanied your 

device.
• the serial protocols and commands the Ultricore CC supports, refer to “External Control”.

To connect the Ultricore CC to a serial device

1. Connect a Serial Interface cable to the COM 1 port on the Ultricore CC rear panel.

Figure 7  Ultricore CC — Serial Cabling to Third-Party Device

2. Connect the other end of the same Serial Interface cable to the applicable serial port on the 
device.

Connecting to a Power Supply
The Ultricore CC panel is powered by one +15V DC, 30W PSU, with an optional PSU available to 
provide redundancy and load sharing.
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For redundancy, each power cord should be connected to a separate power source for protection 
against failure of the A/C power circuit. In the event of one power supply failure, the panel load is 
seamlessly transferred to the other connected redundant power supply.  

To connect the power cables to the Ultricore CC panel

1. Connect the male end of the provided power cable into the socket marked PSU1 on the 
Ultricore CC rear panel.

Figure 8  Ultricore CC — Primary Power Connection 

2. Connect the remaining power cable into the PSU2 power supply socket if redundancy is 
required.

3. Connect the supplied AC power cable into the power modules.

4. Connect the supplied power cable’s three-prong male connector to an AC outlet.

Configuring the Loss of Power Alarm
The ALARM connector on the Ultricore CC rear panel is used when the panel loses power so that 
DashBoard cannot interrogate a non-powered device. Under normal operation, the Center pin (2) is 
open. An alarm condition connects this pin to ground. Refer to “ALARM Connector” for pinout 
details.

Figure 9  De-energized or Alarm State Equivalent Circuit

Warning Hazardous Voltages — The safe operation of this product requires that a protective 
earth connection be provided. This protective earth is provided by the ground conductor in the 
equipment’s supply cord. To reduce the risk of electrical shock to operator and service personnel, this 
ground connector must be connected to an earthed ground.

Warning — In some countries it may be necessary to supply the correct mains supply cord. Use only 
certified cords for the country of use.

Notice — The Ultricore CC automatically powers on when power is applied.
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Basic Configuration
The Ultricore CC system controller with the DashBoard client software allows configuration and 
control of the Ultricore CC and other routing system devices, enhancing the capability of any 
installed Ross products by providing access to the entire range of functions. Ultricore CC provides a 
basic platform operation with SLP discovery and manual configuration of connection to DashBoard. 

This chapter provides instructions on basic set up that includes launching DashBoard, establishing 
network connections for the Ultricore CC panel, and creating your first database. This includes:

• Launching DashBoard
• Using Walkabout to Assign an IP Address to the Ultricore CC Panel
• Adding the Ultricore CC to the Tree View in DashBoard
• Accessing the Ultricore CC Interfaces in DashBoard

 The procedures in this chapter assume that the Ultricore CC is running software v6.1 or higher.

Getting Started
Figure 10 summarizes the basic steps in configuring the Ultricore CC system.

Figure 10  Workflow for Configuring the Ultricore CC
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Launching DashBoard
DashBoard must be run on a computer that has a physical wired Ethernet connection. Wireless 
connections do not allow device discovery.

For More Information on...
• downloading and installing the DashBoard client software, refer to the DashBoard User Guide.
• the Ultricore CC interfaces in DashBoard, refer to “DashBoard Interface Overview”.

To launch DashBoard

1. Ensure that you are running DashBoard software version 9.10 or higher.

2. Launch DashBoard by double-clicking its icon on your computer desktop.

Using Walkabout to Assign an IP Address to the Ultricore CC Panel
Once the Ultricore CC panel is physically installed and cabled to your facility network, you will need 
to assign it a static IP Address to enable DashBoard to locate it on your network. Establishing an IP 
Address enables DashBoard to communicate with the Ultricore CC and update the Basic Tree View 
with the Ultricore CC nodes.

To assign a static IP address to the Ultricore CC panel

1. Launch DashBoard.

2. From the DashBoard client main toolbar, select File > Show Walkabout.

The DashBoard window displays the Walkabout table.

3. Click Refresh, located at the bottom of the Walkabout tab, to ensure the list in the Walkabout 
table is current.

4. In the Walkabout table, find the entry for the Ultricore CC you want to configure.

5. Use the Name field to assign a unique identifier to the Ultricore CC panel. This will be the name 
displayed in the Tree View of DashBoard.

 After editing a cell in the Walkabout table, press Enter to confirm your edits. To verify your 
changes, wait up to 30 seconds, then click Refresh.

6. Use the Address field to specify the IP Address supplied by your IT Department for this device.

7. Ensure the Netmask field is set to match your network requirements.

8. Use the Gateway field to specify the IP Address for connection outside of the local area 
network (LAN).

9. Click Reboot in the row of the Walkabout table for the Ultricore CC to reboot the device.

Adding the Ultricore CC to the Tree View in DashBoard
Once you have assigned the Ultricore CC panel to a static IP Address via Walkabout, you can then 
manually add it to the Tree View in DashBoard. Manually adding the Ultricore CC panel displays its 
node in the Tree View, granting you access to the interfaces described in “DashBoard Interface 
Overview”.

To manually add the Ultricore CC to the Tree View in DashBoard

1. In the Basic Tree View toolbar of DashBoard, click .

The Add New Connections dialog opens.

2. Expand the openGear/DashBoard Connect node.
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3. Select TCP/IP DashBoard Connect or openGear Device.

4. Click Next >.

The TCP/IP DashBoard Connect/openGear Device dialog opens.

5. Select the JSON radio button as the Protocol.

6. Enter the IP Address for the Ultricore CC in the IP Address field assigned in “To assign a static 
IP address to the Ultricore CC panel”.

7. Perform one of the following steps:

• In the text fields provided, enter the display name and port of the Ultricore CC you wish to 
add; or

• Click Detect Frame Information to automatically retrieve the connection details.

8. Click Finish. 

The Ultricore CC panel displays in the Tree View. 

Accessing the Ultricore CC Interfaces in DashBoard
The interfaces are accessed by expanding the Ultricore CC node in the DashBoard Tree View.

To access the Ultricore CC interfaces in DashBoard

1. Locate the Ultricore CC node in the Tree View of DashBoard.

2. Expand the Ultricore CC node.

3. Expand the Ultricore Controller node to display a list of sub-nodes in the Tree View.
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Each sub-node is an Ultricore CC interface.

4. Expand a sub-node to access the functions of the interface. 

For example, expand the Database node to list the options available for configuring a database 
for the Ultricore CC.

5. Double-click a node to display its tab in the right-side of the DashBoard window. 

For example, double-click the Salvos node to display the Salvos interface (as seen in the 
example below).

 The selected interface may be blank or missing some data if the database is new and is not 
configured yet.

Specifying the Time Source
The Ultricore CC requires an external time source in order to accurately report the time-of-day. The 
options in the Frame Configuration interface enable the selection of time/date source via an NTP 
Server in your facility, or you can set the device time to match the computer which is running the 
current DashBoard client.

Using an NTP Server as the Time Source
 Before proceeding, contact your IT Department to learn the IP address(es) of the NTP server(s) in 

your facility. 

To specify an NTP Server as the time source for the Ultricore CC

1. Expand the Ultricore CC node to display a list of sub-nodes in the Tree View.

2. Expand the System sub-node.

3. Expand the Configuration sub-node.

4. Double-click the Ultricore CC node.

The Device Configuration interface opens.

5. Locate the NTP Servers table. 

6. If you are using one NTP server, enter the IP address in the Address field of the Server 1 row.

7. If using a backup NTP server:
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a. Enter the IP address of the first NTP server in the Address field of the Server 1 row.

b. Enter the IP address of the backup NTP server in the Address field of the Server 2 row.

8. Select the NTP Enabled box.

9. Verify that the Status field(s) in the NTP Servers table report a valid connection to the listed IP 
address(es). You may need to refresh the interface as follows:

a. Close the Device Configuration interface.

b. Re-open the Device Configuration interface by repeating steps 1 to 4 to update the Status 
field(s).

Using the DashBoard Client Computer as the Time Source
This section outlines how to set the Ultricore CC to the local time without using an NTP Server. 
Instead, you will set the time to the values reported by the DashBoard client computer you are 
using.

 The time the Ultricore CC reports is not linked to this computer. It is a once off setting of the time 
to match the computer time when the Set to PC Time button is selected on the Ultricore CC 
interface. If the DashBoard client computer time changes, you will need to update the time 
reported on the Ultricore CC by repeating the procedure below.

To specify the DashBoard client computer as the time source for the Ultricore CC

1. Expand the Ultricore CC node to display a list of sub-nodes in the Tree View.

2. Expand the System sub-node.

3. Expand the Configuration sub-node.

4. Double-click the Ultricore CC node.

The Device Configuration interface opens.

5. Locate the NTP Servers table. 

6. Click Set to PC Time. This button is located above the NTP Servers table.

Reviewing the Network Settings for the Ultricore CC Panel
Once you establish initial communications with the Ultricore CC panel, and it displays in the 
DashBoard Tree View, you may wish to alter the network settings according to your facility network 
requirements.

To update the network settings for the Ultricore CC panel

1. In the Tree View of DashBoard, double-click the Product Info node.

The Product Info interfaces display in the DashBoard window.

2. Select the Network tab.
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3. Locate the Settings area of the tab.

4. Use the Address field to specify the new static IP Address for the Ultricore CC panel.

5. Use the Subnet Mask field to specify the subnet mask for your network.

6. Use the Gateway field to specify the gateway for communications outside of the local area 
network (LAN).

7. Click Network Settings Apply.

Updating the Network Settings for the Ultricore CC
Once you establish initial communications with the Ultricore CC, and it displays in the DashBoard 
Tree View, you may wish to review or change the IP Address and other settings according to your 
facility network requirements.

 This section is not applicable if your Ultricore CC is already set to the correct IP Address.

To update the network settings for the Ultricore CC

1. Locate the Ultricore CC in the Tree View of DashBoard.

2. Expand the Ultricore CC node to display a list of sub-nodes in the Tree View.

3. Expand the System sub-node.

4. Expand the Configuration sub-node.

5. Double-click the Ultricore CC node.

The Device Configuration interface opens.

6. Click Communication Settings.

7. Locate the Ethernet Configuration area.

The Ethernet Configuration area reports the status of the active ENET port on the Ultricore CC 
rear panel, and the network settings for the Ultricore CC.
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8. Use the IP Address field to specify the new static IP Address for the Ultricore CC.

9. Use the Subnet Mask field to specify the subnet mask for your network.

10. Use the Default Gateway field to specify the gateway for communications outside of the local 
area network (LAN).

11. Click Apply to apply the new settings.

Re-naming the Ultricore CC
Each Ultricore CC can be given a unique name that is used on internal menus and as the identifier in 
the tree views of DashBoard. 

 Changing the Ultricore CC name after database configuration takes time to propagate through 
the system, and for DashBoard to reconnect, resuming stable system operation. Sufficient time 
must be allowed when making this change before attempting to use the system. This time will 
vary depending on features, matrix size, and configuration. In the case of a system with an 
ULTRIX-1RU and ULTRIX-2RU, the worst case will be 3-4 minutes. In the case of a system with an 
ULTRIX-5RU, the worst case is 10 minutes. The Ultricore CC name is typically assigned during 
initial commission and very rarely ever changed again.

To re-name the Ultricore CC in DashBoard

1. In the Tree View of DashBoard, double-click the Product Info node.

The Product Info interfaces display in the DashBoard window.

2. Select the Setup tab.

3. Use the Device Name field to specify the new name for the Ultricore CC.

4. Press Enter to apply the new name.

Configuring Access for DashBoard Clients
You can specify which DashBoard clients on your network can access and connect to your Ultricore 
CC. By default, the Permitted Clients list is blank, allowing all DashBoard clients on your network to 
connect to your Ultricore CC.

To enable access for a DashBoard client

1. In the Tree View of DashBoard, double-click the Product Info node.

The Product Info interfaces display in the DashBoard window.

2. Select the Network tab.

3. Locate the Permitted Clients area of the Network tab.

4. Click Add in the Permitted Clients area of the Network tab.

The Add Address dialog opens.

5. Use the IP Address field to specify the IP Address of the DashBoard client you wish to grant 
access to your Ultricore CC.

6. Click Apply.

The Add Address dialog closes.

The Dashboards list in the Permitted Clients area updates to display the specified IP Address.

7. Repeat steps 4 to 6 for each DashBoard client you want to allow access.

 Ensure that the IP Address for your DashBoard client machine is also added.
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8. Click Apply in the Permitted Clients area to apply the change.

To disable access for a DashBoard client

1. In the Tree View of DashBoard, double-click the Product Info node.

The Product Info interfaces display in the DashBoard window.

2. Select the Network tab.

3. From the Dashboards list, select the IP Address for the DashBoard client you want to disable 
access for.

 Do not delete the IP Address for your DashBoard client machine.

4. Click Delete in the Permitted Clients area of the Network tab.

5. Click Apply in the Permitted Clients area to apply the change.
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Software License Keys
The Ultricore CC has software options that license functions and features. This chapter outlines the 
available software licensed features, and how to install a software key for a licensed feature on your 
Ultricore CC.

 This chapter assumes the Ultricore CC is running software version 6.1 or higher.

Before You Begin
When installing a software license key on the Ultricore CC:

• You must have the DashBoard client installed and communicating with the Ultricore CC that you 
wish to install the key for.

• Ensure that you are using DashBoard version 9.10 or higher. This information is available by 
selecting Help > About DashBoard from the DashBoard main toolbar.

License Keys Overview
Table 3 provides a brief summary on the types of licensed features available for the Ultricore CC 

Installing a License Key
Ross Video uses license keys to control user access to specific Ultricore CC features. You can obtain 
a key for an Ultricore CC licensed feature from Ross Video Technical Support.

To install an Ultricore CC license key

1. Launch the DashBoard client. 

2. Locate the Ultricore CC node in the Tree View.

3. Expand the Ultricore CC node to display a list of sub-nodes in the Tree View.

4. Expand the System sub-node.

5. Expand the Configuration sub-node.

6. Double-click the Ultricore CC node.

The Device Configuration interface opens.

7. Click Licenses.

Table 3  List of Ultricore CC Licensed Features

License Description
Ultricore-EMBER+ A license that enables the use of the EMBER+ protocol for video and audio 

streaming via an ULTRIX-IP-IO blade.

Ultricore-NVISION A license that enables the use of the NVISION protocol on the Ultricore CC.

ULTRICORE-PRO A licensed that provides full Ultricore Profiles support.

Ultricore-SNMP A license that enables basic SNMP monitoring on Ultricore CC. 
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8. Make a note of the character string in the Request Code field for the feature you wish to 
enable.

9. Contact Ross Video Technical Support using the information found in “Contacting Technical 
Support”.

a. When you speak to your Technical Support representative, tell them your name, your facility 
name, and the Request Code from the Licenses table.

b. You will be given a License Key that must be entered in the applicable field in the Licenses 
table.

10. Enter the provided License Key in the applicable License Key field in the Licenses table.

 You can also right-click on the row for the License Key you are installing, and copy the Request 
Code to or paste the License Key from the Microsoft® Windows® clipboard.

11. Click Apply in the row for the License Key you entered in step 10.

12. Verify that the Count field is updated to report each installed License Key.

Removing a License Key
 Removing a License Key also removes user access to all of the Ultricore CC features associated 

with that License Key.

To remove a Ultricore CC license key

1. Launch the DashBoard client. 

2. Locate the Ultricore CC node in the Tree View.

3. Expand the Ultricore CC node to display a list of sub-nodes in the Tree View.

4. Expand the System sub-node.

5. Expand the Configuration sub-node.

6. Double-click the Ultricore CC node.

The Device Configuration interface opens.

7. Click Licenses.

Each row represents a type of licensed feature.

8. Click in the cell for the slot and licensed feature you want to remove. 

A drop-down menu displays.

9. Select Disable to remove the license.
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Ultricore Profiles
This chapter provides an introduction to the Ultricore Profiles for your routing matrix and includes 
general information on managing those profiles. 

 This chapter is applicable if you are running software version 5.6 or lower. Otherwise, refer to the 
Ultrix and Ultricore Database Guide for details on configuring databases.

Overview
A DashBoard client has the ability to detect devices on a subnet and can enable complete control of 
all settings on all devices. Ultricore Profiles are designed to enable administrators to assign and 
manage user permissions and determine the level of access for those users. For example, one user 
is only responsible for monitoring the video sources is given access only to control panels, while 
another user who manages the input and outputs of the routing matrix is also given access to 
manage the databases. 

The Ultricore Profiles operate as a form of hierarchical database where user permissions are 
organized into a tree-like format. A profile determines which groups and pages that a user can 
access. 

Any number of profiles may be created and can be used in the following ways:

• Group/Role — This profile type is not specific to any user or machine. Once created they can be 
referenced or used by any number of users or machines. For example, a Graphics Editor profile 
can be created and referenced by a team of graphics editors. When a new control panel is added 
to that profile, all graphics editors are updated with the new panel automatically.

• User — A user profile identifies a specific username and can either reference an existing role as 
above or copy an existing role then modify, add, or remove items to allow total customization as 
required. This allows a user that has a specific profile to have the same capabilities on any 
DashBoard system regardless of where they log in. 

• Location — This profile is defined by a specific location (user station) and assigns a consistent 
function regardless of who is logged in that suits the operation in that location. In this way the 
DashBoard instance in front of, for example, the audio operator in a specific control room will 
only have the optimize functionality for that role. A location profile can also reference or copy and 
modify role profiles.

Profiles can also be created that identify a specific user at a specific user station to further optimize 
the user interface in different locations. If no profile exists for the combination of user and location, 
the system default profile is used.

When there are multiple possible profiles the one used is chosen as follows:

1. A User profile has the highest priority. This means that an administrator can log in anywhere 
and execute Administrator level functions or an operator can login anywhere and have an 
optimized UI for their function.

2. A Location profile is used for all users at a specific location unless the user logged in has a 
profile. This allows more or different functionality for users logged into a specific location even 
if they do not have a specific profile themselves.

3. The system default profile is used in all other scenarios.

Modes of Operation
The Ultricore Profiles feature consists of three sub-functions or modes of operation.
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 The ULTRICORE-PRO license is required to upgrade from the basic, non-configurable profiles on 
the Ultricore CC chassis to full, customizable configurations. The ULTRICORE-PRO license is 
standard on the Ultricore-BCS.

Creation and Management of User Credentials
User profiles can reference the operating system username of the individual currently logged into 
the workstation.

Enabling User Credentials in the Setup tab of the status page engages the Ultricore User Credentials 
feature which allows an independent definition of usernames and passwords specifically for the 
Ultricore Profiles feature.

Creation and Management of User Profiles via the Default Role Profiles Only 
User and Location profiles are created and function as above but only reference one of the three 
default profiles:

• Engineer Admin (default profile) can access all features;
• Operator Admin (default operator profile) has full database and configuration capability but not 

engineering configuration and admin functions; or 
• Operator (default minimum profile) can access all soft panels for normal day to day operations.

Full Creation, Customization and Management of User Profiles
In addition to the above mode included with Ultricore-BCS and optional for Ultrix and Ultricore-CC 
is the ability to create and customize group and role profiles as well as create custom profiles on a 
user or location basis as appropriate. In addition, the order of items within these profiles can be set 
to fully optimize the operational environment for a specific user or group as needed.

Ultricore Profiles Interface
The options for configuring and managing the Ultricore Profiles are organized as individual panes 
within a single interface of a DashBoard window. The available options, and the number of panes, 
depends on whether the ULTRICORE-PRO license is installed.

Accessing the Ultricore Profiles Interface
You display the Ultricore Profiles interface by selecting its node in the DashBoard Tree View for the 
Ultricore CC in your system. By default, all nodes are displayed and accessible by any user or 
DashBoard client machine.

To display the Ultricore Profiles interface

1. Launch DashBoard on your desktop. 

2. Locate the Ultricore CC in the Tree View of DashBoard.

3. Expand the Ultricore CC node to display a list of sub-nodes in the Tree View.

4. Expand the Database sub-node.

5. Double-click the Ultricore Profiles sub-node.

The Ultricore Profiles interface displays in the DashBoard window. The following example 
shows the default interface (the ULTRICORE-PRO license is not enabled).
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Overview
When the ULTRICORE-PRO license is enabled, the Ultricore Profiles interface is organized into five 
distinct areas. Figure 11 Each area is briefly described in this section starting with the leftmost area 
of the DashBoard window.

Figure 11  Example of the Ultricore Profiles Interface with the ULTRICORE-PRO license

Users

When the system is configured to use the user login mechanism, a list of all currently configured 
usernames along with their current online status displays in this area.

Profiles

A list of all currently configured profiles. Selecting a profile (row) in this area automatically updates 
the items displayed in the Profile Details, Device Tree, and Options areas.
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Profile Details

This area displays the details of the profile showing the conditions under which the tree in the 
following section will be applied. 

Tree Nodes

A visual representation of the tree view that is defined in the Profile Details. Note that certain 
entries that are specific to licenses or other conditions may be visible but not in the actual tree view. 
Should conditions change that enable those entries, they will appear as shown in this display. A 
profile also maintains the position of items in groups allowing the most relevant items to be the 
easiest to reach.

The tree nodes are organized in a hierarchy where the top level (blue icons) list system specific 
options, and secondary levels (yellow icons) list specific functions. 

 This area only displays when the ULTRICORE-PRO license is enabled.

Group Tabs

This area displays all the available items that have not yet been assigned to the currently selected 
profile but are available to define.

 This area only displays when the ULTRICORE-PRO license is enabled.

Creating a Database of Users
If you wish to use the User Profile feature, the first step is to create a new user account. Once this 
account is created, all users will default to the Operator Profile (the default minimum profile) 
unless or until they have a profile created that allows them appropriate access for their role. 

When creating users and profiles, ensure that the system is not in use. Any currently active 
DashBoard instances will require users to login and features may be blocked. 

You can create as many users as required by your system.

To create a new user account

1. Display the Ultricore Profiles interface as outlined in “To display the Ultricore Profiles 
interface”.

2. Click Manage Users.

The Manage Users dialog opens.

 Users can change their own password at the login screen, the Update Password button allows 
an Administrator to reset a forgotten password. A user name change requires the deletion of the 
current user and the creation of a new one with the new user name.
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3. Click Add.

4. Use the User Name field to assign a unique identifier for the user account. 

5. Use the Password field to define the password the user will need to enter when logging in with 
this account.

6. Repeat this procedure for every new user you wish to create.

Once all the user accounts are created, you can proceed to create profiles and assign users to these 
profiles.

Creating a Profile
 The User Profiles features offers a significant flexibility to optimize the tools in front of individual 

operators which, if inadvertently mis-configured could lead to administrators being locked out. 
As such, it is a good idea for the administrator to ensure that no users are actively working within 
the system prior to making significant changes to users and profile settings. 

Four profiles are created automatically: 

• Engineer Admin Profile — a group profile giving access to all features and functions as has been 
available prior to the Ultricore Profiles feature. This profile is read-only by default.

• Operator Admin Profile — a group profile giving access to all non-engineering features and 
functions. This allows an operational Administrator the ability to configure and use all 
operational functions and databases of the systems. 

• Operator Profile — a group profile giving access to only the soft control panels. This allows users 
that are registered but either have no defined profile on a system or only require basic 
operational access the ability to control pre-configured operational functions of the systems. 

• Ultricore CC Admin Profile — a user profile which allows the “Administrator” user mentioned 
above to have full admin and engineering capabilities by using the Default Profile. This profile is 
read-only by default.

 All users default to the Default Tree Profile with no System Login required. In other words, until 
specifically enabled, the Ultricore Profiles feature is not engaged, and the systems will all behave 
as in previous versions. It should be noted that while the Ultricore Profiles feature is not engaged, 
the default user profile can be modified should the tree for all users need to be modified. 

To create a profile

1. In the Profiles area, click Manage Profiles. 

The Manage Profiles dialog opens.
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2. Click Add to create the new profile.

3. Use the Profile Name field to assign a unique name for the profile. 

Since the profile could be either specific to a user, a workstation or a group of users, it is 
recommended to create a name that reflects its purpose. For example, John Doe (a specific 
user), Graphics Operator (a group of users), or PCR1-TD (a workstation). 

4. Use the Username field to assign a specific user to the profile. 

An asterisk (*) indicates the profile applies to all users subject to the other profile detail entries. 

5. Use the Machine Name field to specify the OS/DNS machine name for a workstation. 

This allows the identification of a specific workstation in an environment where DHCP means 
the IP address may change over time. 

6. Use the IP Address field to specify the IP address for a workstation. 

This allows identification of a specific workstation in a statically addressed system. 

7. Use the Admin box to enable/disable (selected/cleared) access to admin functions.

For example, upload, reboot, refresh and other tasks that are not normal operational functional 
requirements. 

8. Use the Parent Profile to assign any of the currently configured profiles as a parent or 
reference profile for the profile being created or edited. 

9. Use the Use and/or Copy options to determine if the parent profile tree configuration is used 
directly by the profile being created or edited or copied into this profile allowing customization 
of the tree for the specific needs of the user. 

 If another profile tree is used rather than copied, changes to the tree need to be performed on 
the parent profile tree and will affect all users that “use” that parent profile and that the same 
change would need to be executed individually on all users that copied the parent profile tree. 

10. Repeat this procedure for every new profile you wish to create.

Defining the Permissions for a Profile
Once a profile is created, the remaining two areas of the Ultricore Profiles interface allow display 
and/or modification of the tree structure that will be enabled for the user or users of the selected 
profile. 

 This section only applies if the ULTRICORE-PRO license is enabled.
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Figure 12  Example of the Tree Nodes and Tabs for a Selected Profile

Overview
This section provides a brief overview of each area and their options.

Tree Nodes

The tree (the leftmost area) displays all the assigned options and their desired order in the tree 
structure much like the tree view in DashBoard for an Ultricore CC. The nodes in Ultricore Profiles 
tree view are determined by your system configuration and any licenses installed for your system. 
Buttons at the bottom of this area (Up, Down, Remove) allow entries to be moved up and down in 
the tree within the group to which the item belongs or removed if they are not required for the 
selected profile. When removed, the item is returned to the list of available items in the appropriate 
group tab. 

Group Tabs

The group tabs (the rightmost area) contain all items available in the group in question that are not 
included in the selected profile’s tree currently. If an item is not in the tree currently but required, 
the appropriate group tab is selected, the item required is selected and the Assign button is clicked 
moving it to the bottom of the appropriate group of the tree. The Up and Down buttons can then 
be used to order the tree items specific to the needs of the profile. 

When any changes are made to the tree structure(s), the changes are captured locally but are not 
recorded in the database until the Apply button on the bottom row is clicked. Clicking Apply 
records all the pending changes in the system database. Clicking Cancel will discard any unsaved 
changes. There are no pending changes if the Apply and Cancel buttons are not highlighted. 

Enabling the Ultricore Profiles Feature
Once you created the profiles and groups for your system, you can proceed to enable the Ultricore 
Profiles feature. Enabling the feature requires you to disable the current user credentials and 
settings and apply the profiles and groups you defined in previous sections. 

 Before proceeding, ensure that you created a new Administrator profile that has full access to 
your system. This is a separate profile from the default Ultrix Admin profile (which is read-only).

 This procedure requires a reboot of the Ultricore CC.
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To enable the Ultricore Profiles feature

1. In the Tree View of DashBoard, double-click the Product Info node.

The Product Info interfaces display in the DashBoard window.

2. Select the Setup tab.

3. Locate the Ultricore Profile Settings area.

You may need to scroll down the tab to view this area.

4. Clear the User Credentials box.

A dialog opens to confirm the selection.

5. Select the User Profiles box.

A dialog opens to confirm the selection.

6. Click Reboot.

Application of the Ultricore Profiles
Once the Ultricore Profiles function is enabled, all users from that point forward will initially receive 
a tree that only has a System Login entry. Once the user is created with either the default or a 
specific password by the Administrator, the user can login through a login page displayed in the 
DashBoard window. 

Figure 13  Example of the System Login Sub-node

To log in

1. In the Basic Tree View, locate the device you wish to access.

2. Expand the device nodes to display the System Login sub-node.

3. Double-click the System Login sub-node.

The System Login page displays in the DashBoard window.

4. Enter the credentials for the profile assigned to you.

5. Click Login.

• The login information is confirmed by the system, and the appropriate tree with all assigned 
pages and functions are immediately available for use in the DashBoard window. 

• The Login page updates to the Logout page. 

When you log out, the Basic Tree View returns to the System Login tree view. See Figure 13.

To change the password

• Click Change Pwd on the System Login page.

 The old password is required for the user to change the password and the new password needs 
to be confirmed to ensure the new password is as the user expects. If the old password is 
forgotten or lost the admin can force an update to the user password through the Manage Users 
dialog in the Users area of the Ultricore Profiles interface. 
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User Data Import/Export 
Due to the need to maintain different permutations of user data to system data, the Import/Export 
database functions now includes the ability to import databases with and without the user data 
(user accounts and profiles). In addition, the user files can be imported and exported independently 
to any chosen database. This allows for instance a different show configuration to be loaded while 
maintaining the same staff and location configuration or for a truck for instance, allows a new crew 
configuration to be loaded without changing system configurations. 
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Device Communication Setup
Ultricore CC functions as a central controller for the Ross routing system. From Ultricore CC, you 
can store and implement routing system configurations into a system while providing an overview 
of your entire routing system. 

 This chapter is applicable if you are running software version 5.6 or lower. Otherwise, refer to the 
Ultrix and Ultricore Database Guide for details on setting up communications.

Ultricore CC Communications Overview
A connection point is how the Ultricore CC is connected to routing system components such as 
routers (matrices), and remote control panels. A connection point defines the interface and the 
protocol to be used for communications. Once defined, Ultricore CC retrieves the information of 
any device on that connection point.

 Third-party device information is not automatically retrieved. These devices must be added 
manually. 

Ultricore CC provides bi-directional protocol translation to facilitate the control of third party or 
legacy routers as part of a Ross routing system. You can also integrate control over a Ross routing 
system by a third-party automation system. Table 4 lists the important communication ports for 
Ultricore CC.

Device Discovery in DashBoard
When DashBoard is launched, devices such as openGear frames and Ross NK routers, are listed and 
made available in the Tree View. DashBoard uses the open SLP protocol to locate devices on the 
same network as the computer running the DashBoard client software. There are two methods for 
adding a device to the Tree View in DashBoard: using the auto-connect feature of DashBoard or 
manually adding a device by specifying the IP address of the device. Both methods are described in 
more detail in the DashBoard User Guide.

Communications between Ultricore CC and the Devices in a Routing System
The Ultricore CC Connections interface enables you to use DashBoard to locate devices in your 
network. To enable Ultricore CC to function as the ‘master’ of the routing system, you must 
establish communications with the devices it is connected to and define how they are connected. 
Each router must have a connection point defined. For those devices that are not directly connected 
to your network, such as Ross NK Series routers, you must supply their connection information 
(NK-NET/NK-IPS) in the Connections interface. Once this information is entered into the interface, 
the Ultricore CC panel can communicate directly with the device.

Table 4  Communications Ports

Device Protocol Port
NK Routers TCP 5000

Ultrix Routers TCP 15000

Walkabout Discovery UDP 5555
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Connecting to an Ultrix Router
Ultricore CC may act as a master controller for one or more Ultrix routers as well and legacy Ross 
NK series devices. A connection is made from the controlling (primary) Ultricore CC panel to the 
(client) Ultrix router(s). The controlling Ultricore CC panel contains the full database configuration 
for the entire operation of the system.

 Ultricore redundancy is only available when using Ultricore BCS panels. Refer to the Ultricore BCS 
User Guide for more information.

For More Information on...
• configuring the Ultrix router, refer to the Ultrix User Guide.

General Work Flow

Figure 14  Work Flow for Setting up a Connection Point between Ultrix and Ultricore CC

Configuring the Ultriscape

The Ultriscape PiP and head destination mapping is required in the Ultricore CC 'master' database 
for each Ultriscape head in use by the Ultrix router. The procedure is the same as the Ultriscape 
configuration for a stand-alone Ultrix router. 

Mapping Logical Sources and Destinations

The physical inputs and outputs the Ultrix provides will display in the Port Labels tab of the 
Ultricore CC database. These input and outputs ports are now ready for re-naming (if required) and 
mapping to logical source and destinations.

Setup Notes
Keep the following mind when establishing a connection point from an Ultricore CC to an Ultrix 
router:

• Ensure unique device names for each Ultrix router. This allows identification of each individual 
router throughout the setup process. You can edit the name via the Ultrix front panel interface as 
outlined in the Ultrix User Guide.

• Ensure that the Remote Controller Mode is enabled for each client Ultrix router. Refer to the 
Ultrix User Guide for details.

• Client hardware configuration (licensing, port configuration, etc.) is achieved via its own device 
node within the DashBoard tree.

• Client Ultriscape Multiviewers are configured via the Ultriscape node within the DashBoard tree 
of the client Ultrix that physically hosts that Multi-Viewer.

• Routing commands are issued to the primary device via remote control panels, external 
protocols or DashBoard soft panels1. Any client router will ignore routing commands not 
originating from the primary while in this connected mode.

• The ULTRIX-FR12 requires connection to an Ultricore BCS.

1. Only the soft panels defined within the database of the Ultricore CC may control the system.
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Adding a Connection Point
Before defining a connection point between the Ultricore CC and an Ultrix router, you must verify 
that the router is listed in the Walkabout utility.

Once a connection point is established between the Ultricore CC and its client routers, the physical 
inputs and outputs the clients provide will display in the Port Labels tab of the primary Ultricore CC 
database. These input and outputs ports are now ready for renaming (if required) and mapping to 
logical source and destinations. 

To add an Ultrix connection point

1. Ensure each router is installed, configured, and listed in the Basic Tree View of your DashBoard 
client.

2. Launch the Walkabout utility in DashBoard as follows:

a. Expand the NK Utilities node in the Tree View.

b. Double-click Show Walkabout to open the Walkabout utility in the DashBoard window.

c. Verify that the Ultrix router is listed in the table of the Walkabout utility. 

d. Make a note of the router name and IP address.

3. Display the Connections tab in DashBoard for Ultricore CC as follows:

a. Expand the Database node in the Tree View.

b. Double-click the Connections node.

The Connections tab opens that lists the current database connection points.

4. Click Edit > Add.

The Add Connections dialog opens.

5. In the Add Connections dialog, perform the following:

a. Use the Protocol menu to select ultrix.

b. Use the Type menu to select tcp.

c. Use the Count menu to specify the number of new connection entries (rows) to make in the 
Connections table. For example, to connect to three Ultrix routers you would enter a value 
of 3.

d. Click Apply to create the new device row(s) in the Servers table.

The Add Connection dialog closes.

6. In the Name column of the Servers table, click the cell of the new Ultrix row to display the 
drop-down menu.

7. From the drop-down menu, select the Ultrix router you which to establish a connection to.

8. If the Ultrix router is not listed in the drop-down menu:
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a. Close the Connections tab.

b. Launch Walkabout to detect the on-line devices in your system.

c. Double-click the Connections node for the Ultricore CC to display its Connections tab.

d. Repeat steps 4 to 7.

9. In the Enabled column of the new row, select Enable.

10. Repeat steps 6 to 9 for each additional Ultrix router.

11. Click Apply at the bottom of the Connections tab to save the new settings.

Deleting a Connection Point
Once a connection point is deleted from the Ultricore CC database, the Ultricore CC panel and the 

Ultrix router will need to be re-configured as per the new requirements. This will require you to 
update the database(s) on each device.

To delete a connection point between Ultricore CC and an Ultrix router

1. Display the Connections tab for Ultricore CC as follows:

a. Expand the Database node in the Tree View.

b. Double-click the Connections node.

The Connections tab opens that lists the current database connection points.

2. In the Servers table, select the Ultrix connection to be deleted.

The row is now highlighted in the Servers table.

3. Click Edit > Delete.

4. Power cycle the Ultrix router to re-establish its own internal database.

5. Re-configure Ultricore CC and the Ultrix router as per the new requirements.

Connecting to Ross Ethernet Devices
A router must be defined for Ultricore CC to utilize it. A router or remote control panel may be 
defined using the auto-populated fields in the Connections tab in the Ultricore CC interface, or, in 
the case of third-party devices, with connection settings added manually to the fields. 

For More Information on...
• establishing communications with a third-party device, refer to “Connecting to Third-Party 

Devices”.

To establish communication between Ultricore CC and a Ross ethernet device

1. Launch the Walkabout utility in DashBoard as follows:

a. Expand the NK Utilities node in the Tree View.

b. Double-click Show Walkabout to open the Walkabout utility in the DashBoard window.

c. Verify that your Ross Ethernet device is listed in the table of the Walkabout utility. Make a 
note of its name and IP Address.

 If the device you want to connect to the Ultricore CC is not detectable in Walkabout, you can still 
establish communications with it in Ultricore CC using the Connections > Settings menu to 
manually enter/edit the device settings.

2. Display the Connections tab for Ultricore CC as follows:
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a. Expand the Database node in the Tree View.

b. Double-click the Connections node.

The Connections tab opens that lists the current database connection points.

3. Click Edit > Add.

The Add Connections dialog opens.

4. In the Add Connections dialog, perform the following:

a. Use the Protocol menu to specify the ethernet protocol the device uses to communicate 
with the Ultricore CC.

b. Use the Type menu to select tcp.

c. Use the Count menu to specify the number of new connection entries to make in the 
Servers table.

d. Click Apply to create the new device row(s) in the Servers table.

5. In the Name column, click the cell of the new row to display the drop-down menu.

6. From the drop-down menu, select the device you which to establish a connection to.

 Ross Video devices detected by Walkabout will auto-populate this menu. Third-party devices will 
require a chosen name to be typed into this field.

7. In the Enabled column of the new row, select Enable.

8. Click the [...] button to verify the IP Address and TCP port values for the device.

9. Click Apply at the bottom of the Connections tab to save the new settings.

Connecting to Ross NK Series Devices
Ross NK routers and remote control panels are linked via the T-Bus Control System, a multi-drop 
RJ-45 control system. These T-Bus devices can communicate over Ethernet via a Ross NK-IPS or 
NK-NET.

A connection point between the Ultricore CC and an NK-IPS or NK-NET is defined using the 
auto-populated fields in the Connections tab of the Ultricore CC interface. Once a connection point 
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is established, the Ultricore CC gains control over those Ross NK devices connected to the NK-IPS or 
NK-NET.

To establish a connection point between Ultricore CC and an NK-IPS or NK-NET

1. Launch the Walkabout utility in DashBoard as follows:

a. Expand the NK Utilities node in the Tree View.

b. Double-click Show Walkabout to open the Walkabout utility in the DashBoard window.

c. Verify that your the NK-NET and/or NK-IPS device is listed in the table of the Walkabout 
utility. Make a note of its name and IP Address.

 If the device you want to connect to the Ultricore CC is not detectable in Walkabout, you can still 
establish communications with it in Ultricore CC using the Connections > Settings menu to 
manually enter/edit the device settings.

2. Display the Connections tab for Ultricore CC as follows:

a. Expand the Database node in the Tree View.

b. Double-click the Connections node.

The Connections tab opens that lists the current database connection points.

3. Click Edit > Add.

The Add Connections dialog opens.

4. In the Add Connections dialog, perform the following:

a. Use the Protocol menu to select Ross NK.

b. Use the Type menu to select tcp.

c. Use the Count menu to specify the number of new connection entries to make in the 
Servers table.

d. Click Apply to create the new device row(s) in the Servers table and close the Add 
Connections dialog.

5. In the Name column, click the cell of the new row to display the drop-down menu.

6. From the drop-down menu, select the device you which to establish a connection to.

 Ross Video devices will auto-populate this menu.

7. In the Enabled column of the new row, select Enable.

8. Click the [...] button to verify the IP Address for the device.

9. Click Apply at the bottom of the Connections tab to save your settings.

Connecting to Ross NK Series Devices via T-Bus
The Ultricore CC hardware contains a loop-though T-BUS port for direct communication with Ross 
NK Series devices. A connection point for this T-BUS port is defined by default in Ultricore CC. 

To establish a connection between Ultricore CC and a Ross NK Series Device via T-Bus

1. Physically connect the Ross NK series to the T-BUS port on the Ultricore CC rear panel as 
outlined in “To connect the Ultricore CC to a NK Series device via T-BUS”.

2. Follow the instructions in “Integrating Ross NK Series Devices with Ultricore CC”.

Ultricore CC will load the information from the Ross NK series devices for further database 
configuration.
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Connecting to Ross Remote Control Panels
An Ultricore CC can communicate with external remote control panels such as the Ross RCP-NK 
series, RCP-ME, and RCP-QE. Communication with Ethernet enabled panels is direct from the panel 
to Ultricore CC. Refer to the panel user manual for specific configuration details.

RCP-NK Series Panels
Communication with RCP-NK series panels is via an established connection point with either an 
NK-IPS or NK-NET network bridge. Refer to the RCP-NK User Guide for details.

 RCP-NK series control panels do not automatically receive the active database labels. The 
database labels must be replicated on the each RCP-NK series device.

RCP-ME and RCP-QE Panels
The connection from the remote control panel to Ultricore CC is configured on the panel’s 
DashBoard interface.

1. Display the RCP Connection Editor in DashBoard for your remote control panel. Refer to the 
user guide for your remote control panel for details.

2. Locate the Servers to Connect table.

3. In the first row of the table, use the IP address column to specify the IP address of the Ultricore 
CC that the remote control panel will communicate with.

4. Send the current configuration file to the remote control panel. Refer to the user guide for your 
remote control panel for details.

The remote control panel will connect to the Ultricore CC router and receive a copy of the 
current database labels.

Connecting to Third-Party Devices
Ultricore CC provides bi-directional Ethernet and Serial protocol support with labels to facilitate 
control of:

• third party and legacy routers as part of the Ultricore CC routing system
• an Ultricore CC routing system by third party control or automation system

 Before proceeding, ensure that your third-party device is installed and configure according to its 
documentation.

Overview
Ultricore CC provides bi-directional translation of the following third-party protocols:

• GVG Native serial and Ethernet protocols
• Probel SW-P-08 serial protocol

Connection to third-party devices may be categorized into two broad groups: controller and 
controllee.

• Controllers are devices that will control the Ultricore CC and connect via what may be termed an 
incoming connection.

• Controllees are devices to be controlled by Ultricore CC router and connect via what may be 
termed an outgoing connection.
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For More Information on...
• the protocols and ports for configuring third-party communications on Ultricore CC, refer to 

Table 5 and Table 6.
• the commands that Ultricore CC supports, refer to “External Control”.
• connecting a third-party device to the serial port on the Ultricore CC rear panel, refer to 

“Connecting the Ultricore CC to a Serial Device”.

Incoming Ethernet Connections
The Ultricore CC can communicate with third-party external devices via a TCP connection. By 
default, Ultricore CC runs a server process for the following Ethernet protocols:

These Ethernet servers are always running. No further configuration is required — simply configure 
your client device to match the Ultricore CC’s TCP/IP address and port number.

Outgoing Ethernet Connections
This section outlines how to configure a client connection (out-going control) interface to the 
external system.

To set up a connection over Ethernet between Ultricore CC and a third-party device

1. Expand the Database node.

2. Double-click the Connections node located under the Database node.

The Connections tab opens that lists the current database connection points.

3. Click Edit > Add.

The Add Connections dialog opens.

4. In the Add Connections dialog, perform the following:

a. Use the Protocol menu to select the Ethernet protocol the device uses to communicate with 
the Ultricore CC. Refer to Table 5 for a list of options.

b. Use the Type menu to select tcp or udp as required by the external device.

c. Use the Count menu to specify the number of new connection entries to make in the 
Servers table.

d. Click Apply to create the new device row(s) in the Servers table.

Table 5  Supported Protocols — Ethernet Connection

Protocol Default Port
GVG Native Series 7000 TCP: 12345

Probel SW-P-08 TCP: 8910

RossTalk TCP: 7788

TSL UMD v3.1 TCP: 5727
UPD: 4490

TSL UMD v4.0 TCP:5728
UDP: 4491

TSL UMD v5.0 TCP: 5729
UDP: 4492
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5. In the Name field, type a unique identifier for the third-party device. This name is used to 
identify the specific device within the Ultricore CC database.

6. Click the [...] button in the new row to display the Communication dialog.

7. Use the Communication dialog to further define the server to connect to:

a. Use the Address field to specify the IP Address assigned to the third-party device.

b. Use the Port field to specify the Port Number assigned to the third-party device that the 
Ultricore CC will try to connect to.

c. Use the Wrapping field to specify the TSL UMD v5.0 TCP wrapping is enabled or disabled. 
This setting is ignored for other protocol types.

d. Click Apply to save your settings and close the dialog.

8. Edit the Description field to your requirements.

9. In the Enabled column of the new row, select Enable.

The Connected field in the Connections tab reports “Connect” when communication is 
established between the third-party device and Ultricore CC.

10. Click Apply in the Connections tab to save the new settings.

Defining a Serial Connection
Ultricore CC may communicate directly with third-party devices using a native serial protocol. The 
same protocols may also be implemented via serial connections with the following settings:

 A serial connection point must be implemented on the Connections tab in the Ultricore CC 
database before communications can start. The settings may be changed from the protocol 
defaults to suit your requirements.

Table 6  Supported Protocols — Serial Connections

Protocol
Settings

Type Baud Data Bits Parity Stop Bits
GVG Native Series 7000 RS232 or RS422 38400 8 None 1

Probel SW-P-08 RS232 or RS422 38400 8 None 1

TSL UMD v3.1 RS422 or RS485 38400 8 Even 1

TSL UMD v4.0 RS422 or RS485 38400 8 Even 1

TSL UMD v5.0 RS422 or RS485 38400 8 Even 1
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To set up a serial connection between Ultricore CC and a third-party device

1. Double-click the Connections node located under the Database node.

The Connections tab opens.

2. Click Edit > Add.

The Add Connections dialog opens.

3. In the Add Connections dialog, perform the following:

a. Use the Protocol menu to select the protocol standard.

b. Use the Type menu to select Serial.

c. Use the Count menu to specify the number of new connection entries to make in the 
Servers table.

d. Click Apply to create the new device row(s) in the Servers table.

4. In the Name field, type a unique identifier for the third-party device. This name is used to 
identify the device within the Ultricore CC system.

5. Click the [...] button in the new row to display the Communication dialog.

6. Use the Port field to specify the Port Number assigned to the third-party device that Ultricore 
CC will try to connect to.

7. From the Type menu in the Communication dialog, select RS232 or RS422.

The table in the Communication dialog updates to display the settings for serial 
communication.

8. Use the Type field to specify the serial transmission standard for the third-party device.

9. Use the Baud Rate field to specify the bit rate for the third-party device.

10. Use the Parity field to specify the parity for the third-party device.

11. Click Apply to save your settings and close the Communication dialog.

12. In the new row, select the Enabled box.

13. Click Apply to save your settings.

The Connected field in the Connections tab reports “Connect” when communication is 
configured and enabled between the third-party device and Ultricore CC. The system does not 
poll or query the serial link to verify the validity of the setup.

Creating a Logical Matrix for an External Device
If the external device presents a matrix of crosspoint switches for routing, you can create logical 
matrices in an Ultricore CC database using the device inputs and outputs. Creating a logical matrix 
from the external device enables Ultricore CC to include the inputs and outputs for selection in the 
Sources and Destination tabs of the Ultricore CC database.
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 The input/output range and level you specify in the Ultricore CC database must match the 
settings within the external matrix. 

To create a logical matrix from an external device

1. Expand the Database node.

2. Double-click the Third Party Matrices node located under the Database node.

The Third Party Matrices tab opens. 

3. Click Edit > Insert to add a blank row to the Third Party Matrices table.

4. In the Name field, type a unique identifier for the third-party matrix. This name is used to 
identify the matrix within the Ultricore CC database.

5. From the Device ID drop-down menu, select the device you want to define the logical matrix 
for. This is the name given to the device when you established a connection point with it on the 
Connections tab.

 The Device ID menu lists only the third-party devices that have a valid connection point with the 
Ultricore CC router.

6. Define the matrix size as follows:

a. Use the First Output and Last Output fields to define the range of destinations from the 
device within the Ultricore CC database.

b. Use the First Input and Last Input fields to define the range of sources from the device 
within the Ultricore CC database.

 These created inputs and outputs will use the nomenclature DeviceID.Slot.Port.Type.Channel 
where DeviceID represents the Name assigned to the external device on the Connections tab.

7. Use the Level field to specify the number of levels for the device within the Ultricore CC 
database.

8. Use the Type field to specify the signal type for the matrix. 

9. Click Apply.

The new matrix is saved to the database and is added to the list of available matrices in the Port 
Labels tab.
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Database Configuration
A database in Ultricore CC stores and implements a routing system configuration. Multiple 
databases can be configured using a different combination of devices, matrices, levels, sources, and 
destinations for the routings system. Procedures in this chapter assume that you have DashBoard 
launched and the Ultricore CC displayed in the Tree View.

 This chapter is applicable if you are running software version 5.6 or lower. Otherwise, refer to the 
Ultrix and Ultricore Database Guide for details on configuring databases.

How a Database Determines the Routing System
The various tables within an Ultricore CC router determine if a signal/route can be made from input 
to output.

For a given level, if there is a physical port mapped in both the Source and Destination tabs, and the 
controlling device has the level enabled, then a crosspoint switch can be issued and executed on 
the router(s). Table 7 outlines a database with four levels. Level 1 has mapped valid Sources and 
Destinations, and the level is enabled on the controlling device.

Configuration Overview
The generalized work flow of configuring a database for the Ultricore CC is:

1. Establish connection points to external devices. Refer to “Device Communication Setup”.

2. Verify available I/O ports to ensure correct system connections. This default port naming 
convention of frame.slot.port.type nomenclature is to be overwritten (if required) at this 
stage.

3. Create a database as outlined in “Creating a New Database”.

 Ultricore CC does not support Unicode characters.

4. Define a soft panel or establish a connection to a remote control panel (RCP).

Database File Management Overview
Each database consists of a collection of configuration files necessary for Ultricore CC operation. 
The database resides within the Ultricore CC storage system. Multiple databases may be saved and 
accessed at any time. 

Table 7  Example of a Multi-Level Database Setup

Level 1 Level 2 Level 3 Level 4
Is a physical source assigned?  Xa

a. An entry is not present in the corresponding Level column of the Source tab.

 

Is a physical destination assigned?   Xb

b. An entry is not present in the corresponding Level column of the Destinations tab.

X

Is the Level enabled on the Controller device?    X

Can a switch be executed? c

c. A resulting switch will be executed.

Xd

d. A resulting switch will not be executed. Physical ports from the same logical matrix must be entered in 
the same control level before a connection can be made.

Xd Xd
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For More Information on...
• the System Status tabs and menus, refer to “System Status Interfaces”.

Database management consists of the following tasks:

1. Use the System Status > Database tab to create, load, and delete databases. 

2. Use the System Status > Transfer tab to backup and restore databases.

Creating a New Database

A database manages the configuration file and settings for your Ultricore CC. Ultricore CC may use a 
number of database configurations depending on its role in the routing system. Refer to “Creating 
a New Database”.

Loading an Existing Database

Use the System Status > Database tab to load a configured database to your Ultricore CC. Refer to  
“Loading a Database”.

Exporting a Database

Enables you to capture a database configuration in a *.uda file that is saved to a location on your 
network that you can specify. Refer to “Exporting a Database”.

Importing a Database

Enables you to import a saved *.uda file and make it available in the System Status > Database 
tab. Refer to “Importing a Database”.

Deleting an Existing Database

You can choose to permanently delete any configured database on your Ultricore CC. Refer to 
“Deleting a Database”.

Creating a New Database
When you define a database, the information you enter into the Levels, Sources, and Destinations 
fields will auto-populate the applicable fields in the other interfaces for that Ultricore CC router. You 
can change the labels for the destinations and sources at any time using the options in the 
Destinations and Sources interfaces. There are two methods for creating a new database: using the 
Database Builder, or using the options in the System Status > Database tab. Both methods are 
described below.

Using the Database Builder
Use the Database Builder to quickly create a starting point database. Once you define the basic 
parameters of the new database using the settings in the Quick Start interface, you can then define 
the levels, destinations, and sources for the new database. This makes it very easy to build basic 
configurations as well as get a system up and running quickly. 

 Before proceeding, ensure that the required license keys are installed for the device(s) the 
database will be saved to. Refer to “Software License Keys” for more information.

To create a new database using the Database Builder

1. Display the Database nodes as outlined in “To access the Database interfaces in DashBoard”.

2. Double-click the Database Builder sub-node.
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The Database Builder interface opens in the DashBoard window with the Quick Start page 
automatically displayed.

3. Use the Provide a Name field to type a unique identifier for the database.

4. Select the box(es) from the provided list of detected routers the routers to make the database 
available to. 

5. If you wish to leave the remaining settings at their default values and quickly setup a database, 
you can click Finish and the database will be generated based on selected routers in step 4.

 Click Next, located at the bottom of the DashBoard window, to display the next page of options 
in the Database Builder interface.

6. If any AUX Ports are populated with SFP modules, use the Include AUX ports menu to specify 
how to label the I/O in the database.

 The default is Insert at Slot, which labels the I/O in each slot as 1-18 with the AUX Ports as 17 and 
18.

7. Use the Support Video Signal and Number of Audio Channels menus to define the Levels in 
the database.

8. Use the Breakaway Source Support menus to implement audio shuffling. The options for SDI 
and MADI channels are as follows: 

• None — there are no audio channels of this type.
• Mono — audio channels are applied to all levels
• Stereo — audio channels are assigned by pair (1-2, 3-4, 5-6 etc.)
• Quad — audio channels are assigned in groups of four (1-4, 5-8, 9-12 etc.)
• Oct — audio channels are assigned in groups of eight (1-8, 9-16, 17-24 etc.)

 You must have SFP modules installed that support MADI.

9. Use the Disconnect Source menu to set unused audio channels to disconnect.

10. Use the Passthrough Source menu to route the sources without changes/edits.

11. If you have an UltriScape license installed, use the last set of menus to define the heads, 
including the number of Picture in Picture (PIPs) that new layouts can include. 

 You can still create and edit layouts in a database with settings that differ from these.
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12. Click Next to review the levels, destinations, and sources tables before completing the database 
builder.

a. Use the Levels page to review or rename the level labels if required.

b. Use the Destination page to review the destination label to physical port mapping. 
Renaming the labels is also possible from this page if required.

c. Use the Sources page to review the source label to physical port mapping. Renaming the 
labels is also possible from this page if required.

13. Click Finish to create the new database and apply it to the routers selected in step 4.

 Click Rename to define multiple elements. For example, clicking Rename on the Sources page 
enables you to define a prefix (e.g. SRC) and apply from a starting point (input 4).

Using the Database Tab
You can use the Database tab in the System Status interface when only configuring a database for a 
single device.

For More Information on...
• assigning destinations, refer to “Defining the Destinations in a Database”.
• assigning sources, refer to “Defining the Sources in a Database”.

To create a new database

1. In the Tree View of DashBoard, double-click the System Status node.

The System Interfaces display in the DashBoard window.

2. Select the Database tab.

3. Locate the Add Database options in the Database Management area of the tab.

4. In the Add Database Name field type a unique identifier for the database. When the database is 
currently loaded in the system (in use), the Database node displays the database name in the 
tree view under the Ultricore CC node.

5. Select the Include I/O Maps box to create a database to match the quantity of BNC I/O ports 
available in the connected router.

 Each SDI IN/OUT ports will be mapped to the default labels of SRC# and DST# respectively for 
Level 1 only (SDI). The Destinations and Sources fields are ignored, but the Level field is applied.

6. Use the Levels field to specify the total number of levels available in the database.

7. Use the Sources field to specify the total number of inputs available in the database.

8. Use the Destination field to specify the total number of outputs in the database.

9. Click Database Add to create the new database and save it to the Ultricore CC file system.
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10. Load the database to ensure it is active before proceeding to customize it.

Loading a Database
Each active database includes a unique setup saved to the Ultricore CC file system. You must recall 
a database before you can configure the matrices, levels, sources and destinations, and soft panels 
for a particular setup. This also enables you to quickly recall a saved (configured) routing setup just 
by recalling a different database. 

To load a saved database

1. In the Tree View, double-click the System Status node.

2. Select the Database tab.

3. From the Name menu in the Load Database area, select the database you want to load.

4. Click Load.

5. Verify the following to ensure the database was loaded:

• The Name, Levels, Sources, and Destination read-only fields in the Current Database area 
in the Database tab report the correct values.

• The Database node in the Tree View for the Ultricore CC now reports the correct Database 
name. 

Defining the Levels in a Database
A level is a term used to describe a section or layer of the routing system (e.g. video level, audio 
level). Ultricore CC uses level definitions for easy identification and control of various routing 
matrices or parts of the system. The levels defined in the Levels tab have a direct relationship with 
the Level columns found in other database tabs.

Before You Begin
Determining the amount of levels needed requires a little planning.

Ultricore CC may operate with as little as a single level to define control of the Ultrix SDI switching 
matrix. Ultricore CC also allows independent routing of SDI embedded audio channels as well as 
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MADI channels. Using one single level of control will limit the independent selection of embedded 
audio and/or MADI streams. 

Any Ross NK series routers or other third-party routers attached to the Ultricore CC system will 
require their own control level/s.

 The quantity of levels determines how many independent input/output ports (including 
embedded / MADI channels) may be grouped together as one source or destination selection.

Examples

A single control level can be used when there is limited independent embedded audio/MADI 
channel switching. 

 If AFV (audio-follow-video) is desired on a single level database, the Audio Bypass must be 
enabled for each input and output port or disable the Ultrimix function.

 A single level setup with NK-A64 analog audio router attached would require the following levels: 

A setup using SDI with 4 embedded audio levels. This can allow independent switching of 4 of the 
embedded SDI channels and grouping of 4 MADI channels.The following levels would be required:

To define a level in the database

1. Double-click the Levels node located under the Database node.

The Levels tab opens.

2. Verify the ID field to specify the priority of the level.

 The ID field is a row number automatically defined by the routing system. This ID value 
corresponds to level numbers when used in Remote Control Panel (RCP) configurations and 
third-party communications.

3. To re-name a level:

a. In the Name column, type a unique identifier for the level. It is recommended to use words 
that describe the level such as 3G, Audio, etc.

b. Click Enter to update the name.

4. To select a unique color that will represent the level in the soft panels:

ID Name
1 SDI

ID Name
1 SDI

2 AnAud L

3 An Aud R

ID Name
1 SDI

2 A1

3 A2

4 A3

5 A4
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a. In the Color column, click the cell for the level you want to configure to display the Color 
Select dialog.

b. Select the hue from the provided vertical color grid in the Color Select dialog.

c. Use the Saturation options to specify the depth of the color.

d. Use the Lightness options to specify the amount of white or black mixed with the selected 
hue.

e. Confirm that the field beneath the color grid displays the correct color for the level.

f. Apply your changes using one of the following options:

• Click Live to preview the color scheme and apply it but not close the Color Select dialog; 
or

• Click OK to apply the new color to the level and close the Color Select dialog.

5. To provide additional information about the level:

a. In the Description column, type a brief summary of the level or provide additional 
information about the level use or purpose. This column is for identification purposes only 
and not required for operation.

b. Click Enter to update the description.

 Inserting a level in a working database can have destructive effects. It is recommended to insert 
below the last row to minimize this effect.

6. Click Apply to save your changes.

To create additional levels

1. Select a row in the Levels tab.

2. Click Edit.

 You can also copy and paste an existing level by clicking Copy > Paste from the Edit dialog.

3. To add a single level, select Add.

4. To add multiple levels:

a. Select Add Series to display the Add Rows dialog.

b. In the Prefix field, type the phrase. For example, if you want to create levels as AUDIO 1, 
AUDIO 2, etc., you would type AUDIO into the Prefix field.

c. In the Start Value field, type the first number to be used in the series.

d. In the End Value field, type the last number to be used in the series.

e. Click Apply.

To delete an entry from the Levels table

1. Select the row for the destination to delete in the Levels tab.

2. Click Edit > Delete.

 Ensure the ID numbers are correctly sequenced when deleting and inserting entries in the Levels 
table by selecting Edit > Reset All IDs.

Defining the Destinations in a Database
Ultricore CC uses a database to assign inputs and outputs, as well as define levels and matrices. 
Table 8 outlines the available outputs for mapping to the destinations in your database. 



68 • Database Configuration Ultricore CC User Guide (v15-rev2)

For More Information on...
• defining a database, refer to “Creating a New Database”.

Specifying a Destination Label
The Destinations tab allows the definition of names (or labels) for your routing system outputs. 
When a database is initialized, default labels of Dest # are automatically filled in to the quantity 
specified by the database. These destination labels may be changed to suit your naming 
conventions.

To specify a label for a destinations

1. Double-click the Destinations node located under the Database node.

The Destinations tab opens.

Table 8  Mapping Outputs to Database Destinations

Default Slot Label

Physical 
or 

Virtual 
Port? Description

Slotx.out[y].sdi.ch1 P Digital video output slot x port y

flex.out[y].sdi.ch1 P Digital video output flex slot port y (ULTRIX-FR5 only)

Slotx.out[y].audio.chn P Digital audio channel n of output slot x port y

flex.out[y].audio.chn P Digital audio channel n of flex slot output port y (ULTRIX-FR5 
only)

Slotx.head[y].sdi.ch1 V Ultriscape video output slot x head y 

Slotx.heady-pip[z].sdi.ch1 V Video destination for PiP z of slot x Ultriscape Head y

Slotx.heady-pip[z].meter.chn V Audio destination for meter n PiP z of slot x Ultriscape Head y

Slot0.mixer-in[y].audio.ch1 V Audio destination mixer input port y

Slot0.virt-out[y].sdi.ch1 V Acuity AUX BUS output port y
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2. Select the cell in the Name column of the label to alter.

3. Type the required label.

4. Press Enter to apply the change.

 Take care to limit the amount of characters as these labels are displayed on Remote Control 
Panels (RCPs) which have a limited display area.

5. Repeat steps 2 to 4 for each destination you want to specify a virtual label for.

6. Click Apply at the bottom of the Destinations tab to save your changes.

Mapping an Output to a Destination
The Destinations tab is organized into a table with each row representing a Destination and each 
column representing a Level. The table cells are the output ports assigned to the Destination for 
that level. Initially, the table cells are empty (e.g. the destination labels are not assigned to physical 
output sockets). These may be populated as described in “To map a physical output to a 
destination”, or, via the Advanced Fill tool.

The Advanced Fill tool is provided to create new destination labels that are automatically assigned 
to physical outputs depending on options set by the user. The audio routing features provided by 
Ultricore CC can result in an extensive source and destination definition map requiring some time 
to manually enter. The Advanced Fill tool will speed the assignment of physical ports greatly.

Various editing options are available from the editing menus, accessed via the Edit button located 
on the bottom toolbar of the tab.

  If you are defining the destinations in a database for use with UltriScape, it is recommended to 
first define the destinations using the Advanced Fill tool, then re-name the UltriScape Heads as 
required. Otherwise there may be duplicate assignments of channels in the database.

For More Information on...
• assigning Tally IDs to destinations, refer to “Assigning the Tally IDs to the Destinations”.

To map a physical output to a destination

1. Double-click the Destinations node located under the Database node.

2. If desired, type a new name for the destination in the Name cell as outlined in “To specify a 
label for a destinations”.

3. In the Destinations tab, locate the column for the level you wish to include in the destination 
definition.

4. To map a single output, perform one of the following:

• Select the cell of the row in the table to display a list of available outputs; or
• Choose an output from the available Matrix Outputs list and click Assign.

 Cell ranges may be horizontal as well as vertical. For example, a common operation would be to 
assign SDI embedded channels 1 to 16 to levels 2 to 17. The selected range would be horizontal 
across many levels but the selection would be vertical from the available outputs. The 
assignment operation will take the top most of the available outputs selection and assign it to the 
left most of the horizontal selection and so on through the selection range.

5. To map a range of outputs:

a. Select the first cell in the table column.

b. Press and hold Shift.

c. Select the last cell in the table column. 

d. Select a range in the available Matrix Outputs list with the same click + shift-click method.
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e. Click Assign.

6. Click Apply at the bottom of the Destinations tab to apply the changes to the database.

To map a series of outputs to the same level

1. In the table of the Destinations tab, select the first row in the series you want to define for the 
level.

2. Press and hold Shift.

3. Click the last row in the series to select a range of cells within a Level column.

4. Select a range of outputs as outlined in “To map a physical output to a destination”.

5. Click Assign.

6. Click Apply at the bottom of the Destinations tab to apply the changes to the database.

To delete an entry from the Destinations table

1. Select the row for the destination to delete in the Destinations tab.

2. Click Edit > Delete.

 Ensure the ID numbers are correctly sequenced when deleting and inserting entries in the 
Destinations table. To re-order the Destinations ID numbers in the database, click Edit > Reset 
All IDs in the Destinations tab.

Configuring the Destination Follow Feature
The Destination Follow feature enables you to route a specific destination’s source signal to another 
destination. For example, set Dest 1 to follow Dest 6 so when Dest 6 is switched to a different 
source, Dest 1 is also switched to that same source. You can set multiple destinations to follow 
another single destination, or each following their own unique destination.

To configure the Destination Follow feature

1. Double-click the Destination Follow node located under the Database node.

The Destination Follow tab opens.

2. Locate the row for the destination to configure.

3. Use the Following menu to specify the output that the selected Destination will follow.
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In the example below, the user is configuring Dest1 to follow Dest6.

Defining the Sources in a Database
Ultricore CC uses a database to assign inputs, as well as define levels and matrices. Table 8 outlines 
the available inputs for mapping to the sources in your database. 

For More Information on...
• assigning Tally IDs to sources, refer to “Assigning the Tally IDs to the Sources”.

Specifying a Label for a Source
The Sources tab allows the definition of labels for your routing system inputs. When a database is 
initialized, default labels of Src # are automatically filled in to the quantity specified by the 
database. These source labels may be changed to suit your naming conventions.

Table 9  Mapping Inputs to Database Sources

Default Slot Label

Physical 
or 

Virtual 
Port? Description

Slotx.in[y].sdi.ch1 P Digital video input slot x port y 

flex.in[y].sdi.ch1 P Digital video output flex slot port y (ULTRIX-FR5 only)

Slotx.in[y].audio.chn P Digital audio channel n of input slot x port y 

flex.in[y].audio.chn P Digital audio channel n of flex slot input port y (ULTRIX-FR5 
only)

Slot0.disconnect[1].sdi.ch1 V A ‘no signal/disconnected’ video source 

Slot0.disconnect[1].audio.ch1 V A ‘no signal/disconnected’ audio source 

Slot0.passthrough[1].audio.ch1 V Audio on this channel will follow video regardless of audio 
matrix 

Slot0.layout:name[n].mv.ch1 V Ultriscape Head layout file name id n – route a layout to a 
head to change Ultriscape layouts 

Slot0.mixer-out[y].audio.ch1 V Audio source for mixer output port y

Slot0.mixerd-out[y].audio.ch1 V Audio source for mixer channel strip direct output port y

Slot0.virt-in[y].sdi.ch1 V Acuity AUX BUS Input port y
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To specify a label for a source

1. Double-click the Sources node located under the Database node.

The Sources tab opens.

2. Select the cell in the Name column of the label to alter.

3. Type the required label.

4. Press Enter to apply the change.

 Take care to limit the amount of characters as these labels are displayed on Remote Control 
Panels (RCPs) which have a limited display area.

5. Repeat steps 2 to 4 for each destination you want to specify a virtual label for.

6. Click Apply at the bottom of the Destinations tab to save your changes.

7. Click Apply at the bottom of the Sources tab to save your changes.

Mapping an Input to a Source
The Sources tab allows the mapping of physical and virtual input ports to your routing system 
inputs. The tab is organized into a table with each row representing a Source and each column 
representing a Level. At the top of the column is the name of the Level. The table cells are the input 
ports assigned to the source for that level.

An Advanced Fill tool is provided to create new source labels that are automatically assigned to 
inputs depending on options set by the user. The audio routing features provided by Ultricore CC 
can result in an extensive source and destination definition map requiring some time to manually 
enter. The Advanced Fill tool will speed the assignment of ports greatly. 

Various editing options are available from the editing menus, accessed via the Edit button located 
on the bottom toolbar of the tab. 

To map a physical input with a source

1. Double-click the Sources node located under the Database node.

2. If desired, type a new name for the source in the Name cell as outlined in “To specify a label 
for a source”.
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3. In the table of the Sources tab, locate the column for the level you wish to include in the source 
definition.

4. To map a single input, perform one of the following:

• Select the cell of the row in the table to display a list of available input sockets; or
• Choose an input from the available Matrix Inputs list and click Assign.

 Cell ranges may be horizontal as well as vertical. For example, a common operation would be to 
assign SDI embedded channels 1 to 16 to levels 2 to 17. The selected range would be horizontal 
across many levels but the selection would be vertical from the available inputs. The assignment 
operation will take the top most of the available inputs selection and assign it to the left most of 
the horizontal selection an so on through the selection range.

5. To map a range of inputs:

a. Select the first cell in the table column.

b. Press Shift.

c. Select the last cell in the table column. 

d. Select a range in the available Matrix Inputs list. 

e. Click Assign.

6. Click Apply at the bottom of the Sources tab to apply the changes to the database.

To map a series of inputs to the same level

1. In the table of the Sources tab, select the first row in the series you want to define for the level.

2. Press and hold Shift.

3. Click the last row in the series to select a range of cells within a Level column.

4. Select a range of inputs as outlined in step 5 of “To map a physical input with a source”.

5. Click Assign.

6. Click Apply at the bottom of the Sources tab to apply the changes to the database.

To delete an entry from the Sources table

1. Select the row for the destination to delete in the Sources tab.

2. Click Edit > Delete.

 Ensure the ID numbers are correctly sequenced when deleting and inserting entries in the 
Sources table. To re-order the Sources ID numbers in the database, click Edit > Reset All IDs in 
the Sources tab.

Using the Advanced Fill Tool
The Advanced Fill operation is typically a tool used to initially set up an Ultricore CC database. Edits 
and customization may then be performed after the Advanced Fill tool has done the bulk of the 
work.

The following examples are shown on a new database with only database default settings loaded.

 Take care when determining label names. While a long name may be nice and descriptive for the 
Source and Destination tabs, many control devices have limited screen space and labels may be 
truncated.

For More Information on...
• the settings and menus available in the Advanced Fill tool, refer to “Advanced Fill Tool”.
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Create Source Labels with Assignments for SDI Video Levels
The objective of this example is to insert new labels and assignments for inputs for all routers on 
SDI Levels only.

To create source labels with assignments for SDI video levels

1. Define the levels as outlined in “Defining the Levels in a Database”.

2. Select an entry point in the Sources tab from where the new labels and assignments will begin.

a. Double-click the Sources node located under the Database node.

The Sources tab opens. 

b. Select the cell of the row for the entry point. The new entries will be inserted below this row.

c. Click Edit > Fill.

The Breakaway Fill dialog opens.

3. If required, select Fill > Entire Device.

4. In the Name field, type a label prefix. Enter a trailing space to ensure a space between the 
prefix and the numerical counter.

5. From the AUX Port menu, define the router AUX ports. 

6. From the Slot menu, select the first slot in the router. (e.g. Ultrix.slot1)

7. From the Port menu, select the first IN port. (e.g. Ultrix.slot1.in[1])

8. From the Starting Channel menu, select the first channel of the selected port. (e.g. 
Ultrix.slot1.in[1].sdi.ch1)

9. In the Levels table of the dialog, select the fully qualified Input assignment name from the I/O 
Assignment column.

10. Click Apply.

The dialog closes, and the Source tab updates with the newly created and insert labels with 
assignments.

 The Ultrix AUX ports are defined in the list. In this case, these would only be usable providing an 
SFP module that includes an SDI video input was installed into the relevant AUX port on the Ultrix 
rear panel.
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Create Destination Labels with Assignments for SDI Video Levels
The objective of this example is to insert new labels and assignments for Ultricore CC outputs for 
the SDI only level.

To create destination labels with assignments for SDI video levels

1. Define the levels as outlined in “Defining the Levels in a Database”.

2. Select an entry point in the Destinations tab from where the new labels and assignments will 
begin.

a. Double-click the Destinations node located under the Database node.

The Destinations tab opens. 

b. Select the cell of the row for the entry point. The new entries will be inserted below this row.

c. Click Edit > Fill.

The Fill dialog opens.

3. If required, select Fill > Entire Device.

4. In the Name field, type a label prefix. Enter a trailing space to ensure a space between the 
prefix and the numerical counter.
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5. From the AUX Port menu, define the router AUX ports.

6. From the Slot menu, select the first slot in the router. (e.g. Ultrix.slot1)

7. From the Port menu, select the first OUT port. (e.g. Ultrix.slot1.out[1])

8. From the Starting Channel menu, select the first channel of the selected port. (e.g. 
Ultrix.slot1.out[1].sdi.ch1)

9. In the Levels table of the dialog, select the fully qualified Output assignment name from the I/O 
Assignment column.

10. Click Apply.

The dialog closes, and the Source tab updates with the newly created and insert labels with 
assignments.

 The AUX ports of the Ultrix router are defined in the list. These would only be usable providing an 
SFP module that includes an SDI video output was installed into the relevant AUX port on the 
router rear panel.

Create Source Labels with Assignments for SDI and Embedded Audio
The objective of this example is to create source labels and assignments for the SDI video and the 
first four embedded audio channels for an entire Ultricore CC enabled slot. The remaining twelve 
audio channels are not used.

To create source labels with assignments for the SDI video and embedded audio levels

1. Ensure that you have the Ultrimix licensed feature enabled for the slot. Refer to the Ultrix User 
Guide for details.

2. Define one level for SDI Video and 16 levels for the embedded audio as outlined in the Ultrix 
User Guide.

3. Select an entry point in the Sources tab from where the new labels and assignments will begin.

a. Double-click the Sources node located under the Database node.

The Sources tab opens. 

b. Select the cell of the row for the entry point. The new entries will be inserted below this row.

c. Click Edit > Fill.

The Breakaway Fill dialog opens.
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4. If required, select Fill > Entire Slot.

5. In the Name field, type a label prefix. Enter a trailing space to ensure a space between the 
prefix and the numerical counter.

6. From the AUX Port menu, define the router AUX ports.

7. From the Slot menu, select the Ultrimix enabled slot in the router. (e.g. Ultrix.slot1)

8. From the Port menu, select the first port of the Ultrimix enabled slot. (e.g. Ultrix.slot1.out[1])

9. From the Starting Channel menu, select the first channel in the series.

10. In the Levels table of the dialog, select a range of Level rows by clicking the first row level 
name, then holding the Shift button, click the last row level name. 

 Ensure to select the SDI Video level and the first four embedded audio levels.

11. Click Assign to automatically fill the I/O Assignment column for the selected levels.

The Breakaway Fill dialog updates but does not close.

To set the unused audio channels to disconnect

1. From the Slot menu in the Breakaway Fill dialog, select Ultrix.slot0.

2. From the Port menu, select Ultrix.slot0.

3. From the Starting Channel menu, select Ultrix.slot0.disconnect[1].audio.ch1.

4. In the Levels table of the dialog, select the remaining twelve audio levels (e.g. A5-A16) from the 
I/O Assignment column.

5. Select Ultrix.slot0.disconnect[1].audio.ch1 from the I/O Assignment cell for the first selected 
row (e.g. A5).

The disconnect[1].audio will be applied to all the selected rows1.



78 • Database Configuration Ultricore CC User Guide (v15-rev2)

6. Click Apply.

The dialog closes, and the Source tab updates with the newly created and insert labels with 
assignments.

Creating Labels with Assignments for SDI and Embedded Audio, with Audio 
Breakaways
The objective of this example is to create and insert a series of labels with assignments for SDI video 
and embedded audio. Also, audio breakaway sources will be required to implement audio shuffling.

To enable the ability to shuffle audio (that is to take an audio channel and route into another 
stream in a different position within that stream), we need to define that audio channel as a source 
and assign it across all required levels.

For example, we may wish to take channel 3 audio from an input SDI stream, and route (just that 
individual channel) to channel 2 of an output SDI stream. To facilitate this, the following definitions 
are needed;

 If only four audio levels are defined as shown in Table 10, and assuming no other level 
definitions, the user can only route 'SDI 1 ch3' to any of the corresponding levels in the 
destination, i.e. cannot route 'SDI 1 ch3' to a destination stream channel 8 as Out[1].audio.ch8 is 
not defined in any of the destination levels.

1. Pass through may also be selected. Pass through has the effect of passing through any audio (silence or otherwise) 
on the channels A5 to A16. Disconnect effectively mutes those channels on the output stream.

Table 10  Example 1

SDI Level Level A1 Level A2 Level A3 Level A4
Source Name

SDI 1 ch3 <blank> In[1].audio.ch3 In[1].audio.ch3 In[1].audio.ch3 In[1].audio.ch3

Destination Name

SDI out1 Out[1].sdi.ch1 Out[1].audio.ch1 Out[1].audio.ch2 Out[1].audio.ch3 Out[1].audio.ch4
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To enact the previous example, the user selects the destination channel by selecting the 
appropriate level button on the control panel (in this case, the A2 level) before actuating the 
crosspoint switch (destination button SDIout1, then, source button SDI 1 ch1). The Advanced Fill 
tool can automate the creation of these audio breakaway sources saving a great deal of setup time.

To create source labels with assignments for SDI and embedded audio, with audio 
breakaways

1. Define one level for SDI Video and 16 levels for the embedded audio as outlined in “Defining 
the Levels in a Database”.

2. Select an entry point in the Sources tab from where the new labels and assignments will begin.

a. Double-click the Sources node located under the Database node.

The Sources tab opens. 

b. Select the cell of the row for the entry point. The new entries will be inserted below this row.

c. Click Edit > Fill.

The Breakaway Fill dialog opens.

3. From the Fill menu, select Entire Slot.

4. In the Name field, type a label prefix. Enter a trailing space to ensure a space between the 
prefix and the numerical counter.

5. From the Slot menu, select the Ultrimix enabled slot in the Ultrix router. (e.g. Ultrix.slot1)

6. From the AUX Port menu, define the router AUX ports.

7. From the Port menu, select the first port of the Ultrimix enabled slot. (e.g. Ultrix.slot1.out[1])

8. From the Starting Channel menu, select the first channel in the series.

9. In the Levels table of the dialog, assign physical ports to the levels. 

10. Select the BRK I/O box for the Levels assignment to be broken out to a separate 
label/assignment definition.

11. Select the BRK Level box for each level to be included in that label/assignment definition.

12. Click Apply.

The dialog closes, and the Source tab updates with the newly created and insert labels with 
assignments, and the audio breakaways definitions.
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 Notice the chx automatic suffix to the label. This may be overridden by placing text in the BRK 
Suffix cell of the Breakaway Fill dialog.

Creating Categories
You can assign each destination, source, and level to a specific category in the router database. 
Defining multiple categories enable you to filter the sources, destinations, and level and organize 
them into logical groups. Each database provides up to six categories that you can define.

For More Information on...
• managing the categories for your Ultricore CC database, refer to “Using Categories”.

Managing your Databases
A database can be archived by saving it as a *.uda file to a specified location. This enables you to 
import and export an archived database which is useful for:

• creating a safe, off-frame copy of a default database configuration
• importing a copy of a reference database that can be tailored to a specific application
• restoring a known backup copy of a database to an Ultricore CC

 This feature requires DashBoard v8.2 or higher.

Overview
The following information is captured when you archive a database:

• Definitions of levels, sources, and destinations
• Salvos
• Category assignments
• Soft panels
• User assigned port labels
• Current crosspoint status

 The following information is not captured: hardware specifics, and license settings.
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Exporting a Database
You create an archive of a database (as a *.uda file) using the options in the System Status > 
Transfer tab.

To export a database to the archive

1. In the Tree View of DashBoard, double-click the System Status node.

The System Interfaces display in the DashBoard window.

2. Select the Transfer tab.

3. Locate the Export area on the tab.

4. Use the Database field to specify the database to export.

5. Click Browse... to specify the location to save the *.uda file to.

The Archive read-only field updates with the selected path and database name.

6. Click Apply.

The Downloading Archive dialog opens to report the status of the export.

Importing a Database
Once a database is imported from the archive to your system, you can select it from the list of 
databases to load in the System Status > Database tab.

 The database is not automatically loaded. You must follow the procedure “Loading a Database” 
to load the imported database.

To import a database to an Ultricore CC

1. In the Tree View of DashBoard, double-click the System Status node.

The System Interfaces display in the DashBoard window.

2. Select the Transfer tab.

3. Locate the Import area on the tab.

4. Select the *.uda file you wish to import as follows:

a. Click Browse... 

The Open dialog opens.

b. Use the Open dialog to specify the *.uda file to import.

c. Click Open to close the dialog and load the file.

5. Click Apply.

The Uploading Archive dialog opens to report the status of the transfer.

6. Verify that the imported database is now available for selection in the System Status > 
Database tab.

Deleting a Database
 Ensure the database that you are about to delete is not currently loaded and in use by Ultricore 

CC.

To delete a database

1. In the Tree View, double-click the System Status node.

The System interface displays in the DashBoard window.



82 • Database Configuration Ultricore CC User Guide (v15-rev2)

2. Select the Database tab.

3. From the Delete Database Name menu, select the database you want to delete.

4. Click Database Delete.
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Tallies
Ultricore CC accepts TSL UMD tally messages, and passes tally messages associated with a router 
source to the routed destination tally status.

 This chapter is applicable if you are running software version 5.6 or lower. Otherwise, refer to the 
Ultrix and Ultricore Database Guide for details on configuring tallies.

Tally Types
Tally information may be associated with either routing system sources or destinations. Below is a 
summary of the implementations.

 Ultricore CC does not support Unicode characters.

Source Association

Tally IDs associated with routing system sources may serve two purposes:

1. Trigger any Ultriscape Multiviewers to display tally status (this requires that the Ultrix router has 
at least one Ultriscape Head enabled and configured).

2. Enable the tally status to be mapped to other Tally IDs based on router crosspoint status (the 
destination must have Tally ID associated and Tally Direct enabled).

To associate Tally IDs to sources in the database

• Use the Sources tab in the Database interface to associate the Tally IDs with logical sources in the 
Ultricore CC database.

• Choose the UMD “Tally Level”.

Destination Association

A Tally ID may be associated with routing system destinations. This enables any tally status 
associated with router sources to map to a different Tally ID associated with a router destination, 
based on current router crosspoint status.

• Use the Destinations tab in the Database interface to associate Tally IDs with logical 
destinations.

• When a source is switched to a destination on the selected Tally Level, Ultricore CC forwards the 
tally status of the source that is active on the destination, but the outbound TSL message has its 
display ID re-mapped to the display ID that is associated with the destination (Tally Redirect is set 
to ON).

 Ensure the destination Tally IDs do not conflict with Tally IDs asserted by other devices.

• When the TallyID is associated with an Ultriscape PiP (slotn.headx-pip[y] or slot0.pip[y]), any 
assertion on this TallyID will directly control the PiP tally visual elements and over ride any Tally 
associated with the PiP video source (Tally Redirect is set to OFF).

• For switcher support, the label of the connected source to a destination is sent as TSL tally text 
(TSL v3.1 only and when Tally Redirect is set to OFF).

Tally ID Format
Table 11 summarizes the format that the TSL protocol defines Display IDs that are associated with 
the tally displays.
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Keep the following in mind when using tally display IDs:

• TSL v3.1 and 4.0 protocol messages will always map to screen 0.
• When using TSL v5.0, the screen ID is assumed to be 0 if no screen ID is entered.
• If the controller is configured for either v3.1 or 4.0 protocol, it is not necessary to enter a screen 

ID.
• If the controller is configured for v5.0, it is only necessary to specify the screen ID if the tally 

controller is configured to send messages to tally displays on ‘screens’ other than the one with 
the screen ID of 0.

Router Tally Output Operation
Ultricore CC will track current Tally Status messages sent by a controller via Tally Display IDs 
associated with router sources. When a source (with a Tally ID) is routed to a destination (with a 
Tally ID), the router will emit Tally Status messages that reflect the current tally status of the Tally ID 
associated with the source, but that target the Display ID associated with the destination.

 An outgoing connection point must be defined for Ultricore CC to send the new status out.

Example

Consider the following source and destination configurations:

For the above configuration settings, the following states are possible:

Table 11  TSL Protocol — Tally ID Format

TSL Protocol 
Version Tally ID Format Range

3.1 <displayID> 0 - 127

4.0 <displayID> 0 - 127

5.0 <screenID>:<displayID> 0 - 65535 : 0 - 65535

Table 12  Example of Sources and Destinations Assigned to Tally IDs

Name Tally ID Tally Status
Sources

Src 1 5 T1:on

Src 2 10 T1:off

Destinations

Dest 1 33 T1:xxx

Table 13  Example of Sources and Destinations Assigned to Tally IDs

Router Status Tally Status
Src 1 > Dest 1 TallyID 33 = TallyID 5 (on)

Src 2 > Dest 1 TallyID 33 = TallyID 10 (off)
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Tally Routed Mode

The Tally Routed mode associates a tally with a specific router destination. Ultricore CC knows 
which input is routed to that output, and so can assert tally indicators wherever the input signal is 
displayed in an Ultriscape PiP. Refer to the Ultrix User Guide for details on this mode.

Router Status over TSL UMD v3.1 Operation
Ultricore CC can use the TSL UMD protocol version 3.1 to send the connected source database 
name as tally text. This requires you to:

1. Set up an outgoing TSL v3.1 connection.

2. Assign Tally ID numbers to the destinations you wish to track.

3. Ensure the Tally mode is set to None.

When a configured destination changes, the name of the new source will be sent as tally text. Ultrix 
will resend all the configured destinations every 1 minute, and immediately for any source change 
on a configured destination

Getting Started
You must first perform the following in the active database:

1. If RS-232 or RS-422 communication is required, add a serial connection point for either 
incoming or outgoing TSL protocol support.

2. Add an Ethernet connection point for outgoing TSL protocol support if not using the serial 
connection point described in step 1.

3. Enable Tally ID support.

4. Assign the Tally IDs to the sources.

5. Assign the Tally IDs to the destinations.

6. Set the Tally mode to None.

Adding a Serial Connection Point
Connections may be created via the Edit > Add menu on the Connections tab in the database 
interface. Refer to “Defining a Serial Connection” for details on adding a serial connection point to 
third-party devices.

Adding an Ethernet Connection Point
An Ethernet connection point must be added for outgoing TSL protocol support. Incoming Ethernet 
services are natively available. Refer to “Incoming Ethernet Connections” for details on adding an 
Ethernet connection point to third-party devices.

Enabling Tally ID Support
To enable tally ID configuration in an active database, you must select the Enable Tally box on the 
System Status > Database tab, and then define the Status Level for tally operation.

Enabling Tally ID Support in the Active Database
Once support is enabled, the Source and Destinations tabs display a Tally column which is used to 
assign Tally IDs to sources and/or destinations in the active database.



86 • Tallies Ultricore CC User Guide (v15-rev2)

To enable tally ID support in the active database

1. In the Tree View, double-click the System Status node.

The System interface displays in the DashBoard window.

2. Select the Database tab.

3. Verify that the active database is the one you wish to enable tally ID support for.

4. Select the Enable Tally box located in the Current Database area.

The Source and Destinations tabs automatically update to display the Tally column.

Defining the Status Level for Tally Operation
The Status Level specifies which level in the routing system is used to determine the current source 
switched to a given logical destination.

Generally this should be the main SDI Video level; which in most systems is the level to which the 
Ultriscape Head PiP and/or Router Video destinations are mapped in the system database.

To define the status level for tally operation

1. Double-click the Levels node located under the Database node.

The Levels tab opens.

2. Use the Tally Status Level menu (located at the bottom of the Levels tab) to specify the Level 
in the active database that will determine the tally status.

Assigning the Tally IDs to the Sources
Assigning a Tally ID to an Ultricore CC source enables configured Ultriscape displays to show tally 
information.

 Before proceeding, ensure you verify which TSL protocol you are using. The protocol determines 
how you must enter the information into the Tally cells of the Sources tab. Refer to Table 11 for 
details.

To assign a Tally ID to a source in the database

1. Double-click the Sources node located under the Database node.

The Sources tab opens.

2. Verify that the Tally column displays in the Sources tab. If it does not, refer to “Enabling Tally 
ID Support in the Active Database”.

3. Select the cell in the Tally column of the Sources tab to assign the Tally ID to.

TallyID 41 is associated with Src 1 in the 
Ultricore CC database. (TSL UMD v3.1 and 
v4.0)

Tally Screen 5, ID 41 is associated with Src 1 
in the Ultricore CC database. (TSL UMD v5.0)

Figure 15  Example of Sources with Assigned Tally IDs
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4. Type the Tally ID you wish to assign to that source.

5. Press Enter to apply the change.

6. Repeat steps 3 to 5 for each source you wish to assign a Tally ID.

7. Click Apply at the bottom of the Sources tab to save your changes.

Assigning the Tally IDs to the Destinations
Assigning a Tally ID to a standard Ultricore CC destination (e.g. not a PiP, audio mixer destination, 
etc.), enables currently routed source tally data to be output on a defined destination Tally ID, 
essentially routing the tally information along with the video.

 An outgoing connection point (either ethernet server or RS232/422 port) is required for Ultricore 
CC to emit tally information. 

 Before proceeding, ensure you verify which TSL protocol you are using. The protocol determines 
how you must enter the information into the Tally cells of the Destinations tab. Refer to 
Table 11 for details.

To assign a Tally ID to a destination in the database

1. Double-click the Destinations node located under the Database node.

The Destinations tab opens.

Tally ID 51 follows the connected source 
associated tally. This requires an established 
outgoing connection point. (TSL UMD v3.1 and 
v4.0 TallyID format).

Tally Screen 4, ID 11 follows the connected 
source associate tally. This requires an 
established outgoing connection point. (TSL 
UMD v5.0 TallyID format).

The label of the source currently connected to 
DST 1 will be sent as TSL text on Tally ID 5. (TSL 
UMD v3.1 only).

When Tally ID 8 is asserted, any PiPs showing 
the same source as routed to DST 1 also have 
their tally asserted (if defined on the PiP). For 
example, if DST 1 has source CAM 1 routed to it, 
and one or more Ultriscape PiPs also had 
source CAM 1 displayed, the PiP would display 
tally data from Tally ID 8.

The label of the source currently connected to 
destination DST 1 will be output as text in a TSL 
3.1 message with Tally ID 11. The Ultriscape PiP 
displays the tally information from Tally ID 11 
regardless of the displayed source video. 

The Ultriscape PiP displays tally information 
from the connected source associated Tally ID.

Figure 16  Example of Destinations with Assigned Tally IDs
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2. Verify that the Tally column displays in the Destinations tab. If it does not, refer to “Enabling 
Tally ID Support in the Active Database”.

3. Select the cell in the Tally column of the Destinations tab to assign the Tally ID to.

4. Type the Tally ID you wish to assign to that destination.

5. Press Enter to apply the change.

6. Select the Tally Redirect box to enable the connected source Tally ID to be directed to this 
destination Tally ID.

7. Repeat steps 3 to 6 for each destination you wish to assign a Tally ID.

8. Click Apply at the bottom of the Destinations tab to save your changes.
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Using Categories
Category navigation enables you to organize the sources, destinations, and/or levels in a router 
database to defined categories. There are three types of categories each with independent 
interfaces:

• Group — allows a user to organize database resources (sources, destinations, and levels) into 
folders and sub-folders with arbitrary group name. Resources may be assigned to multiple 
groups if required.

• Cat/Index — allows a user to piece together or build up the final resource name from category 
names and index identifiers.

• Legacy — allows compatibility with earlier RCP-QE models. Note that this is not available as a soft 
panel.

 This chapter is applicable if you are running software version 5.6 or lower. Otherwise, refer to the 
Ultrix and Ultricore Database Guide for details on using categories.

Group Categories Overview
 Group category mode is only available when running software version 2.0 or higher.

Group Category allows the user to organize database resources (sources, destinations, and levels) 
into folders and sub-folders with arbitrary group names. The group name is not required to match 
the resource names (it is similar to setting up file folders). This group categorization is useful when 
you need to group resources based on their operational regions, events, personnel credentials etc.

Example of a Group Category Setup

A user wants to arrange sources and destinations based on the types of sports the network 
broadcasts: baseball and football. The resources available are: 

Sources Destinations
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The resources need to be arranged into the following groups based on the sport type: 

The Group Category interface would be used to arrange the resources into group categories:

Figure 17  Example of Group Categories Arrangement Based on Sport Type

Once the group categories are defined, the user can perform switches, on a hard or soft panel, 
based on the group categories.

In the example below, the user uses RCP-QE18 to select the source labeled as HD 3.

Figure 18  RCP-QE18 — Selecting HD 3 via Category Mode

Baseball Football
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In the example below, the user uses a soft panel to select the destination labeled as SAT 1.

Figure 19  Ultricore CC — Selecting SAT 1 via a Soft Panel

Configuring Group Categories
Group categories are arranged in a hierarchy and displayed in a tree view. This is similar to the file 
system on your PC where each group is represented as a folder or node, and the resources 
included in that group are nodes. Each type of resource is represented within the hierarchy as 
follows: sources are green, destinations are blue, and levels are red. (Figure 20)

Figure 20  Example of Group Categories Tree View

Configuring group categories requires:

1. Creating group names

2. Assigning destinations, sources, and/or levels to groups

3. Configuring a soft panel or a hard panel for use
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Creating Group Names
For each database, you can create multiple category groups and add sub-groups. For example, 
Figure 20 shows two main groups (MV, and SDI) where the SDI group also has four sub-groups 
(Slot1, Slot2, Slot3, and Slot4). Once you create your groups, resources can be added.

 Ultricore CC does not support Unicode characters.

 By default, the groups are organized alphabetically in the tree view.

To create a category group

1. Double-click the Group Categories node located under the Database node.

The Group Categories tab opens.

2. Select the Group Categories: node.

3. Click Add.

The Add Group dialog opens.

4. In the Name field, type a unique identifier for the new group.

5. Click Apply.

The Add Group dialog closes and the new group is added as a child of the selected node.

In the example below, a new sub-group “Studio 1” was created below the SDI group.

6. Click Apply in the bottom right corner to apply your changes.

To create a category sub-group

1. In the Group Categories tree, select the group icon that you wish to add a sub-group to.

2. Click Add.

The Add Group dialog opens.

3. In the Name field, type a unique identifier for the new sub-group.

4. Click Apply.

The Add Group dialog closes and the new sub-group is added to the Group Categories tree 
view.

In the example below, a new sub-group “Cameras” was created within the Studio 1 group.

5. Click Apply in the bottom right corner to apply your changes.

To move a group within the tree view

1. In the Group Categories tree, select the group you want to move.

The Move dialog opens. Notice that the dialog header displays the name of the selected group 
to move.

2. Use the tree view in the dialog to select where to move the group to.



Ultricore CC User Guide (v15-rev2) Using Categories • 93

In the example below the Audio sub-group was selected to move to the Studio 1 root.

3. Click Apply.

The Move dialog closes and the group displays in the selected position of the tree view.

4. Click Apply in the bottom right corner to apply your changes.

Auto Generating the Groups
You can also choose to create a group based on the levels, sources, and destinations in your 
database or a combination. This requires the virtual labels for each resource to be consistent. For 
example, if all destinations are labeled as Dest x, a group will be created called “Dest” with each 
destination listed as a separate node.

 Auto generating a group will delete the groups currently listed in the Group Categories tree view.

To auto generate a group

1. Click Auto Generate.

The Auto Generate Groups dialog opens.

2. Select the box to include the resources in the group.

3. Click Apply.

The Auto Generate Groups dialog closes and the Group Categories tree updates.

4. Click Apply in the bottom right corner to apply your changes.

Assigning Resources to a Group
Once a group is configured, you can assign resources (destinations, sources, levels).

To assign a resource to a group

1. In the Group Categories tree, select the group you want to add a resource to.

The middle pane of the Group Categories interface updates to list the sub-groups or resources 
assigned to it.

In the example below the area is blank because nothing is assigned to the selected group.
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2. In the right pane, select the tab for the type of resource you wish to assign to the group.

In the example above, the Destinations tab was selected.

3. To assign a single resource, select the resource from the tab.

4.  To select a series of resources:

a. In the selected tab, select the first resource in the series you want to assign.

b. Press and hold Shift.

c. Click the last row in the series.

5. Click Assign.

The Group Categories tree updates to display the selected resources in the group.

In the example below, Dest 1 to Dest 6 were assigned to the Studio 1 group.

6. Click Apply in the bottom right corner to apply your changes.
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To move a resource to another group

1. In the Group Categories tree, select the resource you want to move.

2. Click Move.

The Move dialog opens.

3. Select the new location for the resource.

4. Click Apply.

The Move dialog closes.

The Group Categories tree updates to display the resource in the new location. Notice that the 
resource is now removed from the original group.

5. Click Apply in the bottom right corner to apply your changes.

To delete a resource from a group

1. In the Group Categories tree, select the specific resource you want to delete from the group.

2. Click Delete.

The Delete dialog opens.

3. Click Yes.

The Delete dialog closes.

The Group Categories tree updates to no longer display the resource in the group. 

4. Click Apply in the bottom right corner to apply your changes.

To delete a series of resources from a group

1. In the Group Categories tree, select the specific group you want to edit.

The middle pane of the Group Categories interface updates to list the sub-groups or resources 
assigned to it.

2. In the middle pane, select the first resource in the series you want to delete.

3. Press and hold Shift.

4. Click the last row in the series.

5. Click Delete.

The Delete dialog opens.

6. Click Yes.

The Delete dialog closes.

The Group Categories tree updates to no longer display the resource in the group. 

7. Click Apply in the bottom right corner to apply your changes.

Managing the Groups
 You cannot rename resources using the options in the Group Categories interface.

To rename a group

1. In the Group Categories tree, select the specific group you want to rename.

2. Click Rename.

The Rename Group dialog opens.

3. Use the Name field to enter a unique identifier for the selected group.
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4. Click Apply.

The Rename Group dialog closes.

The Group Categories tree updates to display the new name for the group. 

5. Click Apply in the bottom right corner to apply your changes.

To delete a group

1. In the Group Categories tree, select the group you want to delete.

2. Click Delete.

The Delete dialog opens.

3. Click Yes.

The Delete dialog closes.

The Group Categories tree updates to no longer display the group. 

4. Click Apply in the bottom right corner to apply your changes.

Cat/Index Categories Overview
Cat/Index category mode (also referred to as Category Index mode), allows alpha-numeric 
extensions to labels to 'build up' the final label selection. For example, VTR 1 - 6 may be expressed 
as a VTR label with numerical extensions 1 through 6. Similarly, alpha extensions may be used, for 
example, VTR A - E for VTRs A through E.

Destination and source names are split into substrings - the first substring traditionally referred to 
as the category, and subsequent substrings the indexes (e.g. Category VTR index 1 through 6). As 
source/destination names become more complex, an index may not be the final part of the 
selection name. For example, consider the source names CG TX 1 and CG TX 2; Cat/Index category 
mode may be configured so that a user selects CG, then TX, then either 1 or 2. This may be 
extrapolated to cover a large range of sources and destinations.

Example of a Cat/Index Category Setup

The resources available are: 

Sources / Destination Names
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The possible categories and indexes would be: 

Once the Cat/Index categories are defined, the user can perform switches, on a hard or soft panel, 
based on the categories.

In the example below, a RCP-QE18 is used to select the source labeled as CAM 1. Notice that only 
the sources are available for the second button selection. In this example, the user would need to 
select TAKE to make the switch.

Figure 21  RCP-QE18 — Selecting CAM 1 via Category Mode

In the example below, an Ultricore CC soft panel is used to select the destination labeled as CG RX 
2.

Figure 22  Ultricore CC — Selecting CG RX 2 via a Soft Panel

Categories Indexes

CAM_a

a.The “_” characters represents a blank space. This indicates the 
category will filter resources with a space in the name (e.g. the CAM_ 
category will allow resources named CAM 1, CAM 2 but not CAM3).

1 5 D

SAT_ 2 A E

CG_ 3 B RX_

EDIT_ 4 C TX_

VTR
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Configuring a Cat/Index Category Setup
Configuring Cat/Index categories requires:

1. Assigning categories

2. Assigning indexes

3. Configuring a soft panel or a hard panel for use

Assigning Categories
You can assign each destination to a specific category or multiple categories in a database. Using 
multiple categories enable you to filter the destinations, and organize them into logical groups. By 
default, categories are organized in alphabetical order.

To auto generate categories based on a database

1. Double-click the Cat/Index Categories node located under the Database node.

The Cat/Index Categories tab opens.

2. Click Generate.

The Auto-Generate dialog opens.

3. Click Yes.

The Auto-Generate dialog closes.

All previous categories are deleted from the Categories pane and new ones are listed based on 
the resource labels in your database.

4. Click Apply.

To manually create categories

1. In the Cat/Index Categories tab, click Add.

The Add Category dialog opens.

2. Use the Name field to specify a unique identifier for the new category.

 The entry must match a resource name prefix.
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Some example entries would be:

• “CG_” creates a category to categorize resources named CG_xxxx where xxxx is any index.
• “CG” creates a category to categorize resources named CGxxxx where xxxx is any index.
• “cg” will not categorize any resources as the category names are case sensitive.

3. Select the Insert trailing space box to represent a space character with the “_” symbol.

4. Click Apply.

The Add Category dialog closes.

The new category is listed in the Categories pane.

5. Click Apply.

Assigning Indexes
An index for a category enables you to filter resources. For example:

• “TX_” creates a sub-index of TX, meaning further entry is required on the control panel. This will 
filter resources named <category name>TX_xxxx where xxxx is any index.

• “TX 1” creates an ‘end-point’ index, meaning TX 1 is the last substring and no further entry is 
required on a control panel. This will filter resources named <category name>TX 1. You cannot 
create an index of “TX 1” and a sub-index of “TX_”. You must choose one or the other.

As category names and indexes are entered, the affected Resources list in the interface will update 
to indicate which sources or destinations of a given category is accessible on a control panel. Select 
a category name in the categories list to see which source or destinations are in that category and 
filtered by the available Indexes list. 

To manually create categories

1. Double-click the Cat/Index Categories node located under the Database node.

The Cat/Index Categories tab opens

2. Click Add (located next to the Categories pane).

The Add Category dialog opens.

3. Use the Name field to specify a unique identifier for the new category.

 The entry must match a resource name prefix.

For example:

• “CG_” creates a category to categorize resources named CG_xxxx where xxxx is any index.
• “CG” creates a category to categorize resources named CGxxxx where xxxx is any index.
• “cg” will not categorize any resources as the category names are case sensitive.

4. Select the Insert trailing space box to represent a space character with the “_” symbol.

5. Click Apply.

The Add Category dialog closes.

The new category is listed in the Categories pane.

6. Click Apply.

To create a category for a specific resource type

1. Double-click the Cat/Index Categories node located under the Database node.

The Cat/Index Categories tab opens.

2. Click Create for the resource type you wish to filter. 
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The Create Category/Index dialog opens.

3. Use the Category Name field to specify the characters for the new index filter. 

 The entry must match a partial resource name.

4. Select the Insert trailing space box if you wish to include trailing spaces in the filter.

5. Click Apply.

The Create Category/Index dialog closes.

6. Click Apply.

Assigning Index Filters
An index for a category enables you to filter resources. As category names and indexes are entered, 
the Affected Resources pane in the interface will update to indicate which sources or destinations 
of a given category is accessible on a control panel. Select a name in the Categories pane to see 
which source or destinations are in that category and filtered by the available Indexes pane. 

To assign an index filter

1. Double-click the Cat/Index Categories node located under the Database node.

The Cat/Index Categories tab opens.

2. Click Add (located next to the Indexes pane).

The Add Index dialog opens.

3. Use the Name field to specify a new index filter. 

 The entry must match a partial resource name.

For example:

• “TX_” creates a sub-index of TX, meaning further entry is required on the control panel. This 
will filter resources named <category name>TX_xxxx where xxxx is any index.

• “TX 1” creates an ‘end-point’ index, meaning TX 1 is the last substring and no further entry is 
required on a control panel. This will filter resources named <category name>TX 1.

• Note that you would not create an index of “TX 1” and a sub-index of “TX_”. You must choose 
one or the other.

4. Click Apply.

The Add Index dialog closes.

The new index filter is listed in the Indexes pane.

5. Click Apply.

To assign an index filter for a specific resource type

1. Double-click the Cat/Index Categories node located under the Database node.

The Cat/Index Categories tab opens.

2. Click Create for the resource type you wish to filter. 

The Create Category/Index dialog opens.

3. Use the Index Name field to specify a unique identifier for the new index filter.

 The entry must match a partial resource name.

4. Select the Insert trailing space box if you wish to include trailing spaces in the filter.

5. Click Apply.
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The Create Category/Index dialog closes.

6. Click Apply.

Legacy Categories Overview
Legacy Category mode allows some category functionality on older RCP-QE control panels (17 
button). There is no soft panel for Legacy Category Mode. Legacy mode is similar in operation to 
Group category mode with some elements of the index functionality of the Cat/Index Category 
mode.

Legacy mode limitations;

• A destination or source cannot be in more than one category
• Only numerical indexes are supported

For More Information on...
• the legacy category mode, refer to the RCP-QE User Guide.

Configuring Legacy Categories
Source and destination selection may be achieved in two ways: direct selection or numerical index 
entry. The setup of the Ultricore Category tables determines the operational functionality.

Category Direct Selection Mode
Figure 23 illustrates the Categories configured in the Ultricore database for direct selection mode.

Figure 23  Ultricore — Entries in the Categories Tab

Figure 24 illustrates direct destination entries and the resulting available destinations in the 
selected category.

Figure 24  Ultricore CC — Resulting Operation

To set up direct selection in categories

1. Display the Categories tab in DashBoard for the Ultricore as follows:

a. Expand the Database node in the Tree View.

b. Double-click the Categories node.



102 • Using Categories Ultricore CC User Guide (v15-rev2)

2. Click Destination or Source as required.

3. Type the text for a category name in column 'Category 1' for each row that is required to be in 
that category.

4. Copy the items in the name column to the Category 2 column. 

 You can use keyboard shortcuts such as Ctrl+C (copy) and Ctrl+V (paste) and Shift+click to select 
a range for ease of data entry.

This will result in those rows being within the category you named in column Category 1.

Numerical Index Entry Mode
Figure 25 illustrates the Categories configured in the Ultricore database for numerical entry mode.

Figure 25  Ultricore — Entries in the Categories Tab

Because we have set the VTRs numbered 6 through 10 in Figure 25, the Ultricore CC expects a two 
digit entry signified by the two underlines on the button next to the category name. As only 
numerals 1 or 0 are the only possible entries to make for the first digit, the Ultricore CC has blanked 
the invalid entry keys. (Figure 26)

To select VTR 6, press 0 then the remaining available numbers will become available, then press 6 to 
finish the selection. 

Figure 26  Ultricore CC — Resulting Operation

To set up numerical index selection in categories

1. Display the Categories tab in DashBoard for the Ultricore as follows:

a. Expand the Database node in the Tree View.

b. Double-click the Categories node.

2. Click Destination or Source as required.

3. Enter a category name in the Category 1 column for each row that is required to be in that 
category. For example, in Figure 25 the user entered “VTR”.

4. Enter a number in the Category 2 column.

This will result in those rows being within the category you named in the Category 1 column. 
These destinations are accessible via entering the numerical extension of the required 
destination. For example, in Figure 25 the user entered “6” for row 5.
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Creating a Soft Panel with Categories
Once you have defined your categories and tags for each level of a database, you can create a 
custom soft panel using the category settings as a basic for arranging the sources, destinations, and 
levels.

For More Information on...
• managing your Category panels, refer to “Using Category Panels”.
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Soft Panels in DashBoard
 This chapter is applicable if you are running software version 5.6 or lower. Otherwise, refer to the 

Ultrix and Ultricore Database Guide for details on creating and using soft panels.

A soft panel is a software implementation of a physical remote control panel (RCP). The soft panel 
configurations are part of a database so any instance of DashBoard connecting to a given Ultricore 
CC has the defined soft panels available. You can customize a soft panel by defining the sources, 
destinations, levels, and/or salvos that will be available on the panel interface. Ultricore CC provides 
the following types of soft panels for control; 

• Matrix — the destinations and sources are organized into a grid layout.
• MultiBus — the destinations and sources are organized into separate a rows (buses) of buttons.
• Cat/Index Category — the resources are defined using a defined set of search criteria (indexes).
• Group Category — the destinations and sources are grouped by pre-defined categories.
• Ultritouch PB — the resources are organized into a customized layout that is pre-sized for an 

Ultritouch hard panel. Refer to the Ultritouch + Ultricore CC User Guide for details.
• Push Button — similar layout and features of the Ultritouch PB panel but sized for use on a 

computer monitor.

Before You Begin
Keep the following in mind when managing your soft panels in DashBoard:

• Soft panels require the setup of the database source/destinations/levels and port assignment to 
be complete.

• If the database changes (source/destination/level/salvo addition or deletion), you will need to edit 
the soft panel configuration to ensure the correct sources/destinations/levels/salvos are visible.

• Ultricore CC does not support Unicode characters. 
• By default, Take operations are blocked by locked destinations. However, the user can configure 

the Routing Behavior mode on the router to allow unlocked destinations to switch on a Take 
operation. Refer to the Ultrix User Guide for details on mode.

For More Information on...
• databases, refer to “Database Configuration”.

Soft Panels Overview
A soft panel is created using the options in the Panels interface for your database. Soft panels are 
listed as sub-nodes under the Soft Panels node in the Tree View of DashBoard. Double-click a 
sub-node to display the corresponding soft panel in the DashBoard window. The hierarchy of the 
nodes in the tree is determined by their Panel ID which is assigned when the soft panel is created in 
the database. In Figure 27 there are seven soft panels in the tree view.
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Figure 27  Example of a Soft Panels Tree View

A soft panel can be as simple or complex in its layout as you require. The Panels interface enables 
you to specify the number of destinations, sources, levels, and salvos displayed on your panel. You 
select a soft panel type and specify the elements of the soft panel including giving the panel a 
unique name. 

For More Information on...
• Matrix panels, refer to “Using Matrix Panels”.
• Multibus panels, refer to “Using MultiBus Panels”.
• Category panels, refer to “Using Category Panels”.
• Ultritouch PB panels, refer to the Ultritouch + Ultrix User Guide.
• Push Button panels, refer to “Using Push Button Panels”.

Enabling Machine Control
Typically, the ports on a data router (such as the NK-M series routers) are bi-directional where there 
is both a transmit (input to output) and reciprocal receive connection that is made for each port. For 
example, a switch from port 1 to port 2 involves a forward path (from port 1 input to port 2 output) 
and the reciprocal connection from (port 2 input to port 1 output).

In some cases however, there is a need to connect on the port's input to several ports’ output (e.g. 
one device commanding many target devices) without making the reciprocal connection. This 
allows the commanding device to just broadcast commands and not receive from the many devices 
it communicates with. 

When configuring a soft panel, you have the option to add a Machine Control button to the panel. 
When selected on the panel, this Machine Control button sends a Take request directed to an NK-M 
series data router to automatically make the reciprocal port switch. On a video router, the 
connection is all one way from an input port to an output port (e.g. such as from IN 1 to OUT 2). 

Specifying the Routing Behavior for Locked Destinations
By default, Take operations are blocked by locked destinations. However, the user can configure the 
Routing Behavior mode on the router to allow unlocked destinations to switch on a Take operation.

To specify the routing behavior

1. Locate the Ultricore CC in the Tree View of DashBoard.

2. Expand the Ultricore CC node to display a list of sub-nodes in the Tree View.

3. Double-click the System Status node.

4. Select the Setup tab.
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5. Locate the Routing Behavior area.

 You may need to scroll down the Setup tab to locate this area.

6. Use the Salvo/Multi- Crosspoint Take Completion options to specify the routing behavior for 
locked or protected destinations. Choose from the following:

• Require All Crosspoints — The Take operation will fail entirely if any destinations are locked 
or protected.

• Best Effort — The Take operation will be performed for any valid routes and fail for locked or 
protected routes.

Creating a Soft Panel
Soft panels are listed under the Soft Panels node in a hierarchy as determined by their Panel ID. 
When you create a new soft panel, you select from the three existing soft panel types: Matrix, 
MultiBus, and Categories. You then assign a Panel Name and ID to display in the tree view using the 
nomenclature “Panel Name [#]” where [#] is the Panel ID.

 A Default Panel is available that is a MultiBus style with 1 level, 4 destinations, and 4 sources.

To create a soft panel

1. Double-click the Panels node located under the Database node.

The Panels tab opens.

2. Click Edit > Add.

The Add Panel dialog opens.

3. Type a unique identifier in the Name field. This will be used to identify the panel in the tree 
under the Soft Panels node.

4. Use the Style menu to specify the type of panel to create. Choose from the following:

• Matrix — Creates a soft panel that organizes the destinations and sources in a grid layout.
• MultiBus — Creates a soft panel where destinations and sources are organized into separate 

buses.
• Category — Creates a soft panel where destinations and sources are arranged as 

determined by the Category tab. Refer to “Using Categories” for more information.
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• Push Button — Creates a soft panel that organizes the destinations and sources in a distinct 
vertical layout.

• Ultritouch PB — Creates a soft panel that is used on an Ultritouch hard panel. Refer to the 
Ultritouch + Ultricore CC User Guide for details.

5. Click Apply to save your settings and close the Add Panel dialog.

The new panel name is added to the Save Panels list of the Panels tab and automatically 
selected in the tab for editing.

6. Select the Info tab.

7. Use the Panel ID menu to determine the position of the panel in the Soft Panels tree where a 
value of “1” is the highest priority (and listed at the top).

 Ensure that the new soft panel does not use the same Panel ID as a previously saved panel.

8. Use the Description field to provide a textual summary of the panel. 

9. Use the Protection Operation menu to provides options for preventing crosspoint switches. 
Choose from the following:

• Enable — The Lock, Protect, and Free buttons display on the soft panel. Refer to “Using 
Matrix Panels” or “Using MultiBus Panels” for a description of these buttons. 

• Disable — The Lock, Protect, and Free buttons do not display on the soft panel. These 
protection options are not available for the soft panel.

10. Use the Take Operation menu to configure the Take button for the soft panel. Choose from 
the following:

• Confirm — Displays a Take button on the soft panel. You must select the Take button to 
perform a crosspoint switch.

• Direct — The soft panel does not display a Take button. A crosspoint switch occurs 
automatically after each destination/source selection made by the user on the soft panel.

11. If you selected MultiBus in step 4, use the Selection Operation menu to enable multiple 
crosspoint/level selections and display the Multi Select button. Choose from the following:

• Single — Disables this feature. The Multi Select button does not display on the soft panel.
• Multi — The Multi Select button displays on the soft panel.

12. Use the Machine Control menu to control whether a Take request directed to an Ross NK-M 
series data router automatically makes a reciprocal port switch. Choose from the following:

• Enable — Displays a Machine Control button on the soft panel. You must select the 
Machine Control button to enable the reciprocal port switch on the NK-M series router.

• Disable — The soft panel does not display a Machine Control button. This is the default 
setting.

13. If you set the Style to Push Button, proceed to “Configuring a Push Button Soft Panel”.

14. Click Apply to save your new soft panel.

The new panel displays in the Soft Panels tree. In the example below, there are seven panels in 
the tree view. Note that the Priority ID is the value displayed in the [#] brackets.

15. Continue to the next sections to add levels, destinations, sources, and salvos to your soft panel 
as required.

Levels for the Soft Panel
You can specify the total number of levels available on the soft panel to the user. For example, if 
you set the Viewable levels to 6 but have assigned 8 levels to the panel, only the first six levels in the 
Assigned list are displayed.
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To specify the levels for the soft panel

1. Double-click the soft panel name from the Panels list in the left toolbar of the Panels tab.

2. Select the Levels tab.

3. Use the Viewable levels field to specify the total number of levels for the soft panel.

4. To add a level to the soft panel:

a. From the Available list, select the level(s) you wish to add to the soft panel.

b. Click .

The Assigned list updates to include the selected level(s).

5. To assign all the available levels in the database to the soft panel, click .

6. To assign multiple levels to the soft panel:

a. From the Available list, select the first level you wish to add to the soft panel.

b. Press Shift.

c. From the Available list, select the other level(s) you wish to add to the soft panel.

d. Click .

The Assigned list updates to include the selected levels.

7. Use the provided buttons beside the Assigned list to determine the order in which the levels 
are displayed on the soft panel.

8. Click Apply at the bottom of the Panels tab to save your settings.

Destinations for the Soft Panel
You can create a soft panel with a specified number of destinations and determine the order in 
which they are displayed in the crosspoint row of the panel. For example, the database may have 32 
destinations but you only want to make the first 4 outputs selectable on the crosspoint row of your 
soft panel. You would then set the Viewable destinations to 4. You can also specify the order in 
which the destination buttons are displayed on the soft panel.

To specify the destinations for the soft panel

1. Double-click the soft panel name from the Panels list in the left toolbar of the Panels tab.

2. Select the Destinations tab.

3. Use the Viewable destinations field to specify the total number of destinations for the soft 
panel.

4. To add a destination to the soft panel:

a. From the Available list, select the destination(s) you wish to add to the soft panel.

b. Click .

The Assigned list updates to include the selected destination(s).

5. To assign all the available destinations in the database to the soft panel, click .

6. To assign multiple destinations to the soft panel:

a. From the Available list, select the first destination you wish to add to the soft panel.

b. Press Shift.

c. From the Available list, select the other destination(s) you wish to add to the soft panel.
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d. Click .

The Assigned list updates to include the selected destinations.

7. Use the provided buttons beside the Assigned list to determine the order in which the 
destinations are displayed on the soft panel.

8. Click Apply at the bottom of the Panels tab to save your settings.

Sources for the Soft Panel
You can create a soft panel with a specified number of sources and determine the order in which 
they are displayed in the crosspoint row of the panel. For example, the router may have 64 sources 
but you only want to make the first 12 inputs selectable on the crosspoint row of your soft panel. 
You could set the Viewable sources to 12 or assign only those 12 inputs to the soft panel. You can 
also specify the order in which the source buttons are displayed on the soft panel.

To specify the sources for the soft panel

1. Double-click the soft panel name from the Panels list in the left toolbar of the Panels tab.

2. Select the Sources tab.

3. Use the Viewable sources field to specify the total number of sources for the soft panel.

4. To add a source to the soft panel:

a. From the Available list, select the source(s) you wish to add to the soft panel.

b. Click .

The Assigned list updates to include the selected source(s).

5. To assign all the available sources in the database to the soft panel, click .

6. To assign multiple sources to the soft panel:

a. From the Available list, select the first source you wish to add to the soft panel.

b. Press Shift.

c. From the Available list, select the other source(s) you wish to add to the soft panel.

d. Click .

The Assigned list updates to include the selected sources.

7. Use the provided buttons beside the Assigned list to determine the order in which the sources 
are displayed on the soft panel.

8. Click Apply at the bottom of the Panels tab to save your settings.

Salvos for the Soft Panel
Before you can add salvos to a soft panel, you must configure them as outlined in “Creating 
Salvos”.

To specify the salvos available on the soft panel

1. Double-click the soft panel name from the Panels list in the left toolbar of the Panels tab.

2. Select the Salvos tab.

3. Use the Viewable salvos field to specify the total number of salvos for the soft panel.

4. To add a salvo to the soft panel:
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a. From the Available list, select the salvo you wish to add to the soft panel.

b. Click .

The Assigned list updates to include the selected source(s).

5. To assign all the available salvos in the database to the soft panel, click .

6. To assign multiple salvos to the soft panel:

a. From the Available list, select the first salvo you wish to add to the soft panel.

b. Press Shift.

c. From the Available list, select the other salvo(s) you wish to add to the soft panel.

d. Click .

The Assigned list updates to include the selected salvos.

7. Use the provided buttons beside the Assigned list to determine the order in which the salvos 
are displayed on the soft panel.

8. Click Apply at the bottom of the Panels tab to save your settings.

Copying a Soft Panel
 Ensure the soft panel is currently not in use.

To copy a soft panel

1. Double-click the Panels node located under the Database node.

The Panels tab opens.

2. From the Panels list in the left toolbar, select the soft panel to copy.

3. Click Edit > Copy.

4. Click Edit > Paste.

The Panels tab updates to display the settings for the selected soft panel. New soft panels are 
automatically named “New Panel #” where # is an auto-generated value.

5. Select the Info tab.

6. Type a unique identifier in the Panel Name field. This will be used to identify the panel in the 
tree under the Soft Panels node.

7. Click Apply at the bottom of the Panels tab to save the new soft panel. This also helps to ensure 
that you do not mistakenly edit the original panel that you copied.

Editing a Soft Panel
Once you edit a soft panel, you must re-load the soft panel if it was in use prior to the edit.

 Ensure the soft panel is currently not in use.

To edit a soft panel

1. Double-click the Panels node located under the Database node.

The Panels tab opens.

2. From the Panels list in the left toolbar, select the soft panel to edit.

The Panels tab updates to display the settings for the selected soft panel. 

3. Edit the settings for the panel using one of the following procedures:
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 You cannot edit the Panel Style of a soft panel.

• “To specify the levels for the soft panel”
• “To specify the destinations for the soft panel”
• “To specify the sources for the soft panel”
• “To specify the salvos available on the soft panel”

4. Click Apply at the bottom of the Panels tab to save the new settings.

5. If a dialog opens to remind you that the affected soft panel is currently in use:

a.  Click OK to close the dialog.

b.  Perform the procedure “To re-load a soft panel”.

To re-load a soft panel

1. Close the newly edited soft panel as follows:

a. Locate the tab for the soft panel in the DashBoard client window.

b. Click  to close the tab.

2. In the Basic Tree View, expand the Soft Panels node for the Ultricore CC.

3. Double-click the node for the newly edited soft panel.

The tab for the selected soft panel opens.

Deleting a Soft Panel from the Database
 Ensure the soft panel is currently not in use.

To delete a soft panel from the database

1. Double-click the Panels node located under the Database node.

The Panels tab opens.

2. Select the soft panel name from the Panels list in the left toolbar.

3. Click Edit > Delete.

4. Click Apply at the bottom of the Panels tab.

Using the Lock and Protect Features
Whether your soft panel includes the Lock and Protect features depends on the panel type. The 
Matrix and Category panels can include the Lock, Protect, and Free buttons. The MultiBus panels 
can include only the Lock button. Soft panels that have their Protection Operation set to Enable 
also display these buttons (depending on the panel type).

For More Information on...
• the Protection Operation, refer to Table 60.

Using a Lock
If your soft panel includes a Lock button, you have the option to protect source/level and 
destination/level pairs. When another control panel or DashBoard client attempts to switch that 
combination, the request will be denied.
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To lock a source/level pair

1. Display the soft panel in the DashBoard window.

2. Select the source/level pairs from the soft panel interface.

3. Click Lock.

The label on the button changes to Unlock and the button remains lit.

To lock a destination/level pair

1. Display the soft panel in the DashBoard window.

2. Select the destination/level pairs from the soft panel interface.

3. Click Lock.

The label on the button changes to Unlock and the button remains lit.

To clear a lock

• Click the Unlock button.
The label on the button changes to Lock and the button remains lit.

Using a Protect
A soft panel can be locked by clicking the Protect button. The button is lit until pressed again. A 
protect alarm message is displayed in the System Status tab when an output is protected.

This feature protects the currently selected destination/level pair from use by other sources, as well 
as from other linked panels. The Protect button is especially useful in instances where a 
destination must be held after a switch has been made.

To apply a protect

• Click Protect.
The button is lit. Selecting crosspoints will not take effect and the panel does not update when 
buttons are pressed.

To clear a protect

• Click Protect.
The button is no longer lit and crosspoint switches can be initiated.

Using Matrix Panels
Matrix panels enable you to perform direct take transitions, and local salvo definitions using a grid 
of sources and destinations.

Panel Interface Overview
Each level is represented as a button in the color defined in the current database. Notice that the 
crosspoints are represented in the same color as the applicable level.
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Figure 28  Example of a Matrix Panel 

1. Crosspoints

The number of Destinations and Sources available in the matrix is specified using the 
Destinations and Sources interfaces.Click within the matrix or click the Destination and Source 
buttons to select the crosspoints for switching the selected levels. In Figure 28 crosspoints were 
selected using the Advanced > Diagonal Presets option. 

2. Levels Button

Click a level button to include the level in the next crosspoint switch. A lit button indicates that the 
corresponding level will be included in the next transition. The color and name of the button are 
specified using the Levels interface. Figure 28 illustrates a Matrix panel with nine levels selected.

3. Follow Button

Click this button to select all crosspoints in the matrix. Clicking TAKE after clicking Follow will 
then switch all crosspoints at the same time on all available levels. 

4. TAKE Button

Click this button to execute the switch between crosspoints. If you are using a soft panel with the 
Take Operation set to Direct, a TAKE button is not displayed because the transitions will occur 
automatically after a crosspoint switch is selected.

5. Lock Button

Click this button to prevent switching of the selected crosspoints. If you are using a soft panel 
with the Protection Operation set to Disable, the Lock and Protect buttons are not displayed.

6. Protect Button

Click this button to prevent switching of the selected crosspoints except in the DashBoard client 
session the Protect was initiated in.

7. Free Button

Click this button to end a lock or protect on the selected crosspoints.

8. Salvo Button

Click this button to display the Salvo menu. Refer to “Salvo Menus” for information on the menu 
options.
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9. Advanced Button

Click this button to display the Advanced menu. Refer to “Advanced Menus” for information on 
the menu options.

10.Machine Control Button (not shown)

If you are using a soft panel with the Machine Control set to Enabled, the MACHINE CONTROL 
button is displayed. Refer to “Enabling Machine Control” for details on this button.

Crosspoint Switches via a Matrix Panel
Crosspoint selections can be made using the cross-hairs or clicking the required Destination and 
Source buttons on the panel. This section provides instructions using the cross-hairs for crosspoint 
selections.

To make a crosspoint switch using a single level

1. In the Basic Tree View, expand the Soft Panels node for the Ultricore CC.

2. Double-click the node for a matrix soft panel.

The Matrix Panel tab opens.

3. Select a level from the left toolbar.

The button is now lit.

4. Select the source and destination intersection inside the matrix.

The selection is represented as an icon set in the color that matches the level. In the example 
below, Level 2, Src 4 and Dest 2 are selected. The TAKE button is now lit.

5. Click Take.

The icon on the matrix is solid in the color that matches the level and the TAKE button is no 
longer lit.

To make a crosspoint switch between multiple sources and destinations on a single level

1. In the Basic Tree View, expand the Soft Panels node for the Ultricore CC.

2. Double-click the node for a matrix soft panel.

The Matrix Panel tab opens.

3. Select a level from the left toolbar.
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4. Select the first source and destinations inside the matrix.

5. Select the additional crosspoints to switch.

In the example below, Level 2 is selected but seven crosspoint switches are also selected (each 
is represented with a green icon on the matrix).

6. Click TAKE.

The icons on the matrix is solid in the color that matches the level and the TAKE button is no 
longer lit.

To make a crosspoint switch on multiple levels

1. In the Basic Tree View, expand the Soft Panels node for the Ultricore CC.

2. Double-click the node for a matrix soft panel.

The Matrix Panel tab opens.

3. Select each level from the toolbar or select Follow to include all levels.

4. Select the first source and destination inside the matrix.

5. Select the additional crosspoints to switch.

When multiple levels are selected, the circle on the crosspoint is divided into colored sections 
with each section representing a level. In th example below, Levels 2, 4, and 6 are selected with 
multiple crosspoint selections on the matrix.
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6. Click Take.

The icons on the matrix are solid in the color that matches the level and the TAKE button is no 
longer lit.

To perform a crosspoint switch on multiple destinations with a single source

1. In the Basic Tree View, expand the Soft Panels node for the Ultricore CC.

2. Double-click the node for a matrix soft panel.

The Matrix Panel tab opens.

3. Select each level from the toolbar or select Follow to include all levels.

4. Click Select All located at the top left corner of the interface.

All the Dest buttons on the Matrix panel are now lit and selected. The Select All button is 
labeled Clear All.

5. From the top toolbar, select the Src button to switch.

The matrix updates to indicate the crosspoint switches that will occur on the next transition to 
the same source. The TAKE button is now lit. For example, Levels 2, 4 and 6 are selected and all 
destinations switch to Src 4.
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6. Click TAKE.

The icons on the matrix are solid in the color that matches the level and the TAKE button is no 
longer lit.

Using a Default Preset
The Advanced menu provides two pre-configured presets: Diagonal and R-Diagonal.

Diagonal Presets

Crosspoint selection is organized into a diagonal line that starts with the top left corner of the 
matrix (e.g. Src 1 and Dest 1), continues in single step intervals (e.g. Src 2 and Dest 2, Src 3 and 
Dest 3 etc.) and ends with the bottom right corner of the matrix (e.g. Src1 6 and Dest 16). 

To use the Diagonal Preset

1. Select each level from the toolbar or select Follow to include all levels.

2. Click Advanced > Diagonal Presets.

3. Click TAKE.

R-Diagonal Presets

Crosspoint selection is organized into a diagonal line that starts with the top right corner of the 
matrix (e.g. Src 16 and Dest 1), continues in single step intervals (e.g. Src 15 and Dest 2, Src 14 and 
Dest 3 etc.) and ends with the bottom left corner of the matrix (e.g. Src 1 and Dest 16). 

To use the R-Diagonal Preset

1. Select each level from the toolbar or select Follow to include all levels.

2. Click Advanced > R-Diagonal Presets.
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3. Click TAKE.

Creating an Automatic Switching Loop
The Automation feature enables you to set up a crosspoint and create a continuous switch loop 
using the specified crosspoints.

To set up an automated crosspoint selection loop

1. Click Advanced > Setup Automation.

The Automation Setup menu opens.

2. Use the Repeat Interval field to specify the number seconds the crosspoint switch will 
continuously loop for.

3. Use the Levels menu to specify the levels the crosspoint will include.

4. Use the Destinations menu to select the outputs on the router.

5. Use the Sources menu to select the input signals to route to the output for the switch.

6. Click Start.

The menu closes and the crosspoint switch begins. The loop continues for the length of time 
specified in step 2.

 To stop the loop, click Advanced > Stop Automation.
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Clearing the Matrix Selections
You can choose to clear all the crosspoint selections, or only the selected Destinations.

To clear all crosspoint selections on the matrix

• Click Advanced > Clear All Presets.

To clear only the Destination selections on the matrix

• Click Advanced > Clear Dest Presets, or
• Click Clear All.

Using MultiBus Panels
The MultiBus panel provides breakaway control and status monitoring of several destinations 
simultaneously.

Panel Interface Overview
Use the MultiBus Panel to send a source to multiple destinations.

Figure 29  Example of a MultiBus Panel

1. Destination Bus

Each button in this crosspoint row represents a configured output for the selected router. 
Selecting a button includes the destination in the next crosspoint switch. The number of 
destinations and label for each button is defined by its entry in the Destinations interface. A 
destination selected to be included in the next crosspoint switch will have a lit button. For 
example, Dest 2 is selected in Figure 29.

2. Lock Button

Click this button to prevent switching of the selected crosspoints. If you are using a soft panel 
with the Protection Operation set to Disable, the Lock button is not displayed.

3. Take Button

Click this button to execute the switch between the selected crosspoints. If you are using a soft 
panel with the Take Operation set to Direct, a TAKE button is not displayed because the 
transitions will occur automatically after a crosspoint switch is selected.
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4. Preset Button

When this button is lit, a new crosspoint switch is set up on the soft panel. At least one source, 
once destination, and one level are selected on the interface (the Dest and Src buttons are lit 
blue to indicate their inclusion in the next switch). 

When this button is not lit, the crosspoint switch setup is still valid but is no longer indicated on 
the soft panel.

If you are using a soft panel with the Take Operation set to Confirm, the crosspoint switch will 
take effect the next time the TAKE button is selected. If you are using a soft panel with the Take 
Operation set to Direct, a TAKE button is not displayed because the transitions occurred 
automatically (hot-punch operation).

5. Clear Button

Clicking this button clears the selections made for the next crosspoint switch in the soft panel 
interface.

6. Multi Select Button

Clicking this button enables you to perform a switch on multiple crosspoint combinations. If you 
are using a soft panel with the Selection Operation set to Single, a Multi Select button is not 
displayed.

7. Level Button(s)

Click a level button to include the level in a crosspoint that you are configuring in the matrix. A lit 
button indicates that the corresponding level will be included in the next transition. The color and 
name of the button are specified using the Levels interface. Figure 29 illustrates a MultiBus 
panel with three levels selected.

8. Follow Button

Click this button to select all levels in the matrix. If you are using a soft panel with the Take 
Operation set to Confirm, pressing Take after pressing Follow will then switch all crosspoints at 
the same time on all available levels.

9. Source Bus

Each button in this crosspoint row represents a configured input for the selected router. 
Selecting a button includes the source in the next crosspoint switch. The label for the button is 
defined by its entry in the Sources tab of the Database. A source selected to be included in the 
next crosspoint switch will have a lit button. For example, in Figure 29 the Src 1 is selected for the 
next transition while the Src 4 is the current source in use. 

10.Machine Control Button (not shown)

If you are using a soft panel with the Machine Control set to Enabled, the MACHINE CONTROL 
button is displayed. Refer to “Enabling Machine Control” for details on this button.

Crosspoint Switches via a MultiBus Panel
The layout of a MultiBus panel is similar to a production switcher layout where the destinations are 
organized into a horizontal row of buttons near the top of the panel and the sources are on the row 
near the bottom. 

To make a crosspoint switch on a single level using a MultiBus Panel

1. In the Basic Tree View, expand the Soft Panels node for the Ultricore CC.

2. Double-click the node for a MultiBus Panel.

The MultiBus Panel tab opens.

3. From the left toolbar, select the button for the level you want to perform the crosspoint switch.
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4. Select a Src button from the Source bus located at the bottom of the interface.

The button is now lit.

5. Select the Dest button(s) from the Destination bus located at the top of the interface.

6. Select a Dest button from the Destination bus located at the top of the interface.

The Dest, Preset, and Take buttons are now lit.

In the example below, Level 2 is selected and Dest 4 will switch with Src 6. The Src 1 button is lit 
green to indicate that Source 1 was used in the last crosspoint switch.

7. Click Take.

To make a crosspoint switch using multiple levels

1. In the Basic Tree View, expand the Soft Panels node for the Ultricore CC.

2. Double-click the node for a MultiBus Panel.

The MultiBus Panel tab opens.

3. Select each level from the toolbar or select Follow to include all levels.

When multiple levels are selected, the center row of the panel reports the level status using a 
horizontal bar to represent the level.

4. Select a Src button from the Source bus located at the bottom of the interface.

The button is now lit.

5. Select the Dest buttons for the outputs to include in the crosspoint switch.

The Dest, Preset, and Take buttons are now lit. In the example below, Follow is selected and 
Dest 5 will switch with Src 4 on all levels.



Ultricore CC User Guide (v15-rev2) Soft Panels in DashBoard • 123

6. Click TAKE.

Using the Multi Select Function
A MultiBus panel displays a Multi Select button on the vertical toolbar of the panel.

To use the Multi Select 

1. In the Basic Tree View, expand the Soft Panels node for the Ultricore CC.

2. Double-click the node for a MultiBus Panel.

The MultiBus Panel tab opens.

3. Select the level(s) from the left toolbar.

4. Click Multi Select.

The Multi Select button is now lit.

5. Select the Dest buttons from the Destination bus located near the top of the interface.

The Dest buttons are now lit.

6. Select a Src button from the Source bus located near the bottom of the interface.

The Src, Preset, and TAKE buttons are now lit. In the example below, Levels 2 and 3 are 
selected, and Dest 2, 3, and 5 will switch with Src 6.

7. Click TAKE.
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Using Category Panels
Category panels organize sources, destinations and levels based on the settings in the Category tab. 
There are two types of category panels: group and classic. This section outlines both types.

For More Information on...
• legacy categories, refer to the RCP-QE User Guide.

Panel Interface Overview
The soft panel interface for each category type is similar in layout and available buttons. 

Figure 30  Example of a Group Category Soft Panel for an Ultricore CC Router

1. Group Window

This area of the soft panel interface may include the following buttons:

› SOURCES, DESTINATIONS Buttons — Clicking one of these buttons updates the button matrix 
to display the sources or destinations available as per the selected category. The button labels 
update to display the source or destination labels.

› BACK Button — Click this button to return the navigation to the previous category selection 
(back one level).

› RESET Button — Click this button to clear all selections on the interface. This button is only 
available on the Classic Category soft panels.

› SELECT Button — This button is only available on the Classic Category soft panels.
› TOP Button — This button is only available on the Group Category soft panels.

When using a Group Category soft panel and the Info > Non-group Resources setting is set to 
Hide, only the resources assigned to a group are displayed on the soft panel.

2. Status Window

The bottom right corner of each soft panel includes a status window. For each level in the list of 
available levels, a corresponding status indicator display will indicate the current source for the 
currently selected destination.

The following buttons are located on the right-side of the soft panel interface:

› Individual Level Buttons — Click a level button to include the level in a crosspoint that you are 
configuring in the matrix. A lit button indicates that the corresponding level will be included in 
the next transition. The color and name of the button are specified using the Levels interface.
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› CURRENT button — This button updates the level display area to show the current status for 
all displayed levels.

› FOLLOW Button — Click this button to select all levels in the matrix. Clicking TAKE after clicking 
Follow will then switch all crosspoints at the same time on all available levels.

› PENDING button — This button updates the level display area to show status for the currently 
pending operation (if selected source has not been switched yet. e.g. before TAKE is pressed). 
The user may clear individual source selections by selecting the levels to be cleared, then 
pressing CLEAR SRC SEL button.

› CLEAR Button — Click this button to clear all selections on the interface.
› USER button — This button shows current lock/protect status of each levels (and the soft panel 

name that is currently owned it). Since the soft panel does not recognize the names of remote 
control panels (RCP) to retrieve their name, a “owner #” name is used. 

3. TAKE Control Area

The bottom toolbar of the soft panel interface includes the following buttons:

› PROTECT Button — Click this button to prevent switching of the selected destination except by 
the panel that initiated the protect. If you are using a soft panel with the Protection Operation 
set to Disable, the Protect button is not displayed.

› LOCK Button — Click this button to prevent switching of the selected destination by an control 
device. If you are using a soft panel with the Protection Operation set to Disable, the Lock 
button is not displayed.

› VIEW Button — Click this button to display the VIEW dialog. This dialog lists the current TAKE 
commands in the queue. Individual items may be removed from the queue via the options in 
the VIEW dialog.

› CLEAR Button — Click this button to clear the current TAKE queue.
› PRESET Button — This button is used to queue up multiple TAKE commands. Select a 

destination/source combination, then click PRESET. Select another destination/source 
combination then click PRESET. A following TAKE command will execute all the PRESET 
switches. To view the switch commands queued by the PRESET, click VIEW.

› TAKE Button — Click this button to execute the switch between the selected crosspoints. If you 
are using a soft panel with the Take Operation set to Direct, a TAKE button is not displayed 
because the transitions will occur automatically after a crosspoint switch is selected.

Figure 31  Status Protected — Destination Figure 32  Status Protected — User
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Crosspoint Switches via a Category Panel
The buttons and options in a Category soft panel are dependent on the categories defined for the 
current database, and how the soft panel was defined in the Panels tab. Instead of having access to 
all sources, destinations, and levels at one time, a Category soft panel provides access based on the 
categories and the tags you have created.

To make a crosspoint switch using a Group Category Panel

1. In the Basic Tree View, expand the Soft Panels node for the Ultricore CC.

2. Double-click the node for the Category Panel.

The Category Panel tab opens.

3. From the status window, highlight the level(s) you wish to include in the crosspoint switch.

• Selected levels highlight in the level defined color.
• Non-selected levels are indicated by a gray button with white text.

4. To select a destination:

a. Click DEST from the category navigation tools.

b.  Navigate to the desired group using the displayed groups in the main group window. 

Only groups containing destination assignments will be displayed unless the Non-group 
Resources option for this soft panel is set to Show.

c. Select a DEST button from the available category destinations located in the main group 
window.

The status title bar (if enabled) reports the currently selected destination. In the example 
below, the user has selected Level A1 and destination EDIT 3 from the EDIT group.

5. To select a source:

a. Click SRC from the category navigation tools.

b. Select a SRC button from the Source bus located in the middle of the interface.

 If your Category soft panel was created with the Take Operation set to Confirm, the TAKE button 
is lit. Otherwise the crosspoint switch automatically occurs.
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6. Click TAKE.

Using Push Button Panels
 This soft panel type is not suitable for use on an Ultritouch hard panel. To control the Ultricore CC 

via an Ultritouch, you must create and load an Ultritouch PB soft panel as outlined in the 
Ultritouch + Ultricore CC User Guide.

Panel Interface Overview
The Push Button soft panel is organized into three distinct windows. The order and width of each 
window can be customized using the options in the Panels > Home View interface.

Figure 33 is an example of a Push Button soft panel set to portrait.

Figure 33  Example of the Default Push Button Soft Panel — Portrait

Figure 34 is an example of a Push Button soft panel set to landscape.
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Figure 34  Example of the Default Push Button Soft Panel — Landscape

1. Destinations Area

The Destinations area displays the available destinations for router control. Select a 
Destination button to arm that destination for subsequent panel operations. Beneath each 
destination button is displayed the current source for that destination.

This area also includes the Filter field. A filter is available to match destination names against the 
entered text:   

• Enter text in the Filter field.

• Click  (or press Enter). The destinations area updates to display only those destinations 
starting with the filter text.

• To clear the active filter, click .

2. Sources Area

The Sources area displays the available sources for router control. Select a Source button to 
control the crosspoint for the currently selected destination.

This area also includes a Filter field. A filter is available to match source names against the 
entered text:

• Enter text in the field provided

• Click  (or press Enter). The sources area updates to display only those sources starting 
with the filter text.

• To clear the active filter, click .

3. Current Destination

The currently selected destination label is displayed here. All subsequent panel operations 
operate on this destination until a new destination is selected.

›  — the current status is not the same for all levels (ie a breakaway switch has occurred).

›  — the current destination is locked. No switches can be made on this destination.
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›  — the current destination is protected. Only the panel that initiated the protect may 
switch this destination.

4. Levels Area

The Levels area displays the available router levels as individual buttons. The current source for a 
given router level is displayed each level button. Select a Level button to include this level in the 
next source selection operation. Select the button again to toggle the level selection setting.

› FOLLOW Button — toggles the selection for all displayed levels.
› CLEAR Button — toggles the currently active level buttons.

5. Operation Area

This area provides buttons for soft panel and router control.

› PROTECT Button — protect the current destination. The following occurs:
• The destination button displays a blue border.

• The Current Destination area displays . When a destination is protected, only the 
panel that initiated the protect can change the destination status.

• The PROTECT button is now labeled as UNPROTECT. Toggle the button to disable the 
protect.

Only the panel that initiated the protect may change the protect status.

› LOCK Button — locks the current destination. The following occurs:
• The destination button displays a red border.

• The current destination display area displays . When a destination is locked, no panel 
may change the destination status.

• The LOCK button is now labeled as UNLOCK.

Only the panel that initiated the lock may change the lock status.

› VIEW Button — displays the current crosspoint switch requests currently in the preset list. 
Individual crosspoints may be removed via the list view.

› CLEAR Button — clear the preset list of all crosspoint selections.
› PRESET Button — adds the current destination/source/level selection to a preset list. A 

crosspoint is added to the list for every level selected. This enables the user to add more 
switches and execute them all with a single take operation. The preset function is only available 
when the Take Mode is set to Confirm.

› SALVO Button — reveals a list of predefined salvos. A salvo may be executed from the dialog. 
The salvo button is visible only when the panel configuration has one or more salvos assigned.

› TAKE Button — is lit when the current destination/source selection is ready to be requested of 
the router. The Take operation is a configurable option and will only be activated if the soft 
panel Take Mode is set to Confirm.

Configuring a Push Button Soft Panel
The Push Button soft panel provides additional configuration options in addition to those outlined 
in “Creating a Soft Panel”.

To configure a Push Button soft panel

1. Create a new soft panel as outlined in “To create a soft panel”.

2. Select the Home View tab.
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3. Use the Display Icons menu to specify whether buttons will display the default icons based on 
window type (Enable) or will only display the label text as determined by the database 
(Disable).

4. Use the Orientation menu to specify the layout on the monitor. Choose from the following:

• Portrait — orients the soft panel in a horizontal layout, where the soft panel is taller than it is 
wide.

• Landscape — orients the soft panel in a vertical layout, where the soft panel is wider than it 
is tall.

5. Specify the order that the windows will display in the completed soft panel layout as follows:

 By default, the windows are organized in the following order (left to right): Destinations, Sources, 
and Status.

a. In the Home Windows table, select the row for the window you want to move to a different 
position on the soft panel layout.

b. Use the buttons in the toolbar to move the row to the desired position.

In the example below, the user moved the Status window to the top of the table so it will 
display on the far left of the soft panel.

6. Adjust a window size as follows:

• Use the Percent field to specify the size of the window as a percentage of the total soft panel 
area.

• Use the Rows field to specify the number of button rows the window will display.
• Use the Columns field to specify the number of button columns the window will display
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7. Click Apply to save your changes.

Crosspoint Switches via a Push Button Panel
The buttons and options in a Push Button soft panel are dependent on the current database, and 
how the soft panel was defined in the Panels tab. You can also use the Filter fields in the 
Destinations and Sources area of the panel to provides access based on the search criteria entered 
into each Filter field.

To make a crosspoint switch on a single level using the Push Button Panel

1. In the Basic Tree View, expand the Soft Panels node for the Ultricore CC.

2. Double-click the node for the Push Button Panel.

The Push Button Panel tab opens.

3. Select the Level you want to perform the crosspoint switch.

4. Select a DEST button from the Destinations window.

The Status field reports the selected DEST button. In the example below, the user selected 
Level 6 and Dest 54.

5. Select a SRC button from the Sources window.

 If your soft panel was created with the Take Operation set to Confirm, the TAKE button is lit. 
Otherwise the crosspoint switch automatically occurs.
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6. Click TAKE.

To make a crosspoint switch on multiple levels using the Push Button Panel

1. In the Basic Tree View, expand the Soft Panels node for the Ultricore CC.

2. Double-click the node for a Push Button Panel.

The Push Button Panel tab opens.

3. Select each level from the Levels window or click Follow to include all levels.

The Level buttons are lit in the toolbar.

4. Select a DEST button from the Destination window.

The Status area updates to display report the selected DEST button. In the example below, the 
user selected Levels 2, 6, 8 and 11, then Dest 40.

5. Select a SRC button from the Source window.
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The Status area updates to display only the selected SRC button. In the example below, Src 6 is 
selected.

 If your soft panel was created with the Take Operation set to Confirm, the TAKE button is lit. 
Otherwise the crosspoint switch automatically occurs.

6. Click TAKE.

Using an Ultritouch PB Panel
An Ultritouch PB soft panel is organized into a pre-sized layout that can be loaded for use on an 
Ultritouch hard panel. Customize each soft panel by specifying the size of each window, the location 
of each window on the layout, and what operational buttons to include on the panel.

 The Ultritouch PB soft panel can only be loaded and used on an Ultritouch hard panel. 

Figure 35  Example of an Ultritouch PB Soft Panel

For More Information on...
• configuring and using an Ultritouch PB soft panel, refer to the Ultritouch + Ultrix User Guide.
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Using Salvos
Salvos are a selected series of crosspoints to switch in the matrix that can be saved and later 
recalled for use.

 This chapter is applicable if you are running software version 5.6 or lower. Otherwise, refer to the 
Ultrix and Ultricore Database Guide.

Creating Salvos
The Salvos tab enables you to create, delete, re-name, and manage your salvos in an interface that 
is off-line. The Salvo tab layout is similar to the Matrix Panel layout where crosspoints are arranged 
in a grid layout with sources in columns and the destinations in rows. 

To create a salvo

1. In the Basic Tree View, expand the Database node for the Ultricore CC.

2. Double-click the Salvos node.

The Salvos tab opens.

3. Create a new salvo in the database as follows:

a. Click Edit > Add. 

The Add Salvo dialog opens.

b. Type a unique identifier in the Name field for the new salvo.

c. Click Apply.

The Add Salvo dialog closes and the Salvos list updates with the new salvo selected.

4. Select the Level(s) button for the level(s) to include in the salvo.

The Level(s) buttons are lit.

5. To create a single crosspoint switch, use the cross-hairs to select the source/destination 
combination on the grid.
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6. To assign multiple destinations to the same source.

a. Click the button(s) in the Destination toolbar for each destination to include in the switch; or 
click Select All to include all the available Destinations.

b. Click the button in the Source toolbar for the source to use for the switch.

The grid updates to indicate the new selections. Notice that each level is represented by a 
corresponding slice of the crosspoint indicator. In the case below, there are seven crosspoint 
switches selected that will affect two levels.

7. Select the Follow button to enable the levels to automatically follow the switches.

 Click Advanced > Clear Dest Presets to cancel the destination selections or click Advanced > 
Clear All Presets to clear the workspace.

8. Click Apply.

The salvo settings are updated.
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Saving the Current Crosspoint Status as a New Salvo
The Advanced menu in the Salvos tab provides the option to capture the current state of the 
crosspoint selections and save them as a salvo.

To create a salvo based on the current destination status

 This procedure captures the status of all destinations.

1. Verify the current crosspoint state using one of the soft panels in your database. Refer to “Soft 
Panels in DashBoard”.

2. In the Basic Tree View, expand the Database node for the Ultricore CC router.

3. Double-click the Salvos node.

The Salvos tab opens.
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4. Create a new salvo in the database as follows:

a. Click Edit > Add. 

The Add Salvo dialog opens.

b. Type a unique identifier in the Name field for the new salvo.

c. Click Apply.

The Add Salvo dialog closes and the Salvos list updates with the new salvo selected.

5. Click Advanced > Capture System Status.

The matrix in the Salvos tab updates to reflect the current crosspoint state as verified in step 1.

6. Click Apply.

To create a salvo based on selected destinations

 This procedure captures the status of selected destinations.

1. Verify the current destination crosspoint states using one of the soft panels in your database. 
Refer to “Soft Panels in DashBoard”.

2. In the Basic Tree View, expand the Database node for the Ultricore CC router.

3. Double-click the Salvos node.

The Salvos tab opens.

4. Create a new salvo in the database as follows:

a. Click Edit > Add. 

The Add Salvo dialog opens.

b. Type a unique identifier in the Name field for the new salvo.

c. Click Apply.

The Add Salvo dialog closes and the Salvos list updates with the new salvo selected.

5. Click Advanced > Capture Dest Status.

The matrix in the Salvos tab updates to reflect the current Destination states as verified in step 
1.
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6. Select the Level(s) button for the level(s) to include in the salvo.

The Level(s) buttons are lit.

7. Select the source(s) to use in the crosspoint switch.

8. Click Apply to update the salvo settings.

Copying and Pasting a Salvo
You can create a copy of a saved salvo and edit its settings or add crosspoint selections separately 
from the original salvo.

To copy and paste a salvo

1. In the Basic Tree View, expand the Database node for the Ultricore CC router.

2. Double-click the Salvos node.

The Salvos tab opens.

3. Select the salvo to copy from the Salvos list.

4. Click Edit > Copy.

5. Click Edit > Paste.

A new salvo displays at the bottom of the Salvos list in the Salvos tab. By default, the salvo is 
named Salvo # where # is an automatically assigned value.

6. Give the new salvo a unique identifier as outlined in “To re-name a salvo”.

7. Edit the settings of the new salvo as outlined in “To edit a salvo”.

Editing a Salvo
Once a salvo is created in the database, you can edit its crosspoint selections, 

To edit a salvo

1. In the Basic Tree View, expand the Database node for the Ultricore CC router.

2. Double-click the Salvos node.

The Salvos tab opens.

3. Select the salvo from the Salvos list.

The grid updates to display the crosspoint selections currently saved for the salvo.

4. Perform steps 4 to 7 as outlined in “To create a salvo”.

5. Click Apply to save your changes.

To re-name a salvo

1. In the Basic Tree View, expand the Database node for the Ultricore CC router.

2. Double-click the Salvos node.

The Salvos tab opens.

3. Select the salvo from the Salvos list.

The grid updates to display the crosspoint selections saved for the salvo.

4. Click Edit > Rename.

The Rename Salvo dialog opens.

5. Type a new name for the salvo in the Name field.
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6. Click Apply.

The Rename Salvo dialog closes and the salvo displays with the new name in the Salvos list.

Deleting a Salvo
Deleting a salvo removes it from the database. The corresponding button on any soft panels for the 
deleted salvo are also no longer displayed.

To delete a salvo from the database

1. In the Basic Tree View, expand the Database node for the Ultricore CC router.

2. Double-click the Salvos node.

The Salvos tab opens.

3. From the Salvos list, select the salvo to delete.

4. Click Edit > Delete.

5. Click Apply to close the dialog.

The salvo no longer displays in the Salvos list to the left of the workspace. If the salvo was 
assigned to a button in a soft panel, the button is automatically deleted from the panel.

Recalling a Salvo
Once you have saved a salvo, you can recall it for use on a soft panel in DashBoard.

 You cannot recall salvos from a Category soft panel.

For More Information on...
• adding salvos to customized soft panels, refer to “Creating a Soft Panel”.

To recall a salvo from a Matrix panel

1. In the Basic Tree View, expand the Soft Panels node for the Ultricore CC router.

2. Double-click the node for a Matrix Panel.

The Matrix Panel tab opens.

3. Click Salvo.

4. Click Recall.

The Execute Salvo dialog opens. Notice that the Active column reports whether the salvo is 
currently in use (ON) or not (OFF).

5. Select the salvo to recall.

6. Click Apply to close the dialog.
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7. Click Take to apply the salvo.

To recall a salvo from a MultiBus panel

1. In the Basic Tree View, expand the Soft Panels node for the Ultricore CC router.

2. Double-click a MultiBus Panel node.

The MultiBus Panel tab opens. The salvo buttons are located at the bottom of the soft panel 
interface. If a salvo button is lit green, it is currently in use. 

3. Click the button for the salvo you wish to recall.

The salvo button and Take buttons are now lit on the soft panel.

4. Click Take to apply the salvo.

The crosspoint switch is made, and the salvo button is no longer lit.
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Operation with Ross Devices
The Ultricore CC Central Controller connects to Ross NK series routers and Remote Control Panels 
(RCPs). Ross NK series routers and RCP devices may connect to the Ultricore CC via an 
NK-IPS/NK-NET over Ethernet.

 This chapter is applicable if you are running software version 5.6 or lower. Otherwise, refer to the 
Ultrix and Ultricore Database Guide.

 It is recommended for optimum performance to minimize device connections to the NK-NET.

For More Information on...
• defining connection points between Ultricore CC and external devices, refer to “Device 

Communication Setup”.

Overview
Introducing an Ultricore CC to an existing Ross NK system requires specific configuration to enable 
the Ultricore CC to manage the devices in the routing system.

 Ultricore CC does not support Unicode characters.

Using RCP-NK Series Remote Control Panels

When adding the Ultricore CC router to an existing system with one or more RCP-NK devices, each 
remote control must:

• have the Virtual routing enabled on their Configuration page
• have the Comms Retry Delay Factor set to 80ms or greater
• ensure that the level numbers correspond to the Ultricore CC Level ID number

Be aware that the RCP-NK devices do not:

• support Ultricore CC salvos
• automatically get source and destination labels from the Ultricore CC. They must be entered 

manually or via a global labels file.

Using an Ross NK Series Router

The Ross NK router partitioning not supported. The logical mapping of the Ultricore control system 
is far more capable and should be implemented there if required.

Keep the following in mind:

• The NK-IPS requires version 2.23 or higher to communicate with an Ultricore CC.
• The SCP/A is not supported.
• The SCP/K2 is not supported.
• NK-A64 control level is not supported.

Table 14 outlines the nomenclature that Ultricore CC automatically uses for Ross NK devices. 

Table 14  Default Ultricore CC Naming for Ross NK Devices

Device Matrix Name Port Name
NK-3Gxxx deviceName.SDI deviceName.slot1.in/out[socket number].SDI.ch1



144 • Operation with Ross Devices Ultricore CC User Guide (v15-rev2)

Using Ross Analog Audio Devices (NK-A16, NK-A32, NK-A64)

The Ross NK Analog Audio devices (NK-A16, NK-A32, NK-A64) will present as two matrices: Left and 
Right respectively.

Connection Diagrams

Figure 36 provides an example of a routing system with an Ultricore CC Central Controller, an 
NK-IPS, and several Ross NK devices. Communication between the NK-IPS and the Ross NK devices 
is over T-Bus, while the Ultricore CC communicates with the NK-IPS via Ethernet.

Figure 36  Connection Example with an NK-IPS

NK-Axxx deviceName.An Aud L deviceName.slot1.in/out[socket number].An Aud L.ch1

deviceName.An Aud R deviceName.slot1.in/out[socket number].An Aud R.ch1

NK-Dxxx deviceName.AES deviceName.slot1.in/out[socket number].AES.ch1

NK-Mxx deviceName.Machine Control deviceName.slot1.in/out[socket number].Machine 
Control.ch1

NK-MDxxx deviceName.SDI deviceName.slot1.in/out[socket number].SDI.ch1

NK-Vxxx deviceName.An Vid deviceName.slot1.in/out[socket number].An Vid.ch1

Table 14  Default Ultricore CC Naming for Ross NK Devices

Device Matrix Name Port Name

Network Switch

PORT 2 PORT 3 PORT 4 PORT 5 PORT 6 PORT 7 PORT 8PORT 1

PC running DashBoard

Internet / LAN / VPN

NK-IPS
Network Bridge

ETHERNET

POWER Service
PortT-BUS

RCP-NKM
Remote Control Panel

PSU
T-BUS

RCP-NKQ
Remote Control Panel

PSU
T-BUS

NK-A64
32x32 Stereo Analog Audio Router

T-BUS

T-BUS VID REF

AUDIO
INPUTS

1-4

9-12

17-20

25-28

5-8

13-16

21-24

29-32

1-4

9-12

17-20

25-28

5-8

13-16

21-24

29-32

AUDIO
OUTPUTS

NK-MD32
Machine Control / Data Router

POWER

18

2

19

3

17

1

20

4

21

5

22

6

23

7

24

8

25

9

26

10

27

11

28

12

29

13

31

15

30

14

32

16

Ultricore
Central Controller

T-BUS
PORT 2PORT 1

ETHERNET

COM1

COM2

PSU 1

PSU 2 ALARM



Ultricore CC User Guide (v15-rev2) Operation with Ross Devices • 145

Figure 37 provides an example of an Ultricore CC Central Controller, Ultrix router, NK-NET and 
various NK devices. 

 The NK-NET requires phantom power from the T-Bus to operate. This is available from any Ross 
NK series router. 

Figure 37  Connection Example with Two NK-NETs and an Ultrix Router

NK-3G-16
16x16 3G/HD/SD SDI Router

T-BUS VID REF

1 3 5 7 9 11 13 15

2 4 6 8 10 12 14 16
INPUTS

1 3 5 7 9 11 13 15

2 4 6 8 10 12 14 16
OUTPUTS

NK-3G-16
16x16 3G/HD/SD SDI Router

T-BUS VID REF

1 3 5 7 9 11 13 15

2 4 6 8 10 12 14 16
INPUTS

1 3 5 7 9 11 13 15

2 4 6 8 10 12 14 16
OUTPUTS

T-BUS
PORT 2PORT 1

ETHERNET

COM1

COM2

PSU 1

PSU 2 ALARM

Ultricore
Central Controller

RCP-NKM
Remote Control Panel

PSU
T-BUS

NK-3G64
64X64 3G/HD/SD SDI Router

VIDREFT-BUS

PC running DashBoardPC r

Internet / LAN / VPN

ETHERNET

RCP-ME
Remote Control Panel

PSU

ULTRIX-FR1
32x32 3G/HD/SD SDI Router

ENET 2

ENET 1

1 4 A B

REF

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

AUX A AUX B

OUT IN

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

AUX A AUX B

OUT IN

Ultrix-HDBNC-IO

REF

!

Network Switch

PORT 2 PORT 3 PORT 4 PORT 5 PORT 6 PORT 7 PORT 8PORT 1

N
K

-N
ET

T-
BU

S 
to

 E
th

er
ne

t A
da

pt
er

N
K

-N
ET

TBUS

ETHERNET

N
K

-N
ET

T-
BU

S 
to

 E
th

er
ne

t A
da

pt
er

N
K

-N
ET

TBUS

ETHERNET



146 • Operation with Ross Devices Ultricore CC User Guide (v15-rev2)

Ross RCP-NK Series Remote Control Panels
When adding the Ultricore CC to an existing system with one or more RCP-NK series devices, each 
panel must:

• have the Virtual Routing enabled on their Configuration page
• have the Comms Retry Delay Factor set to 80ms or greater
• ensure that the Level numbers correspond to the Ultricore CC Level ID number

Be aware that the RCP-NK series devices do not:

• support Ultricore CC salvos
• automatically receive source and destination labels from Ultricore CC. They must be entered 

manually or via a global labels file.

Ross NK Series Routers
Ross NK Series routers can utilize two methods of connection to the Ultricore CC:

• Direct T-Bus connection
• Ethernet connection via an NK-IPS or NK-NET

All Ross NK routers are automatically discovered1 and appear in the available matrix list ready for 
label assignment.

Integrating Ross NK Series Devices with Ultricore CC
Keep the following in mind when integrating Ross NK Series devices with Ultricore CC:

• Ross NK partitioning is not supported across different levels. Use Ultricore CC to facilitate this 
operation.

• NK-Ax analog audio routers present as two routers (Left and Right).
• NK-A64 control level is not supported.
• NK-SCP/A is not supported.
• NK-SCP/K2 is not supported.

Adding Ross NK Series Routers to the Ultricore Routing System
Add a Ross NK series device to the Ultricore routing system requires the following steps:

1. Determine the connection method to the Ross NK router. Choose from the following:

• Direct T-Bus
• Ethernet via NK-NET or NK-IPS

2. If you are using a Direct T-Bus connection, verify that the Ross NK series router is listed in the 
Connections tab for the Ultricore CC. T-Bus devices are automatically discovered as T-Bus 
communication is always enabled on the Ultricore CC.

3. If you are using an ethernet connection, define a connection point between Ultricore CC and 
each NK-IPS or NK-NET. Refer to “Connecting to Ross Ethernet Devices” for details.

4. Review the port label matrices for the Ultricore CC database.

5. Assign outputs to the logical destinations in the database as outlined in “To map a physical 
output to a destination”.

1. Once an ethernet connection point has been established for ethernet connections.



Ultricore CC User Guide (v15-rev2) Operation with Ross Devices • 147

6. Assign inputs to the logical sources in the database as outlined in “To map a physical input 
with a source”.

Integrating Ross RCP-ME/RCP-QE Panels with Ultricore CC
RCP-QE and RCP-ME ethernet series remote control panels connect to Ultricore CC via the facility 
network. The panels offer some extra features not available to RCP-NK series control panels;

• automatic source and destination labeling
• automatic level and salvo labeling
• the ability to trigger system wide salvos
• Category index source/destination selection method (RCP-QE only)

Adding a Ross RCP-ME or RCP-QE Panel to the Ultricore Routing System
The Connection Editor interface for an RCP-ME or RCP-QE enables you to configure the connection 
point from the panel to Ultricore CC. You will need DashBoard installed and running to access the 
Connection Editor interface.

To add an RCP-ME or RCP-QE

1. Connect the RCP to facility network and configure the network settings as outlined in the user 
guide for your remote control panel.

2. Open the Connection Editor in DashBoard for your panel as follows:

a. In the Basic Tree View of DashBoard, expand the tree view for the remote control panel.

b. Double-click the Connection icon within the device tree.

The Connection Editor opens.

3. Locate the Servers to connect to area.

4. In a row of the provided table, type the IP Address of the Ultricore CC you want to establish a 
connection to.

Upon a successful connection and a refresh of the current DashBoard view (click the Refresh 
button), a check mark displays next to the successful connection. In the above example, an IP 
Address is entered for Server 1.

5. Verify in the Connections area that a connection is establish.

6. Configure the Remote Control Panel layout as outlined in the user guide for your panel.
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Machine-Control (RS-422) Logical Mapping
Connecting an NK-M series router to Ultricore CC requires some special consideration.

Machine control routing requires two crosspoints for a point to point connection due to the 
bi-directional nature of the signal. Each physical socket contains a transmit/receive pair. This can be 
thought of as a source-destination combination and is known as a port. 

It is necessary to configure the input and output of the machine control port on the same row ID on 
the logical mapping tables.

Figure 38  Destination Mapping

Figure 39  Source Mapping

It does not matter where the machine control is mapped (either row 3 or 300), but the input and 
outputs physical ports must be mapped to the same row ID.

Conditions for Machine Control
Three conditions must be met before machine control can be switched.

1. The NK machine control router is attached and configured within Ultricore CC (level, 
destination. and source maps).

2. Selected breakaway or level must include the machine control level.

3. Machine control reciprocal must be enabled on the controller.

Configuring T-Bus Devices
Configuration of T-Bus devices connected to an Ultricore CC T-BUS port may be achieved by 
opening an IPS style connection to the Ultricore CC Central Controller. This allows configuration and 
review of device settings in the same manner as legacy system with an NK-IPS.

Adding an NK-IPS Connection to Ultricore CC
An NK-IPS connection must be manually added to DashBoard so the T-Bus devices may be 
configured.

To add an IPS connection to Ultricore CC

1. Note the TCP/IP Address of the Ultricore CC that you want to establish a connection to:

• In the Basic Tree View of DashBoard, hover your mouse cursor over the main Ultricore CC 
node; or

• In the Basic Tree View of DashBoard, right-click the main Ultricore CC node in the tree view 
and select View Frame Information to display the Connection Information dialog.
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2. Configure DashBoard to open an NK-IPS Connection to that TCP/IP address as follows:

a. In the Basic Tree View toolbar, click  to display the Add New Connection dialog.

b. Select NK-IPS Connection.

The New TCP openGear Frame Connection dialog opens.

c. In the IP Address field, enter the IP Address of the Ultricore CC you noted in step 1.

d. Click Finish to apply your change and close the dialog.

3. Verify that a new node displays in the Basic Tree View. Note that the new node will have the 
same name as your Ultricore CC device (where the default name is Ultricore CC).

4. Complete the device configuration by double-clicking the device under the IPS node in the tree 
view. Refer to the user guide that accompanied your device for configuration details.

Operation with an Ultrix Router
Keep the following in mind when operating an Ultrix router within the Ultricore CC routing system:

• The Ultrix hardware is configured on the Ultrix router in DashBoard. Device specific functions 
such as hardware setup, installed license keys, and Ultriscape setup remain in the DashBoard 
node of the Ultrix router. 

• The Ultriscape (Multiviewer) licensed feature is configured on the Ultrix router in DashBoard.
• All crosspoint changes (including salvos) must originate from the master Ultricore CC database.
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• All routing commands are sent to and executed by the master Ultricore CC. This includes any 
third-party communications (GVG, Probel, TS, etc.). The Ultrix router will ignore any routing 
commands not originating from the master Ultricore CC database while in this connected mode.

• If more than one Ultrix router is to be controlled from the Ultricore CC, ensure that you assign 
unique device names for the Ultrix routers via the front panel. This will help to quickly identify the 
routers within the Ultricore CC system. Refer to “Connecting to an Ultrix Router”.

• Each Ultrix router must be configured for remote control mode.
• All Remote Control Panels (RCP) must be configured to connect with the master Ultricore CC.

Figure 40  Example Setup Using an Ultricore CC and an Ultrix
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System Integration Examples
There are many aspects of Ultricore CC that you can configure to suit the needs of your 
organization. The properties that you are able to configure depends on your user permissions. Note 
that the information provided is for illustration purposes only, and the requirements for your 
facility may differ from what is presented.

Adding Ultricore CC to Legacy Systems
In this example, you have legacy NK routers without remote control panels but you want to add the 
Ultricore CC as a system controller.

Figure 41  Routing System with Legacy Routers and No Remote Control Panels
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You can use Ultricore CC and a series of NK-NETs to provide ethernet connectivity for T-Bus based 
legacy systems.

Figure 42  Adding Ethernet Communications via an Ultricore CC
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Integrating Third Party Routers with an Existing System
Ultricore CC integrates supported third-party routers using GVG protocol translation. In this 
configuration, the Ultricore CC or the Ross router is the system master. 

Figure 43  Integrating Third-Party Routers with an Ultricore CC
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Integrating Routers with a Third Party Control System
Ultricore CC is integrated with an existing third-party routing system to add an NK router as a 
matrix within and under control of the third-party system. In this case, the Ultricore CC acts 
primarily as a protocol translator.

Figure 44  Using Ultricore CC to Integrate Existing Routers with a Third-Party Controller
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Adding Third Party Control to Existing Systems
If you have an existing Ross routing system, you can add an external controller, such as an 
automation device, that is compatible with a supported third-party protocol. In this example, the 
Ultricore CC acts as the system controller and provides a protocol translation for the external 
third-party control device. 

To add the third-party controller to your router system, connect the external controller to Ultricore 
CC and configure Ultricore CC to translate between the third-party controller and the rest of your 
Ross routing system. 

Figure 45  Adding Third-Party Control with an Ultricore CC
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Monitoring of the Routing System and Communications
If you have an existing complex routing system with integration between the Ross products and 
third-party equipment connected using a variety of communication protocols. This requires the 
monitoring and/or logging of the communications streams to troubleshoot issues that could arise 
with system-level interactions.

In this case, the Ultricore CC acts as the system controller and provides system logging and 
monitoring functions because it provides protocol translations and communications ports to 
enable communications between all the devices in your system.

Figure 46  Monitoring an Existing Routing System with an Ultricore CC
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Replacing an NK-IPS
You are replacing legacy remote control panels but still T-Bus power and communication for one or 
more legacy NK products. In this case, the Ultricore CC acts as the system controller, and provides 
power to T-Bus. The remote control panels use virtual switch commands to control the router 
system. 

Figure 47  Replacing an NK-IPS with an Ultricore CC

Caution — Observe T-Bus power limitations. Ultricore CC has one loop through T-Bus port 
where the NK-IPS has eight.
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Replacing an NK-3RD
If you have a system without an NK-IPS or an NK-3RD but you still require external control system 
that uses GVG protocol. In this case, the Ultricore CC acts as the system controller and provides 
T-Bus connection to the NK routers. The remote control panels/clients use virtual switch commands 
to control the routing system. Other attached clients may use third-party protocols to control the 
routers. The Ultricore CC translates the third-party protocol to enable control of the entire NK 
routing system.

Figure 48  Replacing an NK-3RD with an Ultricore CC
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External Control
This chapter lists the third-party protocols the Ultricore CC supports.

 This chapter is applicable if you are running software version 5.6 or lower. Otherwise, refer to the 
Ultrix and Ultricore Database Guide for details on communication setup via third-party 
protocols.

Ultricore CC Control with Third-Party Systems
Ultricore CC may be controlled by third-party control or automation systems via the GVG Native 
Series 7000 or Probel SW-P-08 protocols.

Ethernet Communication
The Ethernet interfaces to these protocols are automatically started with Ultricore CC and no 
further configuration is necessary. However, you must configure your external control systems to 
match the settings outlined in Table 5. 

For More Information on...
• defining an ethernet connection between Ultricore CC and an external device, refer to “Incoming 

Ethernet Connections”.

Serial Communication
If you are using a serial connection, you must first define the serial connection point as outlined in 
“Defining a Serial Connection” and selecting GVG Native or Probel SW-P-08 from the Protocol 
menu and the settings as outlined in Table 6.

Third-Party Matrix Control with Ultricore CC
The Ultricore CC control system is able to control third-party matrix devices. Two popular routing 
protocols are available to enhance compatibility: GVG Series 7000 and Probel SW-P-08.

To configure third-party matrix control

1. Create an outgoing connection point from the Ultricore CC to the third-party matrix device.

2. Define the external matrix.

3. Mapping the external matrix inputs and outputs.

4. Define the Ultricore CC operating level.

5. Assign external matrix to the Ultricore CC source and destination levels.

The following sub-sections outline each step required to configure third-party matrix control.

Create an Outgoing Connection Point
You must define an interface for the system to access third-party matrix devices. The connection 
point must be compatible with the settings of the external device you are trying to control.

Before proceeding, ensure that you have the following connection specifics:

• Communication protocol (GVG Native Series 7000 or Probel SW-P-08)

• Communication type (TCP/IP or serial1)

Refer to “Connecting to Third-Party Devices” for details.
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Defining the External Matrix
The system does not automatically know the details of any connected third-party matrix. The user 
must manually define the size and operating level within the Ultricore CC database. 

Creating a Logical Matrix for an External Device

Once you establish a valid connection point between the Ultricore CC router and an external device, 
you can create logical matrices in an Ultricore CC database using the device inputs and outputs. 
Creating a logical matrix from the external device enables Ultricore CC to include the inputs and 
outputs for selection in the Sources and Destination tabs of the Ultricore CC database.

 The input/output range and level you specify in the Ultricore CC database must match the 
settings within the external matrix. 

To create a logical matrix from an external device

1. Expand the Database node.

2. Double-click the Third Party Matrices node located under the Database node.

The Third Party Matrices tab opens. 

3. Click Edit > Insert to display the Insert Matrix dialog.

4. In the Name field, type a unique identifier for the third-party matrix. This name is used to 
identify the matrix within the Ultricore CC database.

5. Click Apply to close the Insert Matrix dialog and add a blank row to the Third Party Matrices 
table.

In the example below, a new matrix named “Matrix 2A” was added.

6. From the Device ID drop-down menu, select the device you want to define the logical matrix 
for. This is the name given to the device when you established a connection point with it on the 
Connections tab.

 The Device ID menu lists only the third-party devices that have a valid connection point with the 
Ultricore CC router.

1. Only available natively on the Ultricore CC Central Controller. Serial connections from Ultrix requires an external 
USB-serial converter.
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7. Define the matrix size as follows:

a. Use the First Output and Last Output fields to define the range of destinations from the 
device within the Ultricore CC database.

b. Use the First Input and Last Input fields to define the range of sources from the device 
within the Ultricore CC database.

 These created inputs and outputs will use the nomenclature DeviceID.Slot.Port.Type.Channel 
where DeviceID represents the Name assigned to the external device on the Connections tab.

8. Use the Level field to specify the number of levels for the device within the Ultricore CC 
database.

9. Use the Type field to specify the signal type for the matrix. 

10. Click Apply to save the new matrix to the database and add it to the list of available matrices in 
the Port Labels tab.

Mapping the External Matrix Inputs and Outputs
Once the connection point and matrix are defined in the Ultricore CC database, you can map the 
external matrix inputs and outputs in the same manner as we do with Ross device matrices. 
However, you will instead select an external matrix output from the Outputs list (or an external 
matrix input from the Inputs list) in the database interfaces. The available inputs and outputs will 
display in the format of DeviceID.slot#.in[x].Type.ch# or DeviceID.slot#.out[x].Type.ch#. 

 It may be necessary to create a new level in the Ultricore CC database for the assignment of 
inputs and outputs to logical labels. Refer to “Defining the Levels in a Database” for details.

For More Information on...
• assigning destinations, refer to “Defining the Destinations in a Database”.
• assigning sources, refer to “Defining the Sources in a Database”.

Using Index Numbers
Some protocols refer to source and destinations with a numerical index number. This number is 
listed in the ID column of the Source and Destination tabs of the Ultricore CC database.

For example, the GVG protocol reference to destination ‘00h’ correlates to Ultricore CC destination 
ID 1 in the case shown below for the Dest 1 entry in the table.

Figure 49  Example of ID Numbers Listed in a Destinations Tab

Protocol Options
Some protocols provide additional configuration options via the Protocol Options dialog. These 
options can be accessed via the Protocol Servers table on the Database > Connections interface. 
Selecting an Options button to on the table opens this dialog.

The Protocol Options are outlined with the respective protocol details in the following sections.
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GVG Series 7000 Native Protocol Commands
Ultricore CC supports the GVG Series 7000 Native protocol and is available over an RS-422 or RS-232 
serial connection, as well as Ethernet connection. 

Table 16 summarizes the settings in the Protocol Options dialog for the GVG Series 7000 Native 
protocol.  

Table 17 lists the GVG Native Protocol commands the Ultricore CC supports.

Table 15  Default GVG Native Connection Types

Setting
Serial
Connection Type RS422 or RS232

Baud 38400

Data Bits 8

Parity None

Stop Bits 1

Ethernet

Port 12345a

a. Port 12345 is the default value but is user configurable.

Table 16  Protocol Options — GVG Series 7000 Native

Option Setting Notes
L4 Echo Yes Send command acknowledgments on 

protocol layer 4 (Ethernet only)

No Do not send acknowledgments. This 
is the default.

Table 17  GVG Native Protocol Commands

Message
NotesCommand Description

BK[,parameter]

BK,D Force next QD command to 
return status of all 
destinations

Clears the flags associated with the D,no_parameter 
command. After BK,D is sent, the next 
QD,no_parameter command will result in destination 
statuses or all destinations being returned.

BK,E Request status of level 4 echo 
setting

BK,E,ON Set level 4 echo to on An err=00 response will be returned for successful 
commands that do not generate their own response 
(eg. Take commands).

This is a per session setting.

BK,E,OFF Set level 4 echo to off 
(default)

No response will be given for commands that do not 
generate their own response.

PR,dest_name,level_bitmap Protects a specific 
destination from having its 
source changed

ER error-code response is currently not supported.
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For More Information on...
• these commands, refer to the GVG protocol documentation.

QC[,dest_name] Query Combined Destination 
status by name

QD[,dest_name] Query Destination status by 
name

No information is returned for unmatched 
destination levels

Qd[,dest_name] Query Destination status by 
name

Sets response src_name to NO_XPT for unmatched 
destination levels

QI,destIndex,lvlIndex Query Destination status by 
indexa

Qi,destIndex,lvlIndex Query Destination status by 
indexa

The srcIndex returned will be 0xfffe if an error 
condition applies to the crosspoint being reported.

QJ[,destIndex] Query Destination status by 
indexa

No information is returned for unmatched 
destination levels

Qj Query Destination status by 
indexa

Sets response srcIndex to 0xFFFe for unmatched 
destination levels

QN,parameter

QN,S Query source names/labels

QN,D Query destination 
names/labels

QN,L Query level names/labels

QN,IS Query names via source 
indexa

QN,ID Query names via destination 

indexa

QN,V Query salvo name

QT Query date and time

TA,dest_name,nbr_sources,src_na
me_entry1[,...src_name_entryn]

Takes sources (on specified 
levels) to specified 
destination, by name rather 
than index

Src_name_entryn = src_name,level_bitmap

TD,dest_name,src_name_entry Takes same source to all or 
specified levels

Src_name_entryn = src_name[,levelbitmap]

No levelbitmap=all destination levels

TI,destIndex,srcIndex[,levelIndex] Request take by index with 
level indexa

TJ,destIndex,nbr_sources,srcInde
x,level_bitmap[,...,srcIndex,level_b
itmap]

Takes sources (on specified 
levels) to specified 
destinations by index rather 
than name; allows 
breakaways

TS,salvo_name Request Take Salvo

UP,dest_name,level_bitmap Removes Protect from 
specified destination

ER, error-code response is currently not supported.

a. Zero-based hex logical index numbering.

Table 17  GVG Native Protocol Commands

Message
NotesCommand Description
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RossTalk Commands
The RossTalk protocol is a plain text based protocol that allows control of Ross Video equipment.

 Each command should be terminated by a carriage return and a line feed (CR/LF).

To send RossTalk commands to Ultricore CC

1. Create a network connection to the Ultricore CC router on Port 7788.

2. At the prompt, enter the commands you wish to send. Refer to Table 18 for a list of supported 
commands.

Table 18  RossTalk Protocol Commands

Message
Notes

Command Description
GPI ## Execute the salvo number 

corresponding to the numerical 
## extension of the command

For example, GPI 04 triggers the salvo 
<salvo_name>[4] as listed in the Ultricore CC 
database

TIMER ##:RUN Request Timer ID to 
start/resume

TIMER ##:STOP Request Timer ID to stop

TIMER ##:PAUSE Request Timer ID to pause

TIMER ##:END Request Timer ID to end

XPT D:<dest> S:<source> 
I:<user_id> [L:<levels>]

Crosspoint command for a 
router TAKE where:
• <dest> is the logical destination ID 

from the active database (1-based)

• <source> is the logical source ID 

from the active database (1-based)

• <user_id> is the numeric 

user/panel ID that will be used to 

request the switch

• <levels> is an optional parameter 

specifying comma-separated list of 

1-based level IDs to switch (for 

breakaway, e.g. L:1,2,4). If no 

levels are specified, a follow 

switch (all valid levels) is 

requested. 

• <levels> supports ranges specified 

by two numbers separated by dash 

(e.g. L:1-16)

Range start value must be less than the end value

Single levels and ranges can be mixed in the list (eg. 
L:1,3,4-8,12-17)

There are no spaces between numbers or ranges

Invalid numbers or improperly specified ranges will 
be ignored 

An argument is separated from its value using a 
single colon (:)

Command arguments are separated single spaces

The arguments may be specified in any order, (e.g. 
these are equivalent: XPT D:1 S:4 I:2 and XPT S:4 I:2 
D:1)

Examples:
• ID 7 requesting to switch Dest 2 to Source 1 on Levels 1,3,5 

and 12-16

• XPT I:7 D:2 S:1 L:1,3,5,12-16
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Probel SW-P-08 Protocol Commands
Ultricore CC supports the Probel SW-P-08 protocol and is available over an RS-422 or RS-232 serial 
connection, as well as ethernet connection. Table 19 provides the default values for this protocol. 

When Ultricore CC is the controller, Probel SW-P-08 System 1 is implemented. When Ultricore CC 
is not the controller, Probel SW-P-08 System 3 is implemented (where equipment functions exist). 

Table 20 summarizes the settings in the Protocol Options dialog for the Probel SW-P-08 protocol.

  

Table 19  Default Probel SW-P-08 Connection Types

Setting
Serial
Connection Type RS422 or RS232

Baud 38400

Data Bits 8

Parity None

Stop Bits 1

Ethernet

Port 8910a

a. Port 8910 is the default value but is user configurable.

Table 20  Protocol Options — Probel SW-P-08 protocol

Option Setting Notes
Protocol Variant Non-extended Use non-extended commands only

Extended Use extended commands only

Use Last Request Use command set as per last received 
command format (e.g. if received a 
non-extended command, reply in a 
non-extended format). This is the 
default.

Matrix Mode Yes Swap matrix and level fields

No Do not swap matrix and level fields. 
This is the default.

Unused Field # Send number (0-15) in either Level or 
Matrix field - which ever is not used as 
per Matrix Mode setting. The default 
is 0.
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Table 21 lists the Probel SW-P-08 Serial Protocol commands the Ultricore CC supports.

Table 21  Probel SW-P-08 Native Protocol Commands

Request Message Response Message

Notes
Cmd 

ID Description
Cmd 

ID Description
01 Crosspoint Interrogate 03 Crosspoint Tally Get single crosspoint 

status

02 Crosspoint Connect 04 Crosspoint connected Take single crosspoint

10 Protect Interrogate 11 Protect Tally Get destination protect 
status

12 Protect Connect 13 Protect connected Set destination protect

14 Protect Disconnect 15 Protect dis-connected Turn off destination 
protect

17 Protect Device Name Request 18 Protect Device Name Response Get name of device that 
hold protect

19 Protect Tally Dump Request 20 Protect Tally Dump Get all protect status

21 Crosspoint Tally Dump Request 22, 23 Crosspoint Tally Dump Get all crosspoint status

Cmd22: Byte max dest 
191

Cmd23: Word max. dest. 
65535 

97 Implementation Request 98 Implementation Status Get list of commands 
supported

100 All Source Names Request 106 Source Name Response Get all source names (8 
char. max.)

101 Single Source Name Request 106 Source Name Response Get single source names 
(8 char. max.)

102 All Destination Association Name 
Request

107 Destination Association Name 
Response

Get destination names (8 
char. max.)

103 Single Destination Association 
Names Request

107 Destination Association Name 
Response

Get single destination 
name (8 char. max.)

104 All UMD Labels Request 108 UMD Label Response Only one set of labels is 
currently supported. 
UMD Labels replicate 
source labels. (16 char. 
max.)

105 Single UMD Labels Request 108 UMD Label Response Get single source label 
(16 char. max.)

120 Crosspoint Connect On Go Group 
Salvo

122 Crosspoint Connect On Go Group 
Salvo Acknowledge

Add crosspoint to preset 
group

121 Crosspoint Go Group Salvo 123 Crosspoint Go Done Group Salvo 
Acknowledge

Switch/clear preset 
group

124 Crosspoint Salvo Group 
Interrogate

125 Crosspoint Group Salvo Tally Preset group status

EXTENDED
129 Extended Crosspoint Interrogate 131 Extended Crosspoint Tally Get crosspoint status

130 Extended Crosspoint Connect 132 Extended Crosspoint Connected Take single crosspoint

138 Extended Protect Interrogate 139 Extended Protect Tally Get destination protect 
status

140 Extended Protect Connect 141 Extended Protect Connected Protect a destination
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NVISION Commands
Ultricore CC supports the NVISION NP16 Ethernet protocol.

 Ensure that the Ultrix router has the Ultricore-NVISION license installed. Refer to the Ultrix User 
Guide for details.

Table 20 summarizes the settings in the Protocol Options dialog for the NVISION protocol. 

 

NVISION NP16 Ethernet Protocol
Ultricore CC supports the NVISION NP16 Ethernet protocol. Table 23 outlines the default values for 
the Ultricore CC when using NP16.

142 Extended Protect Disconnect 143 Extended Protect Disconnected Turn off protect for a 
destination

147 Extended Protect Tally Dump 148 Extended Protect Tally Dump 
Message

Get all protect status for 
given level

149 Extended Crosspoint Tally Dump 151 Extended Crosspoint Tally Dump 
Word Message

Get destination status for 
given level

228 Extended All Source Names 234 Extended Source Name Response Get source names (8 char 
max.)

229 Extended Single Source Name 234 Extended Source Name Response Get single source name 
(8 char max.)

230 Extended All Destination 
Association Names

235 Extended Destination Association 
Names Response

Get all destination names 
(8 char. max.)

231 Extended Single Destination 
Association Name

235 Extended Destination Association 
Names Response

Get single destination 
name (8 char. max.)

232 Extended Single UMD Label 
Request

236 Extended UMD Labels Response Get all source labels (16 
char. max.)

233 Extended Single UMD Label 
Request

236 Extended UMD Labels Response Get single source label 
(16 char. max.)

248 Extended Crosspoint Connect On 
Go Group Salvo

250 Extended Crosspoint Connect On 
Go Group Salvo Acknowledge

Preset group 
acknowledge

124 Crosspoint Group Salvo 
Interrogate

253 Extended Crosspoint Group Salvo 
Tally

Preset group status

Table 22  Protocol Options — NVISION protocol

Option Setting Notes
Offset 0 The Ultricore CC level matches the 

NVISION level

1 The Ultricore CC level is the NVISION 
level plus 1

Table 23  Default Connection Types — NVISION NP16

Setting
TCP Port 5194

Table 21  Probel SW-P-08 Native Protocol Commands

Request Message Response Message

Notes
Cmd 

ID Description
Cmd 

ID Description
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NP16 Commands

The NP16 protocol defines the message format: Protocol ID | Sequence Number | byte count | 
Command

Each field consists of a 32bit number where:

•  Protocol ID — 0x0000000C (Router Control Protocol)
•  Sequence number — controller generated and added to Ultricore CC response message
•  byte count — total number of bytes in message including header (<8176)
•  Command — refer to Table 24

 The protocol is zero based, meaning that destination 0 in the protocol relates to destination ID#1 
in Ultrix. This is true for sources, destinations, and level values.

Refer to Table 24 for a list of supported NP16 commands.

NVISION NP0010 Serial Protocol
Ultricore CC supports a limited sub-set of the NVISION serial NP0010 protocol.

Table 25 outlines the default values for the Ultricore CC for an NP0010 serial connection.

Refer to Table 26 for a list of supported NP0010 commands.

Table 24  NP16 Protocol Commands

Message
Notes

Command Description
0x0000 0050 Performs a TAKE

0x0000 0051 Set Output LPR Sets or releases a lock or protect on a 
destination

0x0000 0052 Get Status of Outputs Retrieves the crosspoint status

0x0000 0059 Router Partition Information

0x0000 005E Crosspoint Tally Retrieves the crosspoint status

0x0000 0070 Machine Control Take Format 1 only

Table 25  Default Connection Types — NVISION NP0010

Setting
Connection Type RS232, RS422

Baud 9600, 19200, 38400, 56700, 
115200

Data Bits 8

Parity No

Stop Bits 1

Table 26  NP0010 Protocol Commands

Message
NotesCommand Description

0x50 Take Non-timestamped version only

0x51 Destination status Get destination status
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TSL UMD Protocol v3.1 Commands
Table 27 outlines the default values for the Ultricore CC when using TSL UMD v3.1.

Protocol Implementation
Ultricore CC implements the protocol with the following structure: DisplayID | Control | 
DisplayData.

Table 28 lists the TSL UMD Protocol v3.1 commands the Ultricore CC supports.

0x55 Lock destination Assert a destination lock

0x56 Protect destination Assert a destination protect

0x58 Release destination lock/protect Releases the destination lock and 
protect

0x66 Destination LPR state Get destination locked/protect/released 
status

Table 27  Default Connection Types — TSL UMD v3.1

Setting
Serial
Connection Type RS422

Baud 38400

Data Bits 8

Parity Even

Stop Bits 1

Ethernet

TCP Port 5727

UDP Port 4490

Table 28  TSL UMD Protocol v3.1 Commands

Protocol 
Breakdown Description Ultriscape System Use

Display Address 0 - 126 display identification 
enumeration

DisplayID associated with source or 
destination

Control Byte

Bit 0 Tally 1 status (1=on, 0=off) Tally 1 (Red)a

Bit 1 Tally 2 status Tally 2 (Green)

Bit 2 Tally 3 status Not used

Bit 3 Tally 4 status Not used

Bits 4-5 Brightness value Not used

Bit 6 Reserved Not used

Table 26  NP0010 Protocol Commands

Message
NotesCommand Description
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TSL UMD Protocol v4.0 Commands
 Table 29 outlines the default values for the Ultricore CC when using TSL UMD v4.0.

Protocol Implementation
Ultricore CC implements the protocol with the following structure: Header | Control | DisplayData | 
VBC | XData.

Table 30 lists the TSL UMD Protocol v4.0 commands the Ultricore CC supports.

Bit 7 0 Not used

Display Data 16 ASCII display characters (20h-3Eh) UMD Display Text

a. Green/Red may be swapped by configuring the Global Tally Settings in the Ultriscape Head 
interface for an Ultrix router. Refer to the Ultrix User Guide for details on these settings.

Table 29  Default Connection Types — TSL UMD v4.0 

Setting
Serial
Connection Type RS422

Baud 38400

Data Bits 8

Parity Even

Stop Bits 1

Ethernet

TCP Port 5728

UDP Port 4491

Table 30  TSL UMD Protocol v4.0 Commands

Protocol 
Breakdown Description Ultriscape System Use

Header 0x80 + 0 - 126 display address DisplayID associated with source or 
destination

Control Byte

Bit 0 Tally 1 status (1=on, 0=off) Not used

Bit 1 Tally 2 status Not used

Bit 2 Tally 3 status Not used

Bit 3 Tally 4 status Not used

Bit 4-5 Brightness value Not used

Bit 6 0=display data, 1=command data Display data only (0)

Bit 7 0 Not used

Display Data 16 ASCII display characters (20h - 7Eh) UMD display text

VBC

Table 28  TSL UMD Protocol v3.1 Commands

Protocol 
Breakdown Description Ultriscape System Use
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TSL UMD Protocol v5.0 Commands
Table 31 outlines the default values for the Ultricore CC when using TSL UMD v5.0.

Table 32 summarizes the settings in the Protocol Options dialog for the TSL UMD v5.0 protocol.

Bits 3-0 Byte count of XData

Bits 6-4 Minor protocol version (v4.0=0)

Bit 7 0

XData1

Bits 0-1 Right Hand tally valuea Not implemented

Bits 2-3 Text display valuea Sets PiP label (UMD) text background 
color

Bits 4-5 Left hand tally valuea Displayed in either border or text 
background; can be either or both

Bit 6 Reserved

Bit 7 0

XData2

Bits 0-1 Right Hand tally value Not implemented

Bits 2-3 Text display value Not implemented

Bits 4-5 Left hand tally value Not implemented

a. Where 0=off, 1=Red, 2=Green, 3=Amber

Table 31  Default Connection Types — TSL UMD v5.0

Setting
Serial
Connection Type RS422

Baud 38400

Data Bits 8

Parity Even

Stop Bits 1

Ethernet

TCP Port 5729

UDP Port 4492

Table 30  TSL UMD Protocol v4.0 Commands

Protocol 
Breakdown Description Ultriscape System Use
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Protocol Implementation
Ultricore CC implements the protocol with the following structure: PBC | Ver. | Flags | Screen | 
DMSG (Index, Control, Length, Text).

Table 33 lists the TSL UMD Protocol v5.0 commands the Ultricore CC supports.

Table 32  Protocol Options — TSL UMD v5.0 protocol

Option Setting Notes
Wrapping Yes Wrap commands for TCP mode

No Do not wrap commands (UPD mode). 
This is the default.

PBC in Count 
Value

Yes Include the Packet Byte Count field 
when calculating the byte count value

No Do not include the Packet Byte Count 
field in the byte count value. This is 
the default.

Table 33  TSL UMD Protocol v5.0 Commands

Protocol 
Breakdown Description Ultriscape System Use

PBC Total byte count of packet

Ver. Minor version number (0=v5.00)

 Flags

Bit 0 0=ASCII strings, 1=UTF-16LE

Bit 1 0=display data, 1=screen control Display data only (0)

Bits 2-7 Reserved (0) Not used

Screen 16bit Screen ID ScreenID associated with source or 
destination

DMSG

Index 16bit Display Address DisplayID associated with source or 
destination

Control Minor protocol version (v5.0=0)

Bits 0-1 Right hand tally valuea

a. Where 0=Off, 1=Red, 2=Green, 3=Amber

Sets right-hand tally indicator color 
(Ultriscape configuration dependent)

Bits 2-3 Text display valuea Sets text background and border color

Bits 4-5 Left hand tally valuea Sets left-hand tally indicator color

Bits 6-7 Brightness value (0-3) Not implemented

Bits 8-14 Reserved (0)

Bit 15 0=display data, 1=command data Display data only (0)

Length Byte count of text

Text Text as defined by Flag 0 setting UMD display text
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Enabling SNMP Support
Ultricore CCs running software version 3v4 or higher provide optional support for remote 
monitoring and control of your router using SNMP (Simple Network Management Protocol). This 
protocol is compatible with many third-party monitoring and control tools. 

 The MIB file provides SNMP traps for the configurable alarms on Ultricore CC as well as on the 
power supplies and fans.

Enabling SNMP Support
The SNMP monitoring and control feature for your Ultricore CC is a software option that you enable 
in the System Status > Network tab.

To enable SNMP support on the Ultricore CC

1. Verify that the SNMP license key is installed for the router. Refer to “Installing a License Key”.

2. In the Tree View of DashBoard, double-click the System Status node under the Ultricore CC 
node.

The System Interfaces display in the DashBoard window.

3. Select the Network tab.

4. Locate the SNMP area of the tab.

5. Select the Enable SNMP box.

6. Ensure that the Alarms you want to monitor via SNMP are also enabled on the Ultricore CC 
router.

• “Monitoring the Hardware”
• “Monitoring the Communications”
• “Monitoring the Signals”

Configuring the SNMP Agent using DashBoard
The SNMP Agent on the Ultricore CC uses SNMP version 2 to allow queries of the configured system 
alarms, and state changes to configured alarms will be sent out as SNMP traps to the specified Trap 
Destination IP Address(es).

Whenever the options in the SNMP area are edited, the SNMP Agent is restarted. It can take up to 
10 seconds for all monitored states to be updated. This latency only applies once on startup.

To configure the SNMP Agent using DashBoard

1. In the Tree View of DashBoard, double-click the System Status node under the Ultricore CC 
node.

The System Interfaces display in the DashBoard window.
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2. Select the Network tab.

3. Locate the SNMP area of the tab.

4. Use the SNMP Community Name field to specify the SNMP password for GET requests. For 
example, public.

5. Use the SNMP Trap Destination IP Address field to specify the target address to which traps 
should be sent.

An example of a valid target is provided in the SNMP area.

 A maximum number of six strings are displayed in the SNMP Trap Destination IP Address field 
at one time. If at the maximum number, you must select a string from the field and delete it 
before adding a new target entry.

6. Press [Enter] to apply the changes.

Ember+ Registration and Discovery
This section provides information on the setup and operation for the Ultricore CC to communicate 
with a third-party control system via the Ember+ media distribution protocol.

Establishing a Connection
To establish a connection between the Ember+ client and the Ultricore CC

1. Configure your network streams as outlined in the Ultrix User Guide.

2. Configure your router database as outlined in “Database Configuration”.

3. Install the Ultricore-EMBER+ license on the Ultricore CC. Refer to “Software License Keys”. This 
enables the Ultricore CC to start an Ember+ server and listen to incoming connections.

4. Add the Ultricore CC in the Ember+ control system interface using the IP Address assigned to 
the Ultricore CC.

5. In the Ember+ controls system, set the TCP port to 9000 for the Ultricore CC.

Specifying the Operation Mode
Ultricore CC can be controlled via Ember+ in two modes: Virtual Mode (table mapped IO) or Physical 
Mode (direct socket control). 

To specify the Ember+ operation mode on the Ultricore CC

1. Display the Connections tab for Ultrix as follows:

a. Expand the Database node in the Tree View.

b. Double-click the Connections node.

2. Click Options in the Protocol Servers area.

The Server Options dialog opens.
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3. Use the Ember Plus menu to specify the operation mode required by your Ember+ control 
system. Choose from the following:

• Virtual Mode — each level is represented by a Matrix and the Labels will be the one defined 
in the Destinations and Sources tabs.

• Physical Mode — the whole router is represented as a single Matrix and the physical socket 
labels are used. The external control system using Ember+ commands bypasses the virtual IO 
mapping and directly controls the Ultrix physical socket connections. Therefore the Ultrix 
should not be switched by any other devices.

4. Click Apply to close the dialog.

5. Click Apply at the bottom of the Connections tab to apply the new setting.

Supported Commands
We support the Get Directory and Connect commands. The router is represented using the 
Ember+ Matrix object including Labels. This allows the Ember+ control system to see the number of 
levels, number of sources and destinations and their labels, the per destination status, and issue 
switch commands.

 If you make changes to the router database (such as Levels, Destinations and Sources) after 
establishing communications, you may need to refresh/reload/reconnect the connection.
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Monitoring
The status of the Ultricore CC may be monitored via its fields in the DashBoard client software or 
the LEDs located on the front panel of the chassis.

 This chapter is applicable if you are running software version 5.6 or lower. Otherwise, refer to the 
Ultrix and Ultricore Database Guide.

Enabling Logging for the Ultricore CC
The Ultricore CC records events in non-volatile memory. Each event includes a timestamp, and 
information about the event. The following events and conditions are recorded in the logs:

• Configuration changes that affect the routing path.
• Input state changes such as video presence, audio presence, video formats. In the case of audio 

inputs, the log entry also includes the associated audio cluster.
• Power-on or reboot cycles.
• Error conditions reported by DashBoard.

 You can also monitor the overall routing system status via the Product Info tabs in DashBoard. 
Refer to “Status Tabs” for details on these tabs.

To enable the Ultricore CC to log events

1. In the Tree View of DashBoard, double-click the Product Info node.

The Product Info interface displays in the DashBoard window.

2. Select the Setup tab.

3. Select the Logging box.

Monitoring the Network Status
The Ethernet ports on the Ultricore CC rear panel are used to connect to an ethernet network for 
communications.

To verify the ethernet redundancy status via the Product Info interface

1. In the Tree View of DashBoard, double-click the Product Info node.

The Product Info interface displays in the DashBoard window.

2. Select the Network tab.

3. Refer to Table 37 for a summary of the possible messages displayed in the Network tab.

Forcing an Ethernet Failover Switch
The failover feature enables the Ultricore CC to use the second Ethernet port when the primary 
Ethernet connection is lost or unavailable. The Active ENET field in the Product Info > Network 
tab reports when Ultricore CC switches from one Ethernet port to the other.

To force an ethernet failover switch

1. In the Tree View of DashBoard, double-click the Product Info node.

The Product Info interface displays in the DashBoard window.

2. Select the Network tab.
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3. Click ENET Failover Force.

Monitoring the Ultricore Mode Status
The primary Ultricore CC passes all commands to each client device in the system. Each client 
device responds back to the primary in minute intervals.

Primary Status
If the Ultricore CC is configured as a primary, the Ultricore Clients table in the Communication 
Settings interface reports on the status between it and each client device connected to it. Each 
client is listed in the table, with the most recently connected device displayed at the bottom of the 
list. 

Figure 50  Ultricore CC Mode — Primary Status

Client Status
If the Ultricore CC router is configured as a client, the Communication Settings interface reports 
on the communications between it and the primary.

Troubleshooting
If you have lost communication between the primary Ultricore CC and its clients:

1. Verify that each device is installed correctly.

2. Verify that each device is installed with a network connection to your facility.

3. Verify the Ethernet settings for each device are valid.

4. Verify that the primary Ultricore CC reports a list of valid connections to clients in its Ultricore 
Clients table. 

5. Verify that each client Ultricore CC is running software compatible to the primary Ultricore CC.

Using the System Logs in DashBoard
An entry in each log includes a timestamp, a code number, and a description. Messages are written 
to the log when significant changes occur in the operation of the Ultricore CC. These could include: 
changes to video, reference, audio or time inputs; power-on or reboot cycles; configuration changes 
that can have an effect on the routing path; alarm conditions.

To access the system logs in DashBoard

1. Double-click the Product Info node.

2. Select the Logs tab.

3. To view the communication log for the Ultricore CC only, select the System Log option.
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4. To view the log for communications between the Ultricore CC and other devices, select the 
Controller Communications Log option.

5. To view the log for executed tasks in DashBoard for the Ultricore CC, select the DashBoard 
Communications Log option.

6. Click Refresh to update the entries for the currently selected log.

Saving the Current Settings for the Ultricore CC
You can save the Ultricore CC settings to a configuration file that can be used by Ross Technical 
Support for troubleshooting. Use this procedure only under the guidance of Ross Technical 
Support.

To save your setup a new file

1. In the Tree View of DashBoard, right-click the node for the Ultricore CC that you want to save 
the settings for.

2. Select Save Configuration to File.

The Save Configuration to File dialog opens.

3. Navigate to the folder on your DashBoard computer in which you want to save the 
configuration file.

 The default location is Desktop\My Documents. 

4. Click Save.

Monitoring the Devices in a Routing System
Devices with an established and valid communication point with Ultricore CC are displayed under 
the Devices node in the Tree View. Ultricore CC aggregates all the devices in a system under the 
Devices node to provide system wide monitoring capabilities.

 If you cannot expand a Devices sub-node, there are currently no devices of that type 
communicating with the Ultricore CC.

To monitor the external devices communicating with an Ultricore CC via DashBoard

1. Locate the Ultricore CC node in the Tree View of DashBoard.

2. Expand the main Ultricore CC node.

3. Expand the Ultricore CC sub-node to display a list of sub-nodes in the Tree View.

4. Expand the System node.

5. Expand the Monitoring node.

6. Double-click the Health sub-node.

Monitoring via the Front Panel
The LCD Display on the Ultricore CC front panel reports the IP Address of the Ultricore CC and 
reports when an error or warning condition is occurring on the Ultricore CC panel.

Navigating the Menus
The front panel includes a five-direction round finger joystick that is used to navigate the Ultricore 
CC messages on the LCD Display.
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Figure 51  Positioner Movement

Use the following actions to navigate the parameters:

• In — pressing once brings the menu system onto the monitor output; holding for two seconds 
exits the menu system. This position is also used to enter the menu values/parameters.

• Up — pressing once selects the menu, item, or value above the current selection; holding scrolls 
to the top of the available selections.

• Down — pressing once selects the menu, item, or value below the current selection; holding 
scrolls to the bottom of the available selections.

• Forward — pressing once moves from menu to item to value.
• Back — pressing once moves from value to item to menu.

Monitoring the Ethernet LEDs on the Rear Panel
Each RJ45 connector on the Ultricore CC rear panel include two LEDs that report the ethernet 
communication activity and speed. Refer to Figure 52 for LED locations on the Ultricore CC rear 
panel.

Figure 52  ENET Ports on Rear Panel — LEDs

Up

Down

Back Forward

ENET Port 1 Speed LED

ENET Port 1 Link/Activity LED

PORT 1 PORT 2

ENET Port 2 Speed LED

ENET Port 2 Link/Activity LED

ETHERNET
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Table 34 provides basic LED descriptions.

If you have any questions pertaining to the installation or operation of Ultricore CC, please contact 
us at the numbers listed in “Contacting Technical Support”. Our technical staff is always available 
for consultation, training, or service.

Upgrading the Software
Ultricore CC is upgraded through the DashBoard client. To obtain the most recent upgrade 
package, contact Ross Technical Support.

 Ensure that you are running DashBoard software version 9.10.0 or higher and that the computer 
running the DashBoard client is located on the same network as the Ultricore CC panel.

 Ultricore CC is temporarily taken off-line during the reboot process. The process is complete once 
the status indicators for the Ultricore CC return to their previous status.

Table 34  ENET Port LEDs

LED Status Description
ENET # - 
Link/Activity

Green When lit green, this LED indicates a valid link is established 
on the specified ENET port.

Flashing When flashing green, this LED indicates communication 
activity is occurring on the specified ENET port.

Off When unlit, this LED indicates an invalid link is detected on 
the specified ENET port. Verify the cable connection on the 
rear module port and your network connections.

ENET # - Port 
Speed

Green When lit green, this LED indicates the ENET Port 
communication speed is at 1Gbps.

Yellow When lit orange, this LED indicates the ENET Port 
communication speed is at 100Mbps.

Off When unlit, this LED indicates the ENET Port 
communication speed is at 10Mbps.



182 • Monitoring Ultricore CC User Guide (v15-rev2)



Ultricore CC User Guide (v15-rev2) DashBoard Interface Overview • 183

DashBoard Interface Overview
The DashBoard client software enables you to monitor, configure, and operate your Ultricore CC 
Central Controller. Using the interfaces provided via the DashBoard client software, you can:

• Configure the network connection for your Ultricore CC
• Configure the connections to Ross NK Series routers via NK-NET or NK-IPS devices
• Configure the connections to Ross Ethernet routers and remote control panels
• Specify which attached routing devices or matrices to use
• Configure system levels and assign level names
• Assign physical router inputs and outputs to logical sources and destinations
• Configure source and destination labels
• Perform crosspoint preset/takes
• Monitor the status of multiple levels
• Create and use salvos

 This chapter is applicable if you are running software version 5.6 or lower. Otherwise, refer to the 
Ultrix and Ultricore Database Guide.

Ultricore CC in DashBoard
Ultricore CC groups the configuration, monitoring, and operating features in a Tree View in the 
DashBoard client window. Each node of the tree opens to reveal one or more sub-nodes, giving 
access to the configuration options for your system.

Ultricore CC includes the following interfaces, as separate nodes, in the DashBoard Tree View.

System Status

Double-clicking the System Status node displays two types of tabs within the same DashBoard 
window: Status (read-only) tabs located on the left, and a series of Configuration tabs located on the 
right. This interface is similar to an openGear® card tab system.

Database

Expanding the Database node enables you to configure the connection points, matrices, 
destinations, sources, groups, levels, soft panels, and salvos for the system. The settings are saved 
locally on the Ultricore CC.

Devices

The sub-nodes under Devices provide a list of external devices in the routing system currently 
communicating with the Ultricore CC.

Soft Panels

The Soft Panels tree provides access to the Matrix, MultiBus, and Category soft panels for the 
Ultricore CC. From these panels you can perform crosspoint switches, and manage salvos via a 
DashBoard interface.
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Terminology
Throughout the DashBoard interface, actual sockets (inputs and outputs) of a router (or matrix) are 
referred to by hierarchical dotted notation: Frame.Slot.Port.Type.Channel where:

• Frame identifies the physical router/device housing the matrix/matrices.
• Slot identifies which slot of the matrix is located.
• Port identifies the physical input or output socket.
• Type identifies the generic signal type (e.g. SDI, audio).
• Channel identifies the audio channel within an SDI stream.

These designators may be assigned more user friendly names if required by editing the Port Labels 
interface.

System Status Interfaces
The System Status interface provides hardware information, IP Address settings, and general 
database management for your Ultricore CC. The interface is organized into two distinct areas in 
the DashBoard window: Status tabs (located on the left), and Configuration tabs (located on the 
right).

Figure 53  Example of a System Status Interface

Status Tabs
The Status tabs display read-only information about the Ultricore CC hardware and software.

Product Tab

Table 35 summarizes the read-only information displayed in the Product tab.

Table 35  Product Tab

Item Parameters Description
Product Indicates the Ultricore CC product name

Vendor Indicates the supplier/manufacturer of the device
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Other Tab

Table 36 summarizes the read-only information displayed in the Other tab.

Configuration Tabs
The Configuration tabs of the DashBoard window provide network setup options for the Ultricore 
CC panel and managing the Ultricore CC databases.

Network Tab

Table 37 summarizes the fields and menus displayed in the Network tab. The options in the 
Network tab are organized into two sections: Settings (editable fields), and Ethernet Redundancy 
(read-only fields).

System Version Indicates the build version of the Ultricore CC panel

Serial Number Indicates the serial number of the Ultricore CC 
panel

Uptime #h #m #s Indicates the number of hours since the last reboot 
of the Ultricore CC panel

System Time DD mm dd yyyy 
hh:mm:ss

Indicates the current date based on the Ultricore CC 
internal clock where:
• DD represents the calendar day
• mm represents the month
• dd represents the day
• yyyy represents the year
• hh:mm:ss represents the current local time

Table 36  Other Tab

Item Parameters Description
Frontend SW Rev #

Read-only information used by Ross Technical 
Support.Backend SW Rev #

Device FW Rev #

Table 37  Network Tab

Item Parameters Description
Information

Active ENET ENET # Indicates which Ethernet port on the rear panel is 
the primary Ultricore CC network connection

Table 35  Product Tab

Item Parameters Description
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ENET # LINK Connected            
(x, y)

Indicates that a valid network link is configured on 
the specified Ethernet port of the Ultricore CC rear 
panel where:
• x represents the speed in number of Mbps
• y represents the link type (e.g. full duplex)

Not Connected Ethernet communications for the Ultricore CC are 
invalid. The Ethernet cable may be disconnected on 
the rear panel or the Ethernet network may be 
down or experiencing problems.

ENET MAC (read-only) ###.###.###.#
##

Indicates the MAC Address for the Ultricore CC 

Force ENET Failover Switches the primary Ultricore CC network connection to other 
Ethernet port on the rear panel

Settings

IP Mode Static The user manually defines the Ultricore CC network 
settings

Static-DHCP The DHCP service for your network assigns the 
network settings to the Ultricore CC; once the 
settings are validated, they remain static

Address ###.###.###.#
##

Specifies the IP address for the Ultricore CC panel

Subnet Mask ###.###.###.#
##

Specifies the subnet mask for the Ultricore CC panel

Gateway ###.###.###.#
##

Specifies the gateway for communication outside of 
the local area network (LAN)

Apply Updates the Address, Subnet Mask, and Gateway settings

Cancel Ignores any unsaved changes made to the Address, Subnet Mask, and 
Gateway settings and reverts back to the current running values.

Services

SSH Selected Enables system administrators to securely log onto 
remote systems and execute commands over an 
unsecured network via the Secure Shell (SSH) Login 
client-server protocol

Cleared Disables this service

FTP Selected Enables devices to transfer of files over a network 
connection

Cleared Disables this service

Walkabout Selected The Walkabout configuration software can be used 
to configure the basic network communications 
settings for the Ultricore CC

Cleared Disables this service

Change Click this button to edit the services

Permitted Clients

Table 37  Network Tab

Item Parameters Description
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Database Tab

Table 38 summarizes the fields and menus displayed in the Database tab. The options in the 
Database tab are organized into two sections: Current Database, and Database Management.

DashBoards: ###.###.###.#
##

Lists the IP Address of each DashBoard client that is 
allowed to communicate with this Ultricore CC

Add Enables you to add a new DashBoard client to the Permitted Clients 
list

Delete Deletes the selected DashBoard client from the Permitted Clients list

Delete All Clears all entries in the Permitted Clients list

Edit Enables you to modify the selected entry in the Permitted Clients list

Cancel Ignores any unsaved changes made to the Permitted Clients list and 
reverts back to the current running values

Apply Updates the Permitted Clients list settings

Table 38  Database Tab

Item Parameters Description

Current Databasea

Name <name> Indicates the database currently loaded in Ultricore 
CC

Levels Indicates the number of levels the database is 
configured for

Sources Indicates the number of inputs the database is 
configured for

Destinations Indicates the number of outputs the database is 
configured for

Enable Tally Selected Select this box to enable Ultricore CC to read tally 
identifiers from the input signals. This information 
is passed through to any assigned outputs.
Selecting this box also updates the Sources and 
Destinations tabs with a new column “Tally” that is 
used to assign Tally IDs to sources and/or 
destinations.

Cleared Tally information from the input signals is not read 
into the database.

I/O Ports Refresh Updates the Matrix Inputs and Outputs lists in the 
Sources and Destinations tabs respectively

Crosspoint Status Refresh Updates the Status field located directly below this 
button

Table 37  Network Tab

Item Parameters Description
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Status (read-only) Loaded The active database was successfully loaded. 

Errorb One of the following has occurred:
• the selected database is no longer available
• an attempt was made to delete a non-existent 

database
• an attempt was made to save a database with an 

existing name

Database Management - Load Database

Name <name> Selects the database to load for the Ultricore CC

Database Load Loads the specified database to the Ultricore CC

Database to RCPs Send Forces the currently loaded database settings to 
the connected Remote Control Panels (RCPs)

Database Management - Add Database

Include I/O Maps Creates a database to match the quantity of BNC 
I/O fitted in the router. Each input / output SDI port 
will be mapped to default labels of SRC xx and DST 
xx respectively.
• I/O mapping occurs for Level 1 only (SDI)
• the Sources field is ignored
• the Destination field is ignored
• the Level field is applied

Name <name> Provides a unique identifier for the new database 
(up to 32 characters)

Levels # Specifies the total number of levels the database 
will make available

Sources # Specifies the total number of sources the database 
will make available

Destinations # Specifies the number of levels the database will 
make available

Database Add Uses the settings in the Database Management 
fields to create a new database

Database Management - Delete Database

Name <name> Selects the database to delete

Database Delete Deletes the currently selected database

a. The Levels, Sources, and Destinations fields indicate the initial values when the database was created. 
Levels, Sources, and Destinations can be removed from or added to the database on their respective 
configuration tabs. Doing so will not alter the fields in the Database tab.

b. This message displays for a maximum of 10 seconds only.

Table 38  Database Tab

Item Parameters Description
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Transfer Tab

Table 39 summarizes the options displayed in the Transfer tab. 

Setup Tab

Table 40 summarizes the options displayed in the Setup tab.

Table 39  Transfer Tab

Item Parameters Description
Export

Database: <database name> Selects the database to be exported

Save As: *.uda Automatically updates with the name of the 
database archive

Browse... Enables you to save or re-name the database to a specific location. The 
default location is

Apply Click to begin exporting the file to specified location

Import

Archive File: *.uda Indicates the last file that was imported

Browse... Enables you to specify the database to import

Retrieve Database 
As:

<database name> Indicates the file currently selected for importing

Apply Click to begin the import

Table 40  Setup Tab

Item Parameters Description
Device 
Identification

Device Name <name> Provides a unique identifier for the Ultricore CC in 
the Tree View

System Name <name> Provides a unique identifier for the routing system

Log Settings

Logging Selected Enables the Ultricore CC to update the entries in the 
System Logs interface

Cleared Disables this feature

Output Debug 
Messages

Selected Only use this feature under the guidance of Ross 
Technical Support.Cleared

DashBoard 
Interface

DashBoard Timeout 10-300s Sets the maximum number of seconds that 
DashBoard waits until it queries the Ultricore CC. 
The default is 10 seconds. This value is reset after a 
power-cycle.

Timeout Update Applies the new value in the DashBoard Timeout 
menu.
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Logs Tab

This tab includes the System Log, Controller Communications Log, and DashBoard Communications 
Log. The read-only information displayed in the logs is used by Ross Technical Support for 
diagnostic purposes.

Database Interfaces
The Database interfaces enable you to configure devices in your routing system and configure 
control aspects for Ultricore CC. Note that the currently active database name is displayed in 
parentheses in the tree view. Unicode names are also supported so that names may be defined in 
other languages or writing systems.

Most of the interfaces are organized into a table format with a row of buttons at the bottom of the 
interface. You can select individual cells, columns, or rows of entries to define.

 A summary of each interface is provided in the following sub-sections.

Status mm/dd/yy 
ERROR: 
Duplicate device 
name [abc] for 
ID [#]

Reports when multiple devices, with the same 
name, are communicating with the Ultricore CC 
where:
• mm/dd/yy represents the date of the error
• [abc] represents the device name
• [#] represents the ID number assigned to the 

device

Clear Clears the Status field entry

Ultricore Profile Settings

User Credentials Users must enter their credentials as defined by the 
Ultricore Profiles feature

User Profiles Users are granted permissions based on the profile 
assigned to their account

Routing Behavior

Salvo/Multi- 
Crosspoint Take 
Completion

Require All 
Crosspoints

The Take operation will fail entirely if any 
destinations are locked or protected

Best Effort The Take operation will be performed for any valid 
routes and fail for locked or protected routes

Table 40  Setup Tab

Item Parameters Description
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Figure 54  Example of Filling a Column of Entries

Figure 55  Example of Filling a Row of Entries

Database Builder
The Database Builder interface helps you to quickly create a database by grouping basic controls on 
four pages: Quick Start, Levels, Destinations, and Sources. The same controls are available as 
sub-nodes of the Database interface.

Quick Start

The Quick Start options display by default when the Database Builder displays in DashBoard. From 
this page you can define the database properties including: type of signals (video, audio) the 
number of Ultricore CC routers that the database includes, the audio elements of the database, and 
basic UltriScape parameters.
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Figure 56  Example of the Database Builder — Quick Start Page

Table 43 summarizes the fields displayed in the options in the Quick Start page. 
Table 41  Database Builder — Quick Start

Item Parameters Description
Database name <name> Assigns a unique identifier for the device in the 

routing system. This name is also used when 
matrices are defined in the Ultricore CC system.

Frame select table Displays a list of detected routers in your network. 
Select a box to apply the database to the specified 
router.

Include AUX ports None Do not create entries for AUX ports in the database

Insert at slot Create AUX port entries as they are physically 
located within the Ultricore CC chassis (e.g. ports 17 
and 18).

At the end Create AUX ports after BNC entries

Ultrimix-Dante map Yes Maps the audio channels as defined by the external 
audio matrix from a connected Dante® device

No Audio channels from a connected Dante® matrix 
are not mapped to this database

Video support Yes Creates a database that includes video and audio 
signals

No Creates an audio-only database

Audio channels # Specifies the quantity of audio channels (levels) 
required

Breakaway source 
support

Yes Create sources for audio breakaways/shuffles

No Audio breakaways are not included in this database

SDI audio per 
channel

Creates audio breakaway sources using the 
selected audio channel grouping size

MADI channels per 
source

Creates MADI sources using the selected audio 
channel grouping size
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Levels

Once you defined the options on the Quick Start interface, you can proceed to preview and 
customize the levels, destinations, and sources this database will include. Clicking Next on the 
Quick Start page displays the Levels page. (Figure 57)

The options in the Levels page are organized into a table where each row represents a level and the 
columns provide the options for configuring that level. From this page you assign a unique name to 
each level, a color that represents the level to make it easier to identify the level in a soft panel. 

Figure 57  Example of the Database Builder — Levels Page

Destinations

Clicking Next on the Levels page displays the Destinations page. (Figure 58)

Disconnect source? Yes Creates a source that will disconnect (mute) SDI and 
audio channels

No This option is not included in the database

Passthrough 
source?

Yes Sources are routed without changes/edits

No This option is not included in the database

Ultriscape support? Yes Enables Ultriscape heads and PiPs to be included in 
the database

No Ultriscape heads and PiPs are not included in the 
database

Number of 
Multiviewer heads

# Specifies the number of Ultriscape heads the 
database will support

Number of 
Multiviewer pips per 
head

# Specifies the maximum number of PiPs available 
per layout

Include detected 
Multiviewer layout

Creates sources for detected Ultriscape layouts to 
enable layout changing from control panels

Table 41  Database Builder — Quick Start

Item Parameters Description
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The Destinations page enables the assignment of logical labels (used by remote control panels and 
soft panels) to physical outputs of the attached matrices or routers. The options in the Destination 
page are organized into a table where each row associates a name of the destination with one or 
more logical matrix output sockets. 

Figure 58  Example of the Database Builder — Destinations Page

Sources

Clicking Next on the Destinations page displays the Sources page. (Figure 59)

The Sources page enables the assignment of labels (used by remote control panels and soft panels) 
to inputs of the attached matrices or routers. The options in the Sources page are organized into a 
table where each row associates a name of the source with one or more logical matrix input 
sockets.

Figure 59  Example of the Database Builder — Sources Page
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Connections Tab
Ross Video devices are automatically discovered and available for connection in this tab. Third-party 
devices that are not discoverable via their protocol must be manually added. 

Figure 60  Example of Entries in a Connections Tab

Protocol Servers Table

The Protocol Servers table lists the connection details of external devices that Ultricore CC has 
established a connection point to (e.g. devices that are controlled by this Ultricore CC). Entries in the 
Protocol Servers table are managed by the user as outlined in “Device Communication Setup”.

 
Table 42  Connections Tab — Protocol Servers

Item Parameters Description
Name <name> Assigns a unique identifier for the device in the 

routing system. This name is also used when 
matrices are defined in the Ultricore CC system.

Options

Enabled Enable Direct communication is established between 
Ultricore CC and the device.

Disable Communication between Ultricore CC and the 
device is unavailable.

Connected 
(read-only)

Connect A valid connection is established between the 
device and the Ultricore CC on your network. This 
box is automatically selected when communication 
is established.

Disconnect The connection is invalid or absent between the 
device and the Ultricore CC on your network.
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Incoming Connections Table

The Incoming Connections table lists the connection details of remote client devices (e.g. external 
devices connecting to this Ultricore CC) currently communicating with the Ultricore CC. 

Protocol (read-only) GVG Native The device uses the third-party GVG protocol to 
communicate. Refer to “GVG Series 7000 Native 
Protocol Commands”.

NVISION This device communicates via the third-party 
NVISION protocol. Refer to “NVISION Commands”.

Probel SW-P-08 The device uses the third-party protocol known as 
Probel SW-P-08.

Ross NK The device uses the Ross NK protocol to 
communicate. Refer to “Connecting to Ross NK 
Series Devices”.

TSL UMD v3.1 The device uses TSL UMD protocol version 3.1

TSL UMD v4.0 The device uses TSL UMD protocol version 4.0

TSL UMD v5.0 The device uses TSL UMD protocol version 5.0

Ultrix The device uses the Ross Ultrix protocol to 
communicate (TCP only).

Communication type: t-bus The device is physically connected to a T-BUS port 
on the Ultricore CC rear panel. Communication is 
via the Ross T-BUS protocol.

type: tcp The device is communicating over a network 
connection. Note that the DashBoard client 
computer, the Ultricore CC, and the external device 
must be on the same network.

type: serial The device is physically connected to a COM port on 
the Ultricore CC rear panel. The device is 
communicating with the Ultricore CC via a serial 
protocol.

ip: 
###.###.###.#
##

Specifies the IP Address of the device on the 
network

ip: localhost Indicates that the device is the one you are 
currently configuring

port:###.###.#
##.###

Specifies the ethernet port the device is associated 
with on the network.

... This button opens a dialog allowing further 
connection point setting adjustments such as 
specifying an IP address, IP port, etc.

Table 42  Connections Tab — Protocol Servers

Item Parameters Description
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Table 43 summarizes the read-only fields displayed in the Incoming Connections table in the 
Connections tab. 

Table 43  Connections Tab — Incoming Connections

Item Parameters Description
Communication type: t-bus The device is physically connected to a T-BUS port 

on the Ultricore CC rear panel. Communication is 
via the Ross T-BUS protocol.

type: tcp The device is communicating over a network 
connection. Note that the DashBoard client 
computer, the Ultricore CC, and the external device 
must be on the same network.

type: serial The device is physically connected to a COM port on 
the Ultricore CC rear panel. The device is 
communicating with the Ultricore CC via a serial 
protocol.

ip: 
###.###.###.#
##

Specifies the IP Address of the device on the 
network

ip: localhost Indicates that the device is the one you are 
currently configuring

port:###.###.#
##.###

Specifies the ethernet port the device is associated 
with on the network.

Details Provides additional information on the device such 
as device type, and firmware version

Device ID <name> Specifies the external device for the connection 
point

Name <name> Assigns a unique identifier for the device in the 
routing system. This name is also used when 
matrices are defined in the Ultricore CC system.

Protocol (read-only) GVG Native The device uses the third-party GVG protocol to 
communicate. Refer to “GVG Series 7000 Native 
Protocol Commands”.

NVISION This device communicates via the third-party 
NVISION protocol. Refer to “NVISION Commands”.

OGP This device uses the openGear Protocol to 
communicate with Ultricore CC.

Probel SW-P-08 The device uses the third-party protocol known as 
Probel SW-P-08.

Ross NK The device uses the Ross NK protocol to 
communicate. Refer to “Connecting to Ross NK 
Series Devices”.

TSL UMD v3.1 The device uses TSL UMD protocol version 3.1

TSL UMD v4.0 The device uses TSL UMD protocol version 4.0

TSL UMD v5.0 The device uses TSL UMD protocol version 5.0

Ultrix The device uses the Ross Ultrix protocol to 
communicate (TCP only).
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Third Party Matrices Tab
Once connection points are established with the devices in your routing system, use the Third 
Party Matrices tab to import the logical matrices from those devices into the Ultricore CC 
database.

Figure 61  Example of Entries in a Third Party Matrices Tab

Table 44 summarizes the options displayed in the Third Party Matrices tab. 

Table 44  Third Party Matrices Tab

Item Parameters Description
ID # Auto-numbered field (read-only).

Name <name> Assigns a unique identifier for the imported third 
party matrix 

First Output # Specifies the first destination for the device within 
the Ultricore CC database

Last Output # Specifies the last destination for the device within 
the Ultricore CC database

First Input # Specifies the first source for the device within the 
Ultricore CC database

Last Input # Specifies the last source for the device within the 
Ultricore CC database

Level # Specifies the number of levels for the device in the 
Ultricore CC database

Type Specifies the signal type of inputs and outputs this 
device provides within the Ultricore CC database

Device ID Specifies the external third-party device the 
imported logical matrix applies to
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Port Labels Tab
The Port Labels tab lists the matrices discovered by the connection points on the Connections tab 
and imported via the Third Party Matrices tab. A matrix (or router) socket is identified via the 
Frame.Slot.Port.Type.Channel nomenclature. Custom labels may be applied to the ports if 
required. These may be also known as actual labels in other terminology (the name the cable would 
be assigned). This re-naming is not necessary for operation, but it may make your assignment of 
source and destination labels easier when using your internal cable naming conventions.

Figure 62  Example of Entries in a Port Labels Tab

Table 43 summarizes the options displayed in the main area of the Port Labels tab (from left to 
right on the interface). 

Table 45  Port Labels Tab

Item Description
Matrix: Provides a list of configured matrices for the currently loaded database. 

Double-click an item in the list to update the table in the Port Labels 
tab.
By default, each router is represented by a read-only matrix in this list. 
This read-only matrix lists all the SDI signals available to the Ultricore 
CC via that router. If you have multiple routers, each router is 
represented with a separate read-only matrix with the device name in 
the matrix name (e.g. NK-3G16.SDI [read-only], or NK-3G144.SDI 
[read-only]).

Port Indicates the physical socket on the external device that is included in 
the currently selected logical matrix using the nomenclature 
Frame.Slot.Port.Type.Channel.

Label Provides a text label that identifies the physical port in other interfaces 
of the database. This virtual label is used instead of the 
Frame.Slot.Port.Type.Channel format. For example, you might 
re-name port NK-S34.slot1.in[1].SDI.ch1 to NK-234 SDI IN 
1-1.
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Bottom Toolbar

Refer to Table 69 for a summary of the buttons displayed in the Bottom toolbar of the Database 
interfaces.

Levels Tab
A level is a specific grouping of signal input and output ports, that may be controlled separately 
from other groups (a breakaway). Typically a level is associated with input/output ports that are 
used with sets of similar or related signals, such as SDI Video, AES Audio, Analog Video, Analog 
Audio, Timecode, or Machine control, and often include routing matrices that are dedicated to 
controlling that specific type of signal.

The options in the Levels tab are organized into a table where each row represents a level and the 
columns provide the options for configuring that level. From this tab you can assign a unique name 
to each level, a color that represents the level, and a textual description of the level to make it easier 
to identify the level in the soft panels.

Figure 63  Example of Entries in a Levels Tab
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Destinations Tab
The Destination tab enables the assignment of labels (used by control panels) to outputs of the 
attached matrices or routers. The options in the Destination tab are organized into a table where 
each row associates the name of the destination with one or more logical matrix output sockets. 

Figure 64  Example of Entries in a Destinations Tab

Table 46 summarizes the options displayed in the Destinations tab. 

Table 46  Destinations Tab

Item Parameters Description
ID # Auto-numbered field (read-only).

Tally TSL v3.1 <displayID> Displays the TSL protocol Tally ID entry. The 
Enable Tally box is selected in the Database 
tab. TSL 4.0 <displayID>

TSL v5.0 <screenID>:<displayID>

Tally 
Redirect

Enables/disables the re-direction of connected source Tally ID to destination Tally 
ID as set by the Tally field

Name <name> Assigns a unique identifier for the 
destination in the routing system. This 
name is also used when matrices are 
defined in the Ultricore CC system.

Description Provides additional information or user entered notes about the output

Level # Specifies the physical output port associated with the destination and assigns it 
to the specified level. Unless you have given the port a different label via the Port 
Labels tab, the port is labeled as Frame.Slot.Port.Type.Channel.

Matrix 
Outputs

# Lists all the physical output ports available 
that can be assigned as a destination in the 
routing system

Assign Click this button to add the selected physical output port(s) to the list of 
Destinations for the database.
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For More Information on...
• the buttons located on the bottom toolbar for the Destinations tab, refer to Table 69.

Sources Tab
The Sources tab enables the assignment of labels (used by remote control panels and soft panels) 
to physical input sources to specific sources based on the routers connected to the Ultricore CC 
(and listed in the Database interface). The rows in the table are dependent on the database that is 
currently loaded. The Sources tab is organized into a table where each row associates a name of the 
source with one or more logical matrix input sockets.

Figure 65  Example of Entries in a Sources Tab

Table 47 summarizes the options displayed in the Sources tab. 

Table 47  Sources Tab

Item Parameters Description
ID # Auto-numbered field (read-only).

Tally <displayID> or 
<screenID>:<displaydID>

Displays the TSL protocol tally ID entry. The Enable 
Tally box is selected in the Database tab.

Name <name> Assigns a unique identifier for the source in the 
routing system. This name is also used when 
matrices are defined in the Ultricore CC system.

Description Provides additional information or user entered 
notes about the input

Level # Specifies the physical input port associated with the 
source and assigns it to the specified level. Unless 
you have given the port a different label via the Port 
Labels tab, the port is labeled as 
Frame.Slot.Port.Type.Channel.
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Cat/Index Categories Tab
The Cat/Index Categories tab enables you to categorize sources, destinations, and levels via a 
hierarchal system of tags. You can use categories to filter sources, destinations or levels into 
manageable groups for a Category soft panel. Refer to “Using Category Panels”.

Figure 66  Example of Entries in a Cat/Index Categories Tab

Categories Area

Table 48 summarizes the options displayed in the Categories area of the Cat/Index Categories tab. 

Affected Resources Area

Table 49 summarizes the options displayed in the Affected Resources area of the Cat/Index 
Categories tab. 

Matrix Inputs # Lists all the physical input ports available that can 
be assigned as a source in the routing system

Assign Click this button to add the selected physical input port to the Source label in 
the database

Table 48  Cat/Index Categories — Categories Area

Item Description
Categories: Lists the category tags defined for this database

Add Adds a category tag

Delete Deletes the selected tag

Delete All Deletes all tags listed in the Categories: pane

Generate Automatically generates category tags based on the entires in your 
database

Table 47  Sources Tab

Item Parameters Description
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Indexes Area

Table 50 summarizes the options displayed in the Indexes area of the Cat/Index Categories tab. 

Inaccessible Resources Area

Table 51 summarizes the options displayed in the Inaccessible Resources area of the Cat/Index 
Categories tab. 

Table 49  Cat/Index Categories — Affected Resources Area

Item Parameters Description
Destinations: <text> Lists the destinations that are tagged

Find Performs a search for destinations in the database 
to add to the category

Sources: <text> Lists the sources that are tagged

Find Performs a search for sources in the database to 
add to the category

Levels: <text> Lists the levels that are tagged

Find Performs a search for level in the database to add 
to the category

Table 50  Cat/Index Categories — Indexes Area

Item Description
Indexes: Creates search terms to define category tags

Add Adds a new entry to the Indexes list

Delete Deletes the selected entry from the Indexes list

Delete All Deletes all entries from the Indexes list

Default Creates indexes 0-9 and A-F

Table 51  Cat/Index Categories — Inaccessible Resources Area

Item Parameters Description
Destinations: <text> Lists the destinations in the current database that 

are not included in any Cat/Index categories

Generate Automatically generates category tags based on the 
destinations in your database

Create Enables you to create a new Cat/Index filter for 
Destinations

Sources: <text> Lists the sources in the current database that are 
not included in any Cat/Index categories

Generate Automatically generates category tags based on the 
sources in your database

Create Enables you to create a new Cat/Index filter for 
Sources
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Group Categories Tab
The Categories tab enables you to categorize sources, destinations, and levels via a hierarchal 
system of tags. You can use categories to filter sources, destinations or levels into manageable 
groups for a Category soft panel. Refer to “Group Categories Overview”.

Figure 67  Example of Entries in a Group Categories Tab

The Group Categories tab is organized into three panels and a bottom toolbar.

Table 52 summarizes the options displayed in the left panel of the Group Categories tab. This panel 
displays all the created groups and sub-groups, and/or resources in a top-down hierarchy. Note 
that the nodes are sorted by type and then by alphabetical order.

Levels: <text> Lists the levels in the current database that are not 
included in any classic categories

Generate Automatically generates category tags based on the 
levels in your database

Create Enables you to create a new Cat/Index filter for 
Sources

Table 52  Group Categories Tab — Left Panel

Item Description
Group Categories: Displays the groups as folders arranged in a tree view

Find Displays the Find dialog that enables you to search for a category or 
resource name

Move Displays the Move dialog that enables you to move a selected group 
and its contents to another group

Rename Renames a selected group; the resource type will be not re-named

Delete Deletes a selected group and all of its contents

Add Adds a new group to the selected group

Table 51  Cat/Index Categories — Inaccessible Resources Area

Item Parameters Description
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Table 53 summarizes the options displayed in the middle panel of the Group Categories tab. This 
panel shows the assigned contents (groups and/or resources) of the currently selected item from 
the tree view (in the left panel). 

 

Table 54 summarizes the options displayed in the right panel of the Group Categories tab. This 
panel displays the available destinations, sources, and levels that can be arranged into group 
categories.

 

Table 55 summarizes the bottom toolbar.

Legacy Categories Tab
The Legacy Categories tab enables you to categorize sources, destinations, and levels via a 
hierarchal system of tags. You can use legacy categories to filter sources, destinations, or levels into 
manageable groups for legacy RCP-QE panels. Refer to the RCP-QE User Guide for details.

Table 56 summarizes the options displayed in the top toolbar. 

 

Table 53  Group Categories Tab — Middle Panel

Item Description
Name Indicates the name of a resource

Type Indicates the type of resource

Delete Deletes the selected resource(s) from the currently selected group

Table 54  Group Categories Tab — Right Panel

Item Description
Destinations Displays the unassigned destinations in alphabetical order

Sources Displays the unassigned sources in alphabetical order

Levels Displays the unassigned levels in alphabetical order

Assign Select the resource(s) and click Assign to assign it to the group selected 
in the left table

Table 55  Group Categories Tab — Bottom Toolbar

Item Description
Auto Generate Click to auto-generate group categories based on the resource names 

from the current database

Cancel Ignores all unsaved changes and reverts the tab back to the last saved 
entries

Apply Applies all change made in the Group Categories tab

Table 56  Legacy Categories Tab — Top Toolbar

Item Description
Destinations Lists the destination category/index assignments

Sources Lists the source category/index assignments

Levels Lists the level category/index assignments
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Table 57 summarizes the options displayed when the Edit button is selected from the bottom 
toolbar.

Salvos Tab
A salvo is a set of pre-defined switch events. The Salvos tab provides a list of the global salvos 
available in the currently selected database. From this tab you can create salvos, rename, and 
delete salvos. 

The workspace in the Salvos tab displays a grid pattern with sources at the top and the destinations 
along the left side. A list of currently available (saved) salvos displays on the far left-side of the tab. 
The toolbar on the far right-side displays a button for each level available in the database with each 
button set in the color specified for the level. The toolbar in the bottom right corner of the interface 
displays three buttons: Advanced, Cancel, and Apply.

Figure 68  Example of a Salvos Tab

Table 58 summarizes the options displayed in the Salvos tab. 

Table 57  Legacy Categories Tab — Bottom Toolbar

Item Description
Copy Copies the selected cells in the tab

Paste Pastes the previously copied items to the current cell selection

Clear Clears the data from the selected cells

Clear All Clears all category/index assignments

Fill Auto fills a range of cells

Auto Generate Auto fills the cells based on spaces in the source/destination names

Table 58  Buttons on the Salvos Interface

Button Description
Salvos: Provides a list of configured salvos for the currently loaded database. 

Double-click an item in the list to update the grid in the Salvos tab.

Edit... Displays the Edit dialog for the soft panel. Refer to “Edit Dialogs”.
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Advanced Menus

Clicking the Advanced button in the Salvos tab displays the options outlined in Table 59. 

Ultricore Profiles Tab
The Ultricore Profiles operate as a form of hierarchical database where user permissions are 
organized into a tree-like format. A profile determines which groups and pages that a user can 
access. 

When the ULTRICORE-PRO license is enabled, the Ultricore Profiles interface is organized into five 
distinct areas. (Figure 69) Each area is briefly described in this section starting with the leftmost 
area of the DashBoard window.

Select All Click this button to select all the Destinations in the matrix of the Salvos 
tab. This will include all the destinations in the matrix in the salvo 
configuration.
• All the Destination buttons are lit red in the matrix.
• The button now displays the Clear All label. Click the button again to 

remove all the Destinations from the salvo configuration.

Level # A button is assigned to each level available in the currently loaded 
database. The color and label of the button is specified in the Levels 
tab.

Advanced Displays the Advanced options outlined in Table 59.

Cancel Discards any recent changes made in the Salvos tab, and clears the 
matrix. Note that the Destinations are still selected (buttons are lit red) 
if you clicked Select All.

Apply Applies changes made in the Salvos tab and updates the salvo settings.

Table 59  Advanced Menu Items

Button Description
Clear All Presets Clears the workspace in the Salvos tab and resets all settings to the 

default values.

Clear Dest Presets Clears all selections made in the Destinations column of the workspace.

Capture System 
Status

Captures the current routing state of the Ultricore CC system.

Capture Dest Status Updates the workspace to reflect only the status of the destinations of 
the Ultricore CC system.

Table 58  Buttons on the Salvos Interface

Button Description
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Figure 69  Example of the Ultricore Profiles Interface with the ULTRICORE-PRO license

Users

When the system is configured to use the user login mechanism, a list of all currently configured 
usernames along with their current online status displays in this area.

Profiles

A list of all currently configured profiles. Selecting a profile (row) in this area automatically updates 
the items displayed in the Profile Details, Device Tree, and Options areas.

Profile Details

This area displays the details of the profile showing the conditions under which the tree in the 
following section will be applied. 

Tree Nodes

A visual representation of the tree view that is defined in the Profile Details. Note that certain 
entries that are specific to licenses or other conditions may be visible but not in the actual tree view. 
Should conditions change that enable those entries, they will appear as shown in this display. A 
profile also maintains the position of items in groups allowing the most relevant items to be the 
easiest to reach.

The tree nodes are organized in a hierarchy where the top level (blue icons) list system specific 
options, and secondary levels (yellow icons) list specific functions. 

 This area only displays when the ULTRICORE-PRO license is enabled.

Group Tabs

This area displays all the available items that have not yet been assigned to the currently selected 
profile but are available to define.

 This area only displays when the ULTRICORE-PRO license is enabled.
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Panels Tab
The Panels tab includes a series of sub-tabs that enable you to customize soft panels (control 
panels within the DashBoard environment). You can choose to assign the levels, sources, and 
destinations from an Ultricore CC database to the soft panel buttons.

The soft panels display as sub-nodes in the Soft Panels tree using the name specified in the Info 
tab. When you save a soft panel to the database, a node for the panel automatically displays under 
the Soft Panels node in the Tree View. The soft panels display in the tree according to their assigned 
Panel ID number (where an ID of 1 is the highest, and ID of 2 is the second highest etc.). 

Figure 70  Example of Entries in a Panels Tab

Panels Menu

The Panels menu displays on the left side of the interface. This menu provides a list of soft panels 
saved in the current database. Selecting a soft panel from the list updates the tab entires in the 
Panels tab with the settings for that soft panel.

Info Tab

Use the options in the Info tab to assign a panel a unique identifier, select the panel style template 
to use, and how the panel will perform tasks such as Take transitions. This is the default tab that the 
interface opens on. Table 60 summarizes the fields and menus displayed in the Info tab. 

Table 60  Info Tab

Item Parameters Description
Panel Style 
(read-only)

<name> Specifies the panel type that was assigned to the 
soft panel when it was created.

Panel ID <integer> Assigns a unique identifier to the panel

Panel Name <name> Provides a unique identifier for the soft panel. This 
name also displays as a sub-node in the Soft Panels 
tree.

Description # Provides a textual summary of the soft panel or 
additional information about the panel.
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Levels Tab

Use the options in the Levels tab to specify the number of levels for the panel, and organize them in 
a hierarchy for the panel. Table 61 summarizes the fields and menus displayed in the Levels tab. 

Protection 
Operation

Lock Displays only the Lock button in the panel interface

Protect Displays only the Protect button in the panel 
interface

Both Displays the Lock and Protect buttons in the panel 
interface

Take Operation Confirm A TAKE button displays on the soft panel. You must 
click this button before the transition occurs

Direct A Take transition occurs automatically when a 
Level, Destination, and Source are selected on the 
soft panel

Selection Operation Single The Multi Select button does not display on the soft 
panel

Multi Displays the Multi Select button on the soft panel. 
Use this button to quickly select multiple 
destinations for a crosspoint switch.
This button is only applicable for MultiBus and 
Category panels.

Machine Control Enable Displays a Machine Control button on the panel. 
When selected on the panel, this Machine Control 
button sends a Take request directed to a Ross 
NK-M series data router to automatically make the 
reciprocal port switch. On a video router, the 
connection is all one way from an input port to an 
output port (e.g. such as from IN 1 to OUT 2). 

Disable Does not display a Machine Control button on the 
panel.

Nongroup 
Resourcesa

Hide Resources that are not assigned to a specific group 
are not displayed on the soft panel.

Show All resources are displayed on the soft panel.

a. This menu is only available when the Panel Style is set to Group Category.

Table 61  Levels Tab

Item Parameters Description
Viewable Levels <integer> Specifies the maximum number of levels, as 

selectable buttons, that can display on the panel 
interface

Available <integer> List all the levels in the current database

Assigned <integer> Specifies which levels will be available in the soft 
panel

Table 60  Info Tab

Item Parameters Description
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Destinations Tab

Use the options in the Destinations tab to specify which router outputs will be available in 
Destination bus of the soft panel. Table 62 summarizes the fields and menus displayed in the 
Destinations tab. 

Sources Tab

Use the options in the Sources tab to specify which router inputs will be available in Source bus of 
the soft panel, and their hierarchy. Table 63 summarizes the fields and menus displayed in the 
Sources tab. 

Salvos Tab

Use the options in the Salvos tab to specify the total number of salvos displayed in the soft panel 
and their hierarchy. Table 64 summarizes the fields and menus displayed in the Salvos tab. 

Favorites Tab

 The Favorites tab only displays when the Panel Style is set to Ultritouch PB.

Table 62  Destinations Tab

Item Parameters Description
Viewable 
Destinations

<integer> Specifies the maximum number of destinations, as 
selectable buttons, on the panel. This field is not 
displayed when the Panel Style is set to Group 
Category or Cat/Index Category.

Available <integer> Lists all the destinations in the current database

Assigned <integer> Specifies which destinations will be available in the 
soft panel

Table 63  Sources Tab

Item Parameters Description
Viewable Sources <integer> Specifies the maximum number of sources, as 

selectable buttons, on the panel. This field is not 
displayed when the Panel Style is set to Group 
Category or Cat/Index Category.

Available <integer> Lists all the sources in the current database

Assigned <integer> Specifies which sources will be available in the soft 
panel

Table 64  Salvos Tab

Item Parameters Description
Viewable salvos # Specifies the maximum number of salvos that will 

be listed on the Recall Salvos dialog for the panel. 
This field is not displayed when the Panel Style is 
set to Matrix.

Available # Lists all the salvos in the current database

Assigned # Specifies which salvos will be available in the soft 
panel
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Table 65 summarizes the fields and menus displayed in the Favorites tab. 

Home View Tab

 The Home View tab only displays when the Panel Style is set to Ultritouch PB or Push Button.

Table 66 summarizes the options displayed in the Home View tab. 

Table 65  Favorites Tab

Item Parameters Description
Name <name> Provides a unique identifier for the type of Favorite 

for this soft panel.

Type Crosspoint Creates a Favorites button on the soft panel that 
recalls a specific crosspoints switch

Group Creates a Favorites button on the soft panel that 
loads a specific Group Category in the database

Salvo Creates a Favorites button on the soft panel that 
recalls a specific salvo in the database

Sources Creates a Favorites button on the soft panel that 
selects a specific source in the database

Destinations Creates a Favorites button on the soft panel that 
selects a specific destination in the database

Field 1 Specifies the first item for the Favorite. For 
example, if the type is set to Crosspoint, Field 1 
reports the destination.

Field 2 Specifies the second item for the Favorite. For 
example, if the type is set to Crosspoint, Field 2 
reports the source.

Up Moves the selected row higher in the table

Down Moves the selected row lower in the table

Top Moves the selected row to the top of the table

Bottom Moves the selected row to the bottom of the table

Sort Sorts by window type

Table 66  Home View Tab

Item Parameters Description
Display Icons Enable The Destination and Source buttons on the soft 

panel display icons

Disabled The Destination and Source buttons do not display 
icons; only the labels are displayed on each button.

Orientation Portrait The windows are organized into columns (vertical 
panes) on the soft panel

Landscape windows are organized into rows (horizontal panes) 
on the soft panel

Home Windows

Window (read-only) <text> Specifies the window type
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Buttons

Table 67 summarizes the buttons displayed in all Panel sub-tabs. 

Percent # Specifies the width of the window in a percentage 
of the overall soft panel size

Rows # Specifies the number of button rows in the window

Columns # Specifies the number of button columns in the 
window

Reset Loads the default window layout and widths

Up Moves the selected row higher in the table

Down Moves the selected row lower in the table

Top Moves the selected row to the top of the table

Bottom Moves the selected row to the bottom of the table

Sort Sorts by window type

Table 67  Button on the Panels Interface

Button Description
In the Available area, clicking this button toggles the sorting order 
between alphabetical or database-index (based on the current order 
listed in the Levels, Destinations, or Sources tabs)

Moves the selected items in the Available list to the Assigned list.

 
Moves the selected item(s) from the Assigned list back to the Available 
list. These items will not be available in the soft panel window.

Moves all the available labels to the Assigned list

Removes all the items from the Assigned list back to the Available list. 
These items will not be available in the soft panel window.

Up Moves the selected item in the Assigned list up one position. This 
changes the order of the displayed items on the soft panel.

Down Moves the selected item in the Assigned list down one position. This 
changes the order of the displayed items on the soft panel.

Top Moves the selected item in the Assigned list to the top of the list. This 
changes the order of the displayed items on the soft panel.

Bottom Moves the selected item in the Assigned list to the bottom of the list. 
This changes the order of the displayed items on the soft panel.

In the Assigned area, clicking this button arranges the items into 
alphanumerical order.

Table 66  Home View Tab

Item Parameters Description
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Destination Follow Tab
Table 68 summarizes the options displayed in the Destination Follow tab. 

Additional Dialogs, Menus, and Toolbars in the Database Interfaces
Each tab displays a toolbar located at the bottom that provides buttons that display additional 
editing dialogs (e.g. insert, cut, paste, search). Also, right-clicking a row in any tab also displays a 
menu of editing dialogs. This section briefly outlines those additional editing dialogs.

Bottom Toolbar

The bottom toolbar of each tab in the Database includes buttons for applying changes made to 
settings in the interface, or adding elements to the table in the interface. Table 69 summarizes the 
buttons displayed in the Bottom toolbar. Note that not all buttons display in all tabs. 

In the Assigned area, clicking this button arranges the items in the 
Assigned list according to the order established in the Levels, 
Destinations, or Sources tabs.

Edit... Displays the Edit dialog for the soft panel

Cancel Discards any recent changes made in the soft panel, and reverts to the 
previously saved settings.

Apply Applies changes made in the soft panel and updates the Ultricore CC 
database

Table 68  Destination Follow Tab

Item Parameters Description
Destination # Specifies the Destination you want to configure

Following # Specifies the router output that the specified 
Destination will follow

Table 69  Bottom Toolbar Items

Button Description
Edit Displays the Edit dialog for the tab. Refer to Table 70 for details.

Find Displays the Find dialog that enables the entering of criteria for 
searching of the tab contents.

Fill Label Applies a custom label to the selected port

Reset Label Reverts the label content to the previously saved text

Delete Removes the selected port from the list for the matrix

Add Adds the selected port from the list for the matrix

Cancel Discards any recent changes made in the tab, and reverts to the 
previously saved table settings.

Apply Applies changes made in the tab and updates the Ultricore CC database

Table 67  Button on the Panels Interface

Button Description
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Edit Dialogs

Table 70 summarizes the buttons displayed in the Edit dialogs. Note that not all options display in 
all tabs. 

Table 70  Edit Dialogs Items

Button Description
Add In interfaces with lists on the left toolbar (e.g. Panels, Port Labels, 

Salvos), selecting a list item and then clicking Add creates a copy of the 
selected item. The name to the newly created item includes the name 
from the copied item with the prefix “New”.

Auto Generate Automatically fills the cells in the table with a default value. For 
example, clicking this button in the Destinations tab automatically fills 
all the cells with the text “Dest”.

Clear Removes the data from the selected cell.

Clear All Removes the text or entry in all cells of the interface.

Copy Copies the selected cell data to the clipboard. In some interfaces, such 
as in the Salvo tab, the salvo settings are copied in entirety.

Cut Copies the cell data to the clipboard and then delete it from the table.

Deletea When working in an interface with a table layout, clicking this button 
removes the currently active row from the table.
When working in an interface with lists on the left toolbar, clicking this 
button removes the selected item from the list. You will still need to 
click Apply to completely remove the item from the database.

Fill A range of name cells may be filled with consecutive numerical data. 
For example, VTR1 to VTR4 may be entered quickly by defining a prefix 
(in this case VTR) and a suffix that will numerically increment. 
Selecting Fill from the Insert toolbar, a dialog displays prompting you to 
enter a prefix (alphanumeric) and the start/end numerical values.
This method adds rows to the destination table inserting below the 
active row. 

Fill & Replace Enables you to overwrite a range of cells in the table. Rows beneath the 
currently active row are overwritten with data from the Fill & Replace 
dialog.

Insert Above Inserts a new row above the currently active row in the table. Any 
existing data is moved down the table by one row.

Insert Below Inserts a new row below the currently active row in the table. Any 
existing data is moved up one row.

Insert Series Inserts a sequential range of labels below the currently selected row.

Paste Pastes the copied cell data from the clipboard. In some interfaces, such 
as in the Salvo tab, the copied salvo settings are pasted in entirety.

Paste Below Pastes the copied cell data, from the clipboard, to currently selected 
cell.
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Find Dialogs

Table 71 summarizes the buttons displayed in the Find dialogs. 

Advanced Fill Tool
The Advanced Fill tool is provided to create new destination and source labels that are 
automatically assigned to physical outputs and inputs depending on options set by the user. The 
audio routing features provided by the routers in your system can result in an extensive source and 
destination definition map requiring some time to manually enter. The Advanced Fill tool will 
speed the assignment of physical sockets greatly.

For More Information on...
• using the tool to set up your database, refer to “Using the Advanced Fill Tool”.

Breakaway Fill Dialog

The Breakaway Fill dialog is the Advanced Fill tool for the Sources tab. This dialog is displayed 
when you click Edit > Fill.

Rename When working in an interface with lists on the left toolbar, clicking this 
button enables you to provide a different name/label to the selected 
item.

Reset All IDs Resets the source/destination ID numbers based on their current row 
number.
It is recommended to verify the interfaces that referenced IDs (such as 
Soft Panels, Salvos, etc.)

a. Ensure the ID numbers are correctly sequenced when deleting and inserting entries in the tabs. Refer to 
the Reset All IDs row in this table.

Table 71  Find Dialogs Items

Item Description
Column A pull-down menu that lists the columns available in the current 

interface. Select the column to perform the search within.

Find What: Specifies the characters, or text, to search the table contents.

Direction Begins the search by searching below the currently selected row 
(Down), or above the selected row (Up).

Match whole word 
only

Select the check box to search only for the characters in the Find What: 
field as they are typed in the field. For example, typing “put” will search 
for instances of the word “put” and not “input” or “output”.

Cancel Cancels the search criteria and closes the Find menu.

Find Performs a search through the table contents based on the specified 
criteria.

Table 70  Edit Dialogs Items

Button Description



218 • DashBoard Interface Overview Ultricore CC User Guide (v15-rev2)

Figure 71  Example of a Breakaway Fill Dialog

Table 72 summarizes the options displayed in the Breakaway Fill dialog. 
Table 72  Breakaway Fill Dialog

Item Parameters Description
Fill Custom Insert labels with assignments for a custom range 

defined by the Range setting

Entire Slot Insert labels with assignments for a single router 
slot (including the AUX ports on the Ultrix router)

Entire Device Insert labels with assignments for the entire router 
(including the AUX ports on the Ultrix router)

Name <text> The prefix for the label creation. For example, 
typing VTR results in labels VTR1, VTR2, etc. 
Take care when determining label names. While a 
long name may be nice and descriptive for the 
Source tab, many control devices have limited 
screen space and labels may be truncated.

Starting # The starting numerical extension for the label 
creation. For example, typing 3 results in labels 
Name3, Name4, etc. 

Range # The quantity of labels for custom fill range

Slot # The Ultrix slot number to start the label assignment 
froma

Port # The Ultrix port to start the label assignment froma

Starting Channel # The Ultrix channel to start the label assignment 
froma

Level # This column lists the levels defined as per user 
entries in the system Levels setup table

I/O Assignment # This column lists the starting assignment for the 
given Level row

Fixed Select the box to fix the I/O assignment selection 
even though it may be out of natural order 
compared to other I/O assignments.
For example, Ultricore 
CC.slot1.in[1].audio.ch1 and Ultricore 
CC.slot2.in[1].audio.ch1.
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Destinations Fill Dialog

The Destinations Fill dialog is the Advanced Fill tool for the Destinations tab. This dialog is 
displayed when you click Edit > Fill.

Figure 72  Example of a Destinations Fill Dialog

Table 73 summarizes the options displayed in the Destinations Fill dialog. 

BRK I/O Select the box to insert a label with this I/O 
assignment on all BRK Level selections.
For example, IN 1 ch1  | 
slot1.in[1].audio.ch1 | 
slot1.in[1].audio.ch1 | 
slot1.in[1].audio.ch1.

BRK Level Select the box to include this level when creating a 
breakaway label. For example, IN 1 ch1.

BRK Suffix <text> By default, breakaway label naming uses the chx 
part of the Ultricore CC name. A user defined suffix 
may be entered here.

Assign Click this button to automatically fill the I/O Assignment column based 
on the Slot, Port, Starting Channel settings to the selected row(s).

Apply Click this button to insert labels with assignments based on dialog 
settings into the source assignment table below the current selected 
row.

Cancel Click this button to cancel the settings and close the dialog. No 
changes to the Source table will be made.

a. The Breakaway Fill dialog uses the default naming convention of FrameName.slot n.in/out[p].type.chx.

Table 73  Destinations Fill Dialog

Item Parameters Description
Fill Custom Insert labels with assignments for a custom range 

defined by the Range setting

Entire Slot Insert labels with assignments for a single router 
slot

Entire Device Insert labels with assignments for the entire 
router/device

Table 72  Breakaway Fill Dialog

Item Parameters Description
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Devices Interface
The Devices node summarizes the hardware components of the routing system. The nodes 
represent a hierarchy of the routing system communicating with the Ultricore CC.

Frame Configuration Interface
The Frame Configuration interface is divided into four areas, each accessed by clicking the 
corresponding button on the left toolbar of the interface.

Name <text> The prefix for the label creation. For example, 
typing VTR results in labels VTR 1, VTR 2, etc. 
Take care when determining label names. While a 
long name may be nice and descriptive for the 
Destination tab, many control devices have limited 
screen space and labels may be truncated.

Starting # The starting numerical extension for the label 
creation. For example, typing 3 results in labels 
Name3, Name4, etc. 

Range # Specifies the quantity of labels for custom fill range

Slot # The Ultricore CC slot number to start the label 
assignment froma

Port # The Ultricore CC port to start the label assignment 
froma

Starting Channel # The Ultricore CC channel to start the label 
assignment froma

Level # This column defines the levels as per user entries in 
the system levels setup table

I/O Assignment # Starting assignment for the given level row

Assign Click this button to automatically fill the I/O Assignment column based 
on the Slot, Port, and Starting Channel settings to the selected row/s

Apply Click this button to insert labels with assignments based on dialog 
settings into the source assignment table below the current selected 
row.

Cancel Click this button to cancel the settings and close the dialog. No 
changes to the Destination table will be made.

a. The Fill Destination dialog uses the default naming convention of FrameName.slot n.in/out[p].type.chx.

Table 73  Destinations Fill Dialog

Item Parameters Description
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Figure 73  Example of Frame Configuration Interface

Frame Information

Below the Frame Inventory table are the fields that report status information on the Ultricore CC 
hardware such as the version of the system firmware and reporting the current date and time. 
From this area you can also specify the NTP Server to be used as the time source for the Ultricore 
CC.

Licenses

Use the options in the Licenses area to manage the licensed features for your Ultricore CC. From 
here you can view which licensed features are enabled, and enter license keys for new features.

Alarms

From the Alarms table you can specify what components the Ultricore CC monitors such as the SD 
Card, the chassis battery, and the ENET ports. 

By default, the Ultricore CC monitors the following components (these options in the Alarms table 
are enabled):

• SD Card Free Space
• SD Card Presence
• Battery

The Alarms table also displays read-only State column that reports the status of each enabled alarm 
using color indicators which vary in severity from green (valid), yellow (caution), to red (alarm). For 
example, if the SD Card status is set to red in the Alarms table, an SD Card is not detected or the SD 
Card not mounted correctly inside the chassis.

Communication Settings

The Frame Communications area enables you to monitor the status of the Ethernet connections of 
the Ultricore CC. From here you can verify the network settings of the active Ethernet port on the 
chassis, and view the mode of the control system (primary/client).
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Serial Ports

The Serial Ports area enables you to monitor the COM1 and COM2 ports on the Ultricore CC chassis. 
Each enabled alarm using color indicators which vary in severity from green (valid), yellow (caution), 
to red (alarm).

Controllers and Matrices
Under the Controllers + Matrices node provides an inventory of remote control devices and 
routers that make up your routing system, and have a defined connection to Ultricore CC.

• A Matrix is, generally speaking, a simple router consists of a matrix and a limited control system. 
• A Controller is a complex router consisting of many matrices and its own control system.

Expanding the Controllers and Matrices reveals devices defined by rows in the Database Matrices 
tab. Double clicking the node for the device opens the setup options for that particular device in 
DashBoard.

Ross Video devices that previously displayed in the Tree View as a sub-node of their IP connection 
point (i.e. NK-NET or IPS), are now relocated to the Controllers and Matrices node of Ultricore CC 
once they are defined in the Database Matrices tab. This indicates the device in question is now part 
of the Ultricore CC control system.

Panels
The Panels node provides a list of physical remote control panels within the routing system. For 
example, if you have any RCP-ME or an RCP-QE setup in your system, each device would display as 
a sub-node under the Panels node. Double-clicking the sub-node updates the DashBoard client 
window with the interface for that remote control panel.

Soft Panels Interfaces
The Soft Panels interface represents the routing system crosspoint control in the virtual space of 
the Ultricore CC. Each available soft panel in the database displays as a sub-node under the Soft 
Panels main node in a tree layout. The soft panels display in a hierarchy based on their Panel ID. 
Double-click a soft panel node to display its interface in the DashBoard window. There are three 
types of soft panels: Matrix, MultiBus, and Category.

 You must configure your connections, sources, destinations, and levels, before you can create a 
soft panel and perform crosspoint switches.

For More Information on...
• creating a database for your routing system, refer to “Creating a New Database”.
• the interface for creating soft panels, refer to “Soft Panels Interfaces”.
• using soft panels, refer to “Soft Panels in DashBoard”.
• creating and using salvos, refer to “Using Salvos”.

Matrix Panel
The Matrix Panel provides a visual representation of multi-level crosspoints, in a grid layout, and 
offers a convenient and easy way to select and switch crosspoints. The columns of the grid 
represent the configured Sources and are labeled with the labels specified in the Input Name cells 
of the Sources tab. The rows of the grid represent the configured Destinations and display the 
labels specified in the Destination tab.
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Figure 74  Example of a Matrix Panel

Right-side Toolbar

Table 74 summarizes the buttons displayed in the toolbar on the right-side of the interface. 

Salvo Menus

Table 75 summarizes the options displayed in the Salvo menu. 

Table 74  Matrix Panel Toolbar Items

Button Description
Level # Each configured level in the currently active database is represented 

with a button. When selected, the button is lit with the color assigned to 
the level. Crosspoint selections on the matrix are also lit this color when 
the level is included in the next switch.

Follow Automatically selects all the Level buttons listed on the Matrix panel 
(buttons are now lit). All levels are now included in next crosspoint 
selection.

TAKE Performs a Take transition to the next crosspoint selection.

Lock Locks the Matrix panel from all switches or function button operation.

Protect Protects the currently selected source/destination level pair from use 
by other sources, as well as from other linked panels.

Free Removes the Lock and Protect from the next crosspoint switch.

Salvo Displays the options for managing the salvos for your soft panel. Refer 
to “Salvo Menus” for details.

Advanced Displays the options for managing crosspoint switches on your soft 
panel. Refer to “Advanced Menus” for details.

Table 75  Matrix Panel — Salvo Menus

Button Description
Recall Recalls and applies the last saved salvo settings.

Edit Enables you to load a salvo, update its settings, and then save your 
changes.
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Advanced Menus

Table 76 summarizes the options displayed in the Advanced menu. 

MultiBus Panel
The MultiBus Panel provides breakaway control and status monitoring of several destinations 
simultaneously. The MultiBus Panel interface is organized into two buses with a central status row 
of indicators for the levels. The toolbar on the far left of the interface provides options for locking 
and protecting crosspoints, setting up the transition, and selecting the levels. The bottom row of the 
interface is populated with buttons for the salvos defined in the database.

Save Saves the current crosspoint selection as a local salvo.

Capture Current 
Status

Automatically creates a salvo based on the currently selected 
destination and source positions.

Capture Dest Status Automatically creates a salvo based on the currently selected 
destination positions.

Table 76  Matrix Panel — Advanced Menus

Button Description
Clear All Presets Removes all selections currently made on the soft panel and returns 

the panel to its default destination and source selections.

Clear Dest Presets Removes only the selections made on the Destinations bus. No 
destination buttons are selected.

Diagonal Presets The destination and source crosspoint selections are automatically 
made starting at the top left corner and progressively moving down the 
grid in a 1:1 pattern. For example, Src1 and Dest1, Src2 and Dest2, Src3 
and Dest3 etc.

R-Diagonal Presets The destination and source crosspoint selections are automatically 
made starting at the top right corner and progressively moving down 
the grid in a 1:1 pattern. For example, Src10 and Dest1, Src9 and Dest2, 
Src8 and Dest3 etc.

Setup Automation Automatically loops the crosspoint switches for the specified length of 
time.

Stop Automation Stops the automatic loop of crosspoint switches that was initiated using 
the Setup Automation option.

Table 75  Matrix Panel — Salvo Menus

Button Description
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Figure 75  Example of a MultiBus Panel

Left Toolbar

Table 77 summarizes the fields and information displayed in the left toolbar of the MultiBus 
Panel. 

Destinations Bus

Each Destination is represented as a distinct box on the top bus of the MultiBus Panel. Figure 76 
provides an example of a Destination bus. The Destination bus only displays the destinations 
specified when the soft panel was configured.

Table 77  MultiBus Panel — Left Toolbar Items

Button Description
Lock Locks the MultiBus panel from all switches or function button 

operation.

Take Performs a Take transition to the next crosspoint selection.

Preset Enables you to configure a crosspoint switch that will not take effect 
until the Take button is selected.

Clear Clears the selections in the crosspoint buses. No buttons are lit and the 
fields in the Destination buses are blank.

Multi Select Enables you to assign a single source to multiple destinations for a 
multi-switch configuration.

Level # Each configured level in the currently active database is represented 
with a button. When selected, the button is lit with the color assigned to 
the level. Crosspoint selections on the matrix are also lit this color when 
the level is included in the next switch.

Follow Automatically selects all the Level buttons listed on the Matrix panel 
(buttons are now lit). All levels are now included in next crosspoint 
selection.
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Figure 76  Example of a Destination Bus on the MultiBus Panel

Table 78 summarizes the buttons displayed for each Destination in the MultiBus Panel. 

Sources Bus

Each Source is represented as a distinct button on the bottom bus of the MultiBus Panel. Figure 77 
provides an example of a Source bus. The Source bus only displays the sources, and in the 
hierarchy, specified when the soft panel was configured.

Figure 77  Example of a Source Bus on the MultiBus Panel

Category Panel
There are two types of Category Panels: Classic and Group. Each Category Panel organizes the 
sources and destinations according to the definitions set in the applicable Category interface for the 
database. The top toolbar is used in conjunction with the central button matrix for selecting sources 
and destinations. The left side of the interface provides access to level selection, and reports on the 
breakaway status with fields for each level. Some functions are category type specific. Refer to 
“Using Category Panels” for details.

Table 78  MultiBus Panel — Destination Items

Button Description
Name The Destination name/label is reported at the top of each area and 

displays as a selectable button. This enables for quick identification on 
the bus when selecting crosspoint switches.
The Destinations available on the bus is dependent on the database 
currently loaded on the router and how many destinations were 
specified when the soft panel was configured.

Level # This field reports the level(s) that the destination was associated with 
on the last crosspoint switch.

Source # This field reports the source(s) currently selected on the Source bus 
located near the bottom of the MultiBus Panel interface.

Lock Locks the Destination from all switches or function button operation.

Protect Protects the currently selected Destination from use by other sources, 
as well as from other linked panels.
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Figure 78  Example of a Category Soft Panel for an Ultricore CC

Ultritouch PB Panels
You can control an Ultrix router via Ultritouch by loading a saved soft panel using the Ultritouch 
hard panel interface. Loading a soft panel to Ultritouch requires a similar method as loading a soft 
panel in the Ultrix and/or Ultricore menu system. You select the device in the Ultritouch > All 
Connections interface, navigate to the specific soft panel you wish to load, and select it from the 
provided list. 

Figure 79  Example of an Ultritouch Soft Panel

For More Information on...
• the creating and using Ultritouch soft panels, refer to the Ultritouch + Ultricore CC User Guide.

Push Button Panels
The Push Button Panel interface is organized into four distinct areas. The top area displays the 
Destinations, the middle row includes the Source buttons, and each area includes an independent 
method for filtering the buttons. A toolbar displays on the right to provide access to the level 
buttons, and includes a status field. The bottom toolbar provides options for locking and protecting 
crosspoints, setting up the transition, selecting salvos, and other functions. 
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Figure 80  Example of a (Landscape) Push Button Soft Panel

For More Information on...
• the creating and using Push Button soft panels, refer to “Using Push Button Panels”.

Using Walkabout in DashBoard
Walkabout is a Ross router utility operating within DashBoard, as of DashBoard version 6.2, that 
enables you to configure the network settings for NK devices. Once a valid connection is established 
with Walkabout, the device is listed in the Tree View of DashBoard and available for monitoring and 
configuration via DashBoard. 

Ultricore CC supports a basic configuration mode via the Walkabout system for initial configuration 
of IP settings:

• specify device IP settings and names
• specify a name for your routing system
• specify the system role (e.g. primary, backup, device)
• select a system to join from a list of valid system names assigned to controllers
• set communications server from a list of valid communication server devices (or IP)

For More Information on...
• the features of Walkabout, refer to the Ross Video document Configuring Devices Using 

Walkabout.
• using Walkabout and Ultricore CC, refer to “Using Walkabout to Assign an IP Address to the 

Ultricore CC Panel”.
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Technical Specifications
This chapter provides technical information for Ultricore CC. Note that specifications are subject to 
change without notice.

Ethernet Ports
Each Ethernet port uses a single 9-pin, RJ45 connector to interface with a local network, RCP-ME, 
RCP-QE, and other devices that use an ethernet protocol for communications. The Ethernet ports 
are operated in a link aggregated or bonded configuration to provide failover functionality.

Specifications

ALARM Connector
The ALARM connector on the Ultricore CC rear panel is used to configure alarm during loss of 
power to the panel.

Specifications

Pinouts
Refer to Figure 82 and Table 81 for the pinout assignment of the ALARM port on the Ultricore CC 
rear panel.

Figure 81  ALARM Connector on Ultricore CC Rear Panel — Pinouts Assignment 

Table 79  Technical Specifications — Ethernet Ports

Item Specifications
Standards Accommodated 1000BASE-T (GbE) network

Connection RJ45

Table 80  Technical Specifications — GPO Alarm Port

Item Specifications
Alarm Mechanical relay normally closed output

Connection 3-pin header

Table 81  GPO Alarm Pinouts

Pin Number Function

1 Ground

2 Alarm Output

3 +5VDC 22mA max.

ALARM

3 2 1
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Refer to Figure 82 for the signal pinouts for the 3-pin connector plug. 

Figure 82  Connector Plug — Pinouts for GPO Alarm Port

Serial Ports
The COM 1 and COM 2 ports on the Ultricore CC rear panel are used to connect to a third-party 
device that communicates via a supported serial protocol.

Specifications

Pinouts
This section outlines the signal pinouts for the two COM ports. 

Figure 83  Pinouts for Serial Ports

Table 82  Technical Specifications — Serial Ports

Item Specifications
Standards Accommodated RS-232/RS-422 (switchable) serial

Maximum Baud 115200

Connection DB9 female

Table 83  Serial Pinouts

Pin Number RS-232 Function RS-422 Function

1 N/C N/C

2 Tx -Rx

3 Rx +Tx

4 N/C N/C

Connector
End View

Connector
Side View

Cable

Connector

Tie Wrap

Connector
Top Views

(without cable)
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T-Bus Ports
The T-Bus ports on the Ultricore CC rear panel are used for connecting to Ross NK Series devices 
that communicate via the T-Bus protocol.

Specifications

Pinouts
This section outlines the signal pinouts for the two T-Bus ports. 

Figure 84  Pinouts for T-Bus Ports 

5 Ground/shield Ground/shield

6 N/C N/C

7 N/C +Rx

8 N/C -Tx

9 N/C N/C

Table 84  Technical Specifications — T-Bus Ports

Item Specifications
Standards Accommodated Ross Video proprietary T-Bus

Cabling Type CAT3 or better

Connection 8P8C modular jack

Table 85  T-Bus Pinouts

Pin Number Function

1 Ground

2 Ground

3 +Tx/Rx

4 N/C

5 N/C

6 -Tx/Rx

7 +15 VDCa

a. 7W total for both ports and not 7W 
each.

8 +15 VDCa

Table 83  Serial Pinouts

Pin Number RS-232 Function RS-422 Function
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Power
The two power ports on the Ultricore CC rear panel deliver AC power.

Table 86  Technical Specifications — PSU 

Item Specifications
Output  15VDC @ 4A

Output Power 60W

Input 100-240V~, 50-60Hz, 1.5A
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Software Licenses
This chapter provides third-party software license information for your Ultricore CC. This product 
includes multiple software components which are individually licensed under one or more of the 
following licenses included in this chapter.

BSD
Copyright (c) 1991,1993, The Regents of the University of California. All rights reserved.
This code is derived from software contributed to Berkeley by Kenneth Almquist.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:
1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other 
materials provided with the distribution.
3. <BSD Advertising Clause omitted per the July 22, 1999 licensing change ftp://ftp.cs.berkeley.edu/pub/4bsd/README.Impt.License.Change> California, Berke-
ley and its contributors.
4. Neither the name of the University nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior 
written permission.
THIS SOFTWARE IS PROVIDED BY THE REGENTS AND CONTRIBUTORS ``AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, 
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN 
NO EVENT SHALL THE REGENTS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CON-
SEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR 
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABIL-
ITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF 
THE POSSIBILITY OF SUCH DAMAGE.

Dual GPL
Portions of this software are copyright (C) 1996-2002 The FreeType Project (www.freetype.org). All rights reserved.
This project is also covered under the GPL v2.

GPL
GNU GENERAL PUBLIC LICENSE

Version 3, 29 June 2007
Copyright (C) 2007 Free Software Foundation, Inc. <http://fsf.org/>

Preamble
The GNU General Public License is a free, copyleft license for software and other kinds of works.
The licenses for most software and other practical works are designed to take away your freedom to share and change the works. By contrast, the GNU General Pub-
lic License is intended to guarantee your freedom to share and change all versions of a program--to make sure it remains free software for all its users. We, the Free 
Software Foundation, use the GNU General Public License for most of our software; it applies also to any other work released this way by its authors. You can apply 
it to your programs, too.
When we speak of free software, we are referring to freedom, not price. Our General Public Licenses are designed to make sure that you have the freedom to distrib-
ute copies of free software (and charge for them if you wish), that you receive source code or can get it if you want it, that you can change the software or use pieces 
of it in new free programs, and that you know you can do these things.
To protect your rights, we need to prevent others from denying you these rights or asking you to surrender the rights. Therefore, you have certain responsibilities if 
you distribute copies of the software, or if you modify it: responsibilities to respect the freedom of others.
For example, if you distribute copies of such a program, whether gratis or for a fee, you must pass on to the recipients the same freedoms that you received. You must 
make sure that they, too, receive or can get the source code. And you must show them these terms so they know their rights.
Developers that use the GNU GPL protect your rights with two steps: (1) assert copyright on the software, and (2) offer you this License giving you legal permission 
to copy, distribute and/or modify it.
For the developers' and authors' protection, the GPL clearly explains that there is no warranty for this free software. For both users' and authors' sake, the GPL 
requires that modified versions be marked as changed, so that their problems will not be attributed erroneously to authors of previous versions.
Some devices are designed to deny users access to install or run modified versions of the software inside them, although the manufacturer can do so. This is funda-
mentally incompatible with the aim of protecting users' freedom to change the software. The systematic pattern of such abuse occurs in the area of products for indi-
viduals to use, which is precisely where it is most unacceptable. Therefore, we have designed this version of the GPL to prohibit the practice for those products. If 
such problems arise substantially in other domains, we stand ready to extend this provision to those domains in future versions of the GPL, as needed to protect the 
freedom of users. 
Finally, every program is threatened constantly by software patents. States should not allow patents to restrict development and use of software on general-purpose 
computers, but in those that do, we wish to avoid the special danger that patents applied to a free program could make it effectively proprietary. To prevent this, the 
GPL assures that patents cannot be used to render the program non-free.
The precise terms and conditions for copying, distribution and modification follow.

TERMS AND CONDITIONS

0. Definitions.
"This License" refers to version 3 of the GNU General Public License.
"Copyright" also means copyright-like laws that apply to other kinds of works, such as semiconductor masks.
"The Program" refers to any copyrightable work licensed under this License. Each licensee is addressed as "you". "Licensees" and "recipients" may be individuals or 
organizations.
To "modify" a work means to copy from or adapt all or part of the work in a fashion requiring copyright permission, other than the making of an exact copy. The 
resulting work is called a "modified version" of the earlier work or a work "based on" the earlier work.
A "covered work" means either the unmodified Program or a work based on the Program.
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To "propagate" a work means to do anything with it that, without permission, would make you directly or secondarily liable for infringement under applicable copy-
right law, except executing it on a computer or modifying a private copy. Propagation includes copying, distribution (with or without modification), making available 
to the public, and in some countries other activities as well.
To "convey" a work means any kind of propagation that enables other parties to make or receive copies. Mere interaction with a user through a computer network, 
with no transfer of a copy, is not conveying.
An interactive user interface displays "Appropriate Legal Notices" to the extent that it includes a convenient and prominently visible feature that (1) displays an 
appropriate copyright notice, and (2) tells the user that there is no warranty for the work (except to the extent that warranties are provided), that licensees may convey 
the work under this License, and how to view a copy of this License. If the interface presents a list of user commands or options, such as a menu, a prominent item in 
the list meets this criterion.

1. Source Code.
The "source code" for a work means the preferred form of the work for making modifications to it. "Object code" means any non-source form of a work.
A "Standard Interface" means an interface that either is an official standard defined by a recognized standards body, or, in the case of interfaces specified for a partic-
ular programming language, one that is widely used among developers working in that language.
The "System Libraries" of an executable work include anything, other than the work as a whole, that (a) is included in the normal form of packaging a Major Compo-
nent, but which is not part of that Major Component, and (b) serves only to enable use of the work with that Major Component, or to implement a Standard Interface 
for which an implementation is available to the public in source code form. A "Major Component", in this context, means a major essential component (kernel, win-
dow system, and so on) of the specific operating system (if any) on which the executable work runs, or a compiler used to produce the work, or an object code inter-
preter used to run it.
The "Corresponding Source" for a work in object code form means all the source code needed to generate, install, and (for an executable work) run the object code 
and to modify the work, including scripts to control those activities. However, it does not include the work's System Libraries, or general-purpose tools or generally 
available free programs which are used unmodified in performing those activities but which are not part of the work. For example, Corresponding Source includes 
interface definition files associated with source files for the work, and the source code for shared libraries and dynamically linked subprograms that the work is spe-
cifically designed to require, such as by intimate data communication or control flow between those subprograms and other parts of the work.
The Corresponding Source need not include anything that users can regenerate automatically from other parts of the Corresponding Source.
The Corresponding Source for a work in source code form is that same work.

2. Basic Permissions.
All rights granted under this License are granted for the term of copyright on the Program, and are irrevocable provided the stated conditions are met. This License 
explicitly affirms your unlimited permission to run the unmodified Program. The output from running a covered work is covered by this License only if the output, 
given its content, constitutes a covered work. This License acknowledges your rights of fair use or other equivalent, as provided by copyright law.
You may make, run and propagate covered works that you do not convey, without conditions so long as your license otherwise remains in force. You may convey 
covered works to others for the sole purpose of having them make modifications exclusively for you, or provide you with facilities for running those works, provided 
that you comply with the terms of this License in conveying all material for which you do not control copyright. Those thus making or running the covered works for 
you must do so exclusively on your behalf, under your direction and control, on terms that prohibit them from making any copies of your copyrighted material out-
side their relationship with you.
Conveying under any other circumstances is permitted solely under the conditions stated below. Sublicensing is not allowed; section 10 makes it unnecessary.

3. Protecting Users' Legal Rights From Anti-Circumvention Law.
No covered work shall be deemed part of an effective technological measure under any applicable law fulfilling obligations under article 11 of the WIPO copyright 
treaty adopted on 20 December 1996, or similar laws prohibiting or restricting circumvention of such measures.
When you convey a covered work, you waive any legal power to forbid circumvention of technological measures to the extent such circumvention is effected by 
exercising rights under this License with respect to the covered work, and you disclaim any intention to limit operation or modification of the work as a means of 
enforcing, against the work's users, your or third parties' legal rights to forbid circumvention of technological measures.

4. Conveying Verbatim Copies.
You may convey verbatim copies of the Program's source code as you receive it, in any medium, provided that you conspicuously and appropriately publish on each 
copy an appropriate copyright notice; keep intact all notices stating that this License and any non-permissive terms added in accord with section 7 apply to the code; 
keep intact all notices of the absence of any warranty; and give all recipients a copy of this License along with the Program.
You may charge any price or no price for each copy that you convey, and you may offer support or warranty protection for a fee.

5. Conveying Modified Source Versions.
You may convey a work based on the Program, or the modifications to produce it from the Program, in the form of source code under the terms of section 4, provided 
that you also meet all of these conditions:

a. The work must carry prominent notices stating that you modified it, and giving a relevant date.

b. The work must carry prominent notices stating that it is released under this License and any conditions added under section 7. This requirement modifies 
the requirement in section 4 to "keep intact all notices".

c. You must license the entire work, as a whole, under this License to anyone who comes into possession of a copy. This License will therefore apply, along 
with any applicable section 7 additional terms, to the whole of the work, and all its parts, regardless of how they are packaged. This License gives no 
permission to license the work in any other way, but it does not invalidate such permission if you have separately received it.

d. If the work has interactive user interfaces, each must display Appropriate Legal Notices; however, if the Program has interactive interfaces that do not 
display Appropriate Legal Notices, your work need not make them do so.

A compilation of a covered work with other separate and independent works, which are not by their nature extensions of the covered work, and which are not com-
bined with it such as to form a larger program, in or on a volume of a storage or distribution medium, is called an "aggregate" if the compilation and its resulting 
copyright are not used to limit the access or legal rights of the compilation's users beyond what the individual works permit. Inclusion of a covered work in an aggre-
gate does not cause this License to apply to the other parts of the aggregate.

6. Conveying Non-Source Forms.
You may convey a covered work in object code form under the terms of sections 4 and 5, provided that you also convey the machine-readable Corresponding Source 
under the terms of this License, in one of these ways:

a. Convey the object code in, or embodied in, a physical product (including a physical distribution medium), accompanied by the Corresponding Source 
fixed on a durable physical medium customarily used for software interchange.

b. Convey the object code in, or embodied in, a physical product (including a physical distribution medium), accompanied by a written offer, valid for at 
least three years and valid for as long as you offer spare parts or customer support for that product model, to give anyone who possesses the object code 
either (1) a copy of the Corresponding Source for all the software in the product that is covered by this License, on a durable physical medium customarily 
used for software interchange, for a price no more than your reasonable cost of physically performing this conveying of source, or (2) access to copy the 
Corresponding Source from a network server at no charge.

c. c) Convey individual copies of the object code with a copy of the written offer to provide the Corresponding Source. This alternative is allowed only 
occasionally and noncommercially, and only if you received the object code with such an offer, in accord with subsection 6b.
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d. d) Convey the object code by offering access from a designated place (gratis or for a charge), and offer equivalent access to the Corresponding Source in 
the same way through the same place at no further charge. You need not require recipients to copy the Corresponding Source along with the object code. 
If the place to copy the object code is a network server, the Corresponding Source may be on a different server (operated by you or a third party) that 
supports equivalent copying facilities, provided you maintain clear directions next to the object code saying where to find the Corresponding Source. 
Regardless of what server hosts the Corresponding Source, you remain obligated to ensure that it is available for as long as needed to satisfy these 
requirements.

e. e) Convey the object code using peer-to-peer transmission, provided you inform other peers where the object code and Corresponding Source of the work 
are being offered to the general public at no charge under subsection 6d.

A separable portion of the object code, whose source code is excluded from the Corresponding Source as a System Library, need not be included in conveying the 
object code work.
A "User Product" is either (1) a "consumer product", which means any tangible personal property which is normally used for personal, family, or household purposes, 
or (2) anything designed or sold for incorporation into a dwelling. In determining whether a product is a consumer product, doubtful cases shall be resolved in favor 
of coverage. For a particular product received by a particular user, "normally used" refers to a typical or common use of that class of product, regardless of the status 
of the particular user or of the way in which the particular user actually uses, or expects or is expected to use, the product. A product is a consumer product regardless 
of whether the product has substantial commercial, industrial or non-consumer uses, unless such uses represent the only significant mode of use of the product.
"Installation Information" for a User Product means any methods, procedures, authorization keys, or other information required to install and execute modified ver-
sions of a covered work in that User Product from a modified version of its Corresponding Source. The information must suffice to ensure that the continued func-
tioning of the modified object code is in no case prevented or interfered with solely because modification has been made.
If you convey an object code work under this section in, or with, or specifically for use in, a User Product, and the conveying occurs as part of a transaction in which 
the right of possession and use of the User Product is transferred to the recipient in perpetuity or for a fixed term (regardless of how the transaction is characterized), 
the Corresponding Source conveyed under this section must be accompanied by the Installation Information. But this requirement does not apply if neither you nor 
any third party retains the ability to install modified object code on the User Product (for example, the work has been installed in ROM).
The requirement to provide Installation Information does not include a requirement to continue to provide support service, warranty, or updates for a work that has 
been modified or installed by the recipient, or for the User Product in which it has been modified or installed. Access to a network may be denied when the modifica-
tion itself materially and adversely affects the operation of the network or violates the rules and protocols for communication across the network.
Corresponding Source conveyed, and Installation Information provided, in accord with this section must be in a format that is publicly documented (and with an 
implementation available to the public in source code form), and must require no special password or key for unpacking, reading or copying.

7. Additional Terms.
"Additional permissions" are terms that supplement the terms of this License by making exceptions from one or more of its conditions. Additional permissions that 
are applicable to the entire Program shall be treated as though they were included in this License, to the extent that they are valid under applicable law. If additional 
permissions apply only to part of the Program, that part may be used separately under those permissions, but the entire Program remains governed by this License 
without regard to the additional permissions.
When you convey a copy of a covered work, you may at your option remove any additional permissions from that copy, or from any part of it. (Additional permis-
sions may be written to require their own removal in certain cases when you modify the work.) You may place additional permissions on material, added by you to a 
covered work, for which you have or can give appropriate copyright permission.
Notwithstanding any other provision of this License, for material you add to a covered work, you may (if authorized by the copyright holders of that material) supple-
ment the terms of this License with terms:

a. Disclaiming warranty or limiting liability differently from the terms of sections 15 and 16 of this License; or

b. Requiring preservation of specified reasonable legal notices or author attributions in that material or in the Appropriate Legal Notices displayed by works 
containing it; or

c. Prohibiting misrepresentation of the origin of that material, or requiring that modified versions of such material be marked in reasonable ways as different 
from the original version; or

d. Limiting the use for publicity purposes of names of licensors or authors of the material; or

e. Declining to grant rights under trademark law for use of some trade names, trademarks, or service marks; or

f. Requiring indemnification of licensors and authors of that material by anyone who conveys the material (or modified versions of it) with contractual 
assumptions of liability to the recipient, for any liability that these contractual assumptions directly impose on those licensors and authors.

All other non-permissive additional terms are considered "further restrictions" within the meaning of section 10. If the Program as you received it, or any part of it, 
contains a notice stating that it is governed by this License along with a term that is a further restriction, you may remove that term. If a license document contains a 
further restriction but permits relicensing or conveying under this License, you may add to a covered work material governed by the terms of that license document, 
provided that the further restriction does not survive such relicensing or conveying.
If you add terms to a covered work in accord with this section, you must place, in the relevant source files, a statement of the additional terms that apply to those files, 
or a notice indicating where to find the applicable terms.
Additional terms, permissive or non-permissive, may be stated in the form of a separately written license, or stated as exceptions; the above requirements apply either 
way.

8. Termination.
You may not propagate or modify a covered work except as expressly provided under this License. Any attempt otherwise to propagate or modify it is void, and will 
automatically terminate your rights under this License (including any patent licenses granted under the third paragraph of section 11).
However, if you cease all violation of this License, then your license from a particular copyright holder is reinstated (a) provisionally, unless and until the copyright 
holder explicitly and finally terminates your license, and (b) permanently, if the copyright holder fails to notify you of the violation by some reasonable means prior 
to 60 days after the cessation.
Moreover, your license from a particular copyright holder is reinstated permanently if the copyright holder notifies you of the violation by some reasonable means, 
this is the first time you have received notice of violation of this License (for any work) from that copyright holder, and you cure the violation prior to 30 days after 
your receipt of the notice.
Termination of your rights under this section does not terminate the licenses of parties who have received copies or rights from you under this License. If your rights 
have been terminated and not permanently reinstated, you do not qualify to receive new licenses for the same material under section 10.

9. Acceptance Not Required for Having Copies.
You are not required to accept this License in order to receive or run a copy of the Program. Ancillary propagation of a covered work occurring solely as a conse-
quence of using peer-to-peer transmission to receive a copy likewise does not require acceptance. However, nothing other than this License grants you permission to 
propagate or modify any covered work. These actions infringe copyright if you do not accept this License. Therefore, by modifying or propagating a covered work, 
you indicate your acceptance of this License to do so.

10. Automatic Licensing of Downstream Recipients.
Each time you convey a covered work, the recipient automatically receives a license from the original licensors, to run, modify and propagate that work, subject to 
this License. You are not responsible for enforcing compliance by third parties with this License.
An "entity transaction" is a transaction transferring control of an organization, or substantially all assets of one, or subdividing an organization, or merging organiza-
tions. If propagation of a covered work results from an entity transaction, each party to that transaction who receives a copy of the work also receives whatever 
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licenses to the work the party's predecessor in interest had or could give under the previous paragraph, plus a right to possession of the Corresponding Source of the 
work from the predecessor in interest, if the predecessor has it or can get it with reasonable efforts.
You may not impose any further restrictions on the exercise of the rights granted or affirmed under this License. For example, you may not impose a license fee, roy-
alty, or other charge for exercise of rights granted under this License, and you may not initiate litigation (including a cross-claim or counterclaim in a lawsuit) alleging 
that any patent claim is infringed by making, using, selling, offering for sale, or importing the Program or any portion of it.

11. Patents.
A "contributor" is a copyright holder who authorizes use under this License of the Program or a work on which the Program is based. The work thus licensed is called 
the contributor's "contributor version".
A contributor's "essential patent claims" are all patent claims owned or controlled by the contributor, whether already acquired or hereafter acquired, that would be 
infringed by some manner, permitted by this License, of making, using, or selling its contributor version, but do not include claims that would be infringed only as a 
consequence of further modification of the contributor version. For purposes of this definition, "control" includes the right to grant patent sublicenses in a manner 
consistent with the requirements of this License.
Each contributor grants you a non-exclusive, worldwide, royalty-free patent license under the contributor's essential patent claims, to make, use, sell, offer for sale, 
import and otherwise run, modify and propagate the contents of its contributor version.
In the following three paragraphs, a "patent license" is any express agreement or commitment, however denominated, not to enforce a patent (such as an express per-
mission to practice a patent or covenant not to sue for patent infringement). To "grant" such a patent license to a party means to make such an agreement or commit-
ment not to enforce a patent against the party.
If you convey a covered work, knowingly relying on a patent license, and the Corresponding Source of the work is not available for anyone to copy, free of charge 
and under the terms of this License, through a publicly available network server or other readily accessible means, then you must either (1) cause the Corresponding 
Source to be so available, or (2) arrange to deprive yourself of the benefit of the patent license for this particular work, or (3) arrange, in a manner consistent with the 
requirements of this License, to extend the patent license to downstream recipients. "Knowingly relying" means you have actual knowledge that, but for the patent 
license, your conveying the covered work in a country, or your recipient's use of the covered work in a country, would infringe one or more identifiable patents in that 
country that you have reason to believe are valid.
If, pursuant to or in connection with a single transaction or arrangement, you convey, or propagate by procuring conveyance of, a covered work, and grant a patent 
license to some of the parties receiving the covered work authorizing them to use, propagate, modify or convey a specific copy of the covered work, then the patent 
license you grant is automatically extended to all recipients of the covered work and works based on it.
A patent license is "discriminatory" if it does not include within the scope of its coverage, prohibits the exercise of, or is conditioned on the non-exercise of one or 
more of the rights that are specifically granted under this License. You may not convey a covered work if you are a party to an arrangement with a third party that is 
in the business of distributing software, under which you make payment to the third party based on the extent of your activity of conveying the work, and under which 
the third party grants, to any of the parties who would receive the covered work from you, a discriminatory patent license (a) in connection with copies of the covered 
work conveyed by you (or copies made from those copies), or (b) primarily for and in connection with specific products or compilations that contain the covered 
work, unless you entered into that arrangement, or that patent license was granted, prior to 28 March 2007.
Nothing in this License shall be construed as excluding or limiting any implied license or other defenses to infringement that may otherwise be available to you under 
applicable patent law.

12. No Surrender of Others' Freedom.
If conditions are imposed on you (whether by court order, agreement or otherwise) that contradict the conditions of this License, they do not excuse you from the con-
ditions of this License. If you cannot convey a covered work so as to satisfy simultaneously your obligations under this License and any other pertinent obligations, 
then as a consequence you may not convey it at all. For example, if you agree to terms that obligate you to collect a royalty for further conveying from those to whom 
you convey the Program, the only way you could satisfy both those terms and this License would be to refrain entirely from conveying the Program.

13. Use with the GNU Affero General Public License.
Notwithstanding any other provision of this License, you have permission to link or combine any covered work with a work licensed under version 3 of the GNU 
Affero General Public License into a single combined work, and to convey the resulting work. The terms of this License will continue to apply to the part which is the 
covered work, but the special requirements of the GNU Affero General Public License, section 13, concerning interaction through a network will apply to the combi-
nation as such.

14. Revised Versions of this License.
The Free Software Foundation may publish revised and/or new versions of the GNU General Public License from time to time. Such new versions will be similar in 
spirit to the present version, but may differ in detail to address new problems or concerns.
Each version is given a distinguishing version number. If the Program specifies that a certain numbered version of the GNU General Public License "or any later ver-
sion" applies to it, you have the option of following the terms and conditions either of that numbered version or of any later version published by the Free Software 
Foundation. If the Program does not specify a version number of the GNU General Public License, you may choose any version ever published by the Free Software 
Foundation.
If the Program specifies that a proxy can decide which future versions of the GNU General Public License can be used, that proxy's public statement of acceptance of 
a version permanently authorizes you to choose that version for the Program.
Later license versions may give you additional or different permissions. However, no additional obligations are imposed on any author or copyright holder as a result 
of your choosing to follow a later version.

15. Disclaimer of Warranty.
THERE IS NO WARRANTY FOR THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE STATED IN 
WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE PROGRAM "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER 
EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PAR-
TICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD THE PROGRAM 
PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

16. Limitation of Liability.
IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY 
WHO MODIFIES AND/OR CONVEYS THE PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, 
SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE PROGRAM (INCLUDING BUT 
NOT LIMITED TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE 
OF THE PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POS-
SIBILITY OF SUCH DAMAGES.

17. Interpretation of Sections 15 and 16.
If the disclaimer of warranty and limitation of liability provided above cannot be given local legal effect according to their terms, reviewing courts shall apply local 
law that most closely approximates an absolute waiver of all civil liability in connection with the Program, unless a warranty or assumption of liability accompanies 
a copy of the Program in return for a fee.
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LGPL
GNU LESSER GENERAL PUBLIC LICENSE

Version 3, 29 June 2007
Copyright (C) 2007 Free Software Foundation, Inc. <http://fsf.org/>

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.
This version of the GNU Lesser General Public License incorporates the terms and conditions of version 3 of the GNU General Public License, supplemented by the 
additional permissions listed below.

0. Additional Definitions.
As used herein, "this License" refers to version 3 of the GNU Lesser General Public License, and the "GNU GPL" refers to version 3 of the GNU General Public 
License.
"The Library" refers to a covered work governed by this License, other than an Application or a Combined Work as defined below.
An "Application" is any work that makes use of an interface provided by the Library, but which is not otherwise based on the Library. Defining a subclass of a class 
defined by the Library is deemed a mode of using an interface provided by the Library.
A "Combined Work" is a work produced by combining or linking an Application with the Library. The particular version of the Library with which the Combined
Work was made is also called the "Linked Version".
The "Minimal Corresponding Source" for a Combined Work means the Corresponding Source for the Combined Work, excluding any source code for portions of the
Combined Work that, considered in isolation, are based on the Application, and not on the Linked Version.
The "Corresponding Application Code" for a Combined Work means the object code and/or source code for the Application, including any data and utility programs 
needed for reproducing the Combined Work from the Application, but excluding the System Libraries of the Combined Work.

1. Exception to Section 3 of the GNU GPL.
You may convey a covered work under sections 3 and 4 of this License without being bound by section 3 of the GNU GPL.

2. Conveying Modified Versions.
If you modify a copy of the Library, and, in your modifications, a facility refers to a function or data to be supplied by an Application that uses the facility (other than 
as an argument passed when the facility is invoked), then you may convey a copy of the modified version:

a. under this License, provided that you make a good faith effort to ensure that, in the event an Application does not supply the function or data, the facility 
still operates, and performs whatever part of its purpose remains meaningful, or

b. under the GNU GPL, with none of the additional permissions of this License applicable to that copy.

3. Object Code Incorporating Material from Library Header Files.
The object code form of an Application may incorporate material from a header file that is part of the Library. You may convey such object code under terms of your 
choice, provided that, if the incorporated material is not limited to numerical parameters, data structure layouts and accessors, or small macros, inline functions and 
templates (ten or fewer lines in length), you do both of the following:

a. Give prominent notice with each copy of the object code that the Library is used in it and that the Library and its use are covered by this License.

b. Accompany the object code with a copy of the GNU GPL and this license document.

4. Combined Works.
You may convey a Combined Work under terms of your choice that, taken together, effectively do not restrict modification of the portions of the Library contained in 
the Combined Work and reverse engineering for debugging such modifications, if you also do each of the following:

a. Give prominent notice with each copy of the Combined Work that the Library is used in it and that the Library and its use are covered by this License.

b. Accompany the Combined Work with a copy of the GNU GPL and this license document.

c. For a Combined Work that displays copyright notices during execution, include the copyright notice for the Library among these notices, as well as a 
reference directing the user to the copies of the GNU GPL and this license document.

d. Do one of the following:

1) Convey the Minimal Corresponding Source under the terms of this License, and the Corresponding Application Code in a form suitable for, and under 
terms that permit, the user to recombine or relink the Application with a modified version of the Linked Version to produce a modified Combined Work, 
in the manner specified by section 6 of the GNU GPL for conveying Corresponding Source.

2) Use a suitable shared library mechanism for linking with the Library. A suitable mechanism is one that (a) uses at run time a copy of the Library 
already present on the user's computer system, and (b) will operate properly with a modified version of the Library that is interface-compatible with the 
Linked Version.

e. Provide Installation Information, but only if you would otherwise be required to provide such information under section 6 of the GNU GPL, and only to 
the extent that such information is necessary to install and execute a modified version of the Combined Work produced by recombining or relinking the 
Application with a modified version of the Linked Version. (If you use option 4d0, the Installation Information must accompany the Minimal 
Corresponding Source and Corresponding Application Code. If you use option 4d1, you must provide the Installation Information in the manner specified 
by section 6 of the GNU GPL for conveying Corresponding Source.)

5. Combined Libraries.
You may place library facilities that are a work based on the Library side by side in a single library together with other library facilities that are not Applications and 
are not covered by this License, and convey such a combined library under terms of your choice, if you do both of the following:

a. Accompany the combined library with a copy of the same work based on the Library, uncombined with any other library facilities, conveyed under the 
terms of this License.

b. Give prominent notice with the combined library that part of it is a work based on the Library, and explaining where to find the accompanying 
uncombined form of the same work.

6. Revised Versions of the GNU Lesser General Public License.
The Free Software Foundation may publish revised and/or new versions of the GNU Lesser General Public License from time to time. Such new versions will be sim-
ilar in spirit to the present version, but may differ in detail to address new problems or concerns.
Each version is given a distinguishing version number. If the Library as you received it specifies that a certain numbered version of the GNU Lesser General Public 
License "or any later version" applies to it, you have the option of following the terms and conditions either of that published version or of any later version published 
by the Free Software Foundation. If the Library as you received it does not specify a version number of the GNU Lesser General Public License, you may choose any 
version of the GNU Lesser General Public License ever published by the Free Software Foundation.
If the Library as you received it specifies that a proxy can decide whether future versions of the GNU Lesser General Public License shall apply, that proxy's public 
statement of acceptance of any version is permanent authorization for you to choose that version for the Library.
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MIT
Copyright 1987, 1988 by MIT Student Information Processing Board.
Permission to use, copy, modify, and distribute this software and its documentation for any purpose is hereby granted, provided that the names of M.I.T. and the 
M.I.T. S.I.P.B. not be used in advertising or publicity pertaining to distribution of the software without specific, written prior permission. M.I.T. and the M.I.T. 
S.I.P.B. make no representations about the suitability of this software for any purpose. It is provided "as is" without express or implied warranty. 

zlib
Copyright (C) 1995-1998 Jean-loup Gailly and Mark Adler
This software is provided 'as-is', without any express or implied warranty. In no event will the authors be held liable for any damages arising from the use of this soft-
ware.
Permission is granted to anyone to use this software for any purpose, including commercial applications, and to alter it and redistribute it freely, subject to the follow-
ing restrictions:

1. The origin of this software must not be misrepresented; you must not claim that you wrote the original software. If you use this software in a product, 
an acknowledgment in the product documentation would be appreciated but is not required.

2. Altered source versions must be plainly marked as such, and must not be misrepresented as being the original software.

3. This notice may not be removed or altered from any source distribution.Jean-loup Gailly Mark Adler jloup@gzip.org madler@alumni.caltech.edu

The data format used by the zlib library is described by RFCs (Request for Comments) 1950 to 1952 in the files ftp://ds.internic.net/rfc/rfc1950.txt (zlib format), 
rfc1951.txt (deflate format) and rfc1952.txt (gzip format).
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Glossary
The following terms are used throughout this guide:

Breakaway — an act of performing a switch on only some of the signals grouped together under 
one label.

Connection Point — setting to define a communication connection between Ultricore CC and a 
device in the routing system.

Crosspoint — a switch within a matrix. For example, the connection of signal IN 1 to OUT 1 requires 
one crosspoint.

Destination — a signal output from the routing system.

IP Address — a setting that defines the Internet protocol address of a device within a network.

Label — text that is used by control displays to identify a signal as an input or output.

Level — refers to a section of a routing system. For example, a video router would be one level and 
an audio router would be a second level.

Logical (virtual) Label — a name for a group of routing system inputs or outputs.

Logical (virtual) Routing — the action of switching a group of otherwise unrelated signals via a 
common label (name).

Macro — a recorded sequence of Remote Control Panel operations (local to the panel).

Map — a table that defines the allocation of names (labels) to router input and output sockets.

Matrix — the part of the routing system that performs the actual signal switching tasks.

Partition — matrices may be partitioned to behave as smaller independent matrices.

Remote Control Panel (RCP) — a physical hardware panel of buttons that is used to control the 
routing system.

Resource — a source or destination of a router configuration; an external device providing some 
conversion functionality for use within the routing control system.

Salvo — a system wide sequence of matrix control operations and crosspoint actions.

Soft Panel — a DashBoard interface that represents a panel of buttons that is used to control the 
routing system.

Source — a signal input to the routing system.

T-Bus — the Ross Video proprietary routing communication method via a defined physical 
interface.

Virtual Label — a name for a group of routing system inputs or outputs.

Virtual Routing — the action of switching a group of otherwise unrelated signals via a common 
label (name).
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